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Alconox is a registered trademark of the Alconox Company.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
3Flex 3500 is a registered trademark of Micromeritics Instrument Corporation.
AutoPore IV is a registered trademark of Micromeritics Instrument Corporation.
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This application may contain a binary form of the Info-ZIP tool to create .zip files  That source code is provided  
under the following license: 

This software is provided "as is," without warranty of any kind, express or implied.  In no event shall Info-ZIP or its 
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the 
use of or inability to use this software.

 Permission is granted to anyone to use this software for any purpose, including commercial applications, and to 
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of 
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this 
list of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions--including, but not limited to, ports to new operating systems, existing ports with new 
graphical interfaces, and dynamic, shared, or static library versions--must be plainly marked as such and 
must not be misrepresented as being the original source.  Such altered versions also must not be 
misrepresented as being Info-ZIP releases--including, but not limited to, labeling of the altered versions 
with the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), 
"Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP.  Such altered  versions are 
further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-
ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket 
Zip," and "MacZip" for its own source and  binary releases.

© Micromeritics Instrument Corporation 2012 - 2013. All rights reserved. Printed in the U.S.A.

The software described in this manual is furnished under a license agreement and may be used or copied only in 
accordance with the terms of the agreement.
                                                                                                                                                                                                     



Form No. 008-42104-00

WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each 
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under 
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any 
instrument or defective parts when returned prepaid to us and which our examination discloses to have been 
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for 
warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized 
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The 
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive 
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed 
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of 
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and 
authorization to return the instrument or product. All repairs or replacements are made subject to factory 
inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications 
are made by persons other than its own authorized service personnel unless such work is authorized in writing by 
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold 
under their respective brand names or trade names. We, therefore, make no express or implied 
warranty as to such products. We shall use our best efforts to obtain from the manufacturer, in 
accordance with his customary practice, the repair or replacement of such of his products that may 
prove defective in workmanship or materials. Service charges made by such manufacturer are the 
responsibility of the ultimate purchaser. This states our entire liability in respect to such products, 
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, 
at the discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed 
circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs 
(rotor) and stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for 
manufacturing defects. Such items which perform satisfactorily during the first 45 days after the 
date of shipment are assumed to be free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against 
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or 
manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of 
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or 
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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3Flex Introduction
1.  USING THE ANALYZER

Introduction

This manual provides details on program menu options and operating instructions. This chapter con-
tains information on the system hardware and software components.

To help you operate the analyzer system more efficiently, refer to:

• Chapter 1, USING THE ANALYZER - prior to operating the analyzer and software
• Chapter 2, OPERATIONAL PROCEDURES - for step-by-step instructions for common operations

Organization of the Operator’s Manual

This operator’s manual is organized as follows:

Chapter Description 

Chapter 1 USING THE ANALYZER

Provides a general description and features of the analyzer, organization of the 
manual, and software and instrument interface.

Chapter 2 OPERATIONAL PROCEDURES 

Provides step-by-step procedures for the operations available using the 
application.

Chapter 3 FILE MENU

Provides a description of the File menu options and field and button definitions. 

Chapter 4 UNIT MENU

Provides a description of the Unit menu options and field and button definitions.

Chapter 5 REPORTS MENU

Provides a description of the Reports menu options and field and button 
definitions.

Chapter 6 OPTIONS MENU

Provides a description of the Options menu options and field and button 
definitions.

Chapter 7 DIAGNOSTICS

Provides information on using system diagnostics.
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Chapter 8 TROUBLESHOOTING AND MAINTENANCE

Provides user maintenance and service information.

Chapter 9 ORDERING INFORMATION

Provides ordering information for the application and analyzer system 
components.

Appendix A FORMS

Provides a sample information worksheet used to assist in obtaining a sample 
mass.

Appendix B ERROR MESSAGES

Program error messages are listed numerically. If the Action response indicates to 
contact a Micromeritics service representative, record the error message and make 
backup copies of any files involved in the operation.

Provides a list of program error messages, causes, and actions.

Appendix C CALCULATIONS

Provides calculations used in reports.

Appendix D FREE SPACE CORRECTION

Provides a discussion of the free space measurements for the analyzer.

Appendix E MAINTAINING HIGH PURITY GASES

Provides information on the importance of maintaining high purity gases.

Appendix F DFT MODELS

Provides information on DFT models.

Appendix G USER-DEFINED REPORTS, PYTHON MODULE

Provides information on accessing and creating user-defined reports using Python.

Index INDEX

Provides quick access to a subject matter.

Chapter Description (continued)
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Conventions

This manual uses the following icons to identify notes of importance, warnings and cautions. 

Notes contain important information pertinent to the subject matter.

Warnings contain information to help prevent actions that may cause personal injury.

Cautions contain information to help prevent actions that may damage the analyzer or 
components.
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Equipment Description 3Flex
Equipment Description

The analyzer is an automated gas adsorption analyzer with three ports allowing up to three samples to 
be analyzed simultaneously. The core analytical engine is composed of an advanced vacuum system, a 
versatile analysis manifold, and sensitive pressure transducers on each analysis port. The basic config-
uration consists of 2 or 3 micropore ports. Standard ports can be individually upgraded for high quality 
micropore analyses with 10 torr and 0.1 torr transducers on each micropore port.

The analyzer also features a dedicated port for measuring the saturation pressure (Po) on a continuous 
basis. Surface areas as low as 0.01 m2/g can be measured using nitrogen and as low as 0.001 m2/g with 
krypton as the adsorptive. Up to 1000 data points can be collected allowing the observation of minute 
details of the isotherm. The analyzer must be equipped with a 10 mmHg transducer and a high-vacuum 
pump to provide this capability. 

Up to four analyzers can be operated with one computer. The system consists of the analyzer, an 
optional SmartPrep degasser for preparing samples, a dry diaphragm roughing vacuum pump, and a 
computer for entering analysis and report options.

Windows 7 Professional or higher operating system is recommended for the best user experience. If 
the computer is to be connected to a network, two Ethernet ports are required.
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Vacuum Pump

The analyzer requires a dry diaphragm roughing vacuum pump for sample analysis. Appropriate vac-
uum pumps are available from Micromeritics. Refer to ORDERING INFORMATION, page 9-1.

Vapor Option

Vapor adsorption allows analyses with hydrocarbon vapors or water vapor. The instrument allows for 
dosing from one dedicated sample port to the other two sample ports.

A vapor adsorption option provides for dosing from a reservoir attached to the Psat port to all three 
sample ports. The vapor option includes a stainless steel chamber with a hard seal, manual cutoff valve 
to be attached in place of the Psat tube, and a heating mantle to control the temperature of the chamber 
at an operator-specified temperature between ambient and 43 °C. The instrument is quickly and easily 
configured with the vapor option. 

Micropore Option

Each port on the standard instrument can be upgraded individually for high quality micropore analyses 
with 10 torr and 0.1 torr transducers on each micropore port. Any remaining ports continue to operate 
in standard mode.

The micropore option is required to run krypton.

Degasser Options

• SmartPrep 065

The SmartPrep passes flowing-gas over the sample at elevated temperatures. It contains six sample 
ports in which temperature, ramp rates, and soak times are individually controlled by the analyzer 
program so that all degas information is integrated into the sample data file for future reference. It 
contains 2 serial ports, one for connecting to the computer and the other for connection of up to 3 
additional SmartPrep instruments permitting 24 preparation ports to be used.

The SmartPrep is the recommended degassing unit for the instrument.

• FlowPrep 060

Micropore Unit Micropore port number

One micropore unit 2

Two micropore unit 1 and 2

Three micropore unit 1, 2, and 3
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The FlowPrep applies both heat and a stream of inert gas to the sample to remove adsorbed 
contaminants from the surface and pores in preparation for analysis for up to 6 samples. It lets you 
choose the temperature, gas, and flow rate best suited for your sample material and application.

The FlowPrep is an independent unit and not controlled by the instrument.

• VacPrep 061

The VacPrep offers two methods for removing contaminants. In addition to flowing gas, it provides 
vacuum to prepare samples by heating and evacuation of up to 6 samples. This combination allows 
you to choose the preparation method that is best suited to your material or application. Needle 
valves are also provided allowing you to introduce the vacuum slowly to prevent fluidization of 
samples.

The VacPrep is an independent unit and not controlled by the instrument.
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Instrument Components and Connectors

Front Panel

Power 
indicator

Mantle/Furnace 
Thermocouple 
connector

Heating Mantle/
Furnace 
power connector

Manifold 
compartment cover 
latch

Elevator reset 
button

Access panels to mantle, heater, and 

Component Description 

Power indicator Blinks when power is applied to the analyzer; illuminates when analysis 
program is initiated and ready for operation.

Manifold 
compartment 
cover latch

Latches to hold the removable manifold compartment cover.

Elevator reset button Resets the elevator in case of failure. The message Elevator Circuit 
Breaker Open on the instrument schematic indicates this reset button 
should be pushed.

Thermocouple 
connector

Connector for the thermocouple.

Mantle/Furnace 
power connector

Power connector for the mantle or furnace.
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Sample Compartment

Three sample 
ports

Saturation 
pressure (Po) tube

Elevator

Access panels Lift the pad then lift the access panel to access the reset buttons for the 
mantle, heater, and transformer.

Component Description 

Sample ports For installing up to three sample tubes.

Po tube For measuring the saturation pressure.

Elevator Allows placement of the Dewar around the sample and Po tubes. The 
elevator is raised automatically when the analysis is started and lowers 
automatically upon completion. During analysis, the elevator optionally 
lowers after the free-space measurement to allow evacuation, then is 
raised and continues the analysis.

Component Description (continued)
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Rear Panel

Gas inlet valves

Compressed air 
connector

Vacuum pump 
foreline 
connector

Power cord 
connector

Component Description 

Gas inlet valves Inlet valves 1-6 for analysis gases. 

Vacuum pump 
foreline connector

For attaching the dry diaphragm roughing vacuum pump hose.

Power cord connector For setting the power voltage and connecting the analyzer to the power 
supply.

Compressed air 
connector

For compressed air supply for the pneumatically actuated, hard seal valves.
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Side Panels

Ethernet 
port

RS232 
connector

Turning the Analyzer On and Off

Turning the Analyzer On

1. Place the computer, monitor and printer ON/OFF switches in the ON position.

2. Place the analyzer ON/OFF switch in the ON position.

3. Turn on the dry diaphragm roughing vacuum pump. 

Connector Description 

Ethernet port Port for an Ethernet cable allowing communication between the analyzer 
and the computer.

RS-232 connector Used to connect the SmartPrep. 

On/Off switch For turning the analyzer on and off.

The pump must warm for approximately two hours before performing analyses. 
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Turning the Analyzer Off

It is recommended that the analyzer be turned on at all times. If it does become necessary to turn it off, 
perform the following steps:

1. Go to  File > Exit from the analyzer program (or use the Alt+F4 keyboard shortcut).

If an analysis is in progress, the following message is displayed:

Select Yes and the analysis program closes. The analysis continues and data continue to be 
collected. Queued reports under the printer will print. If a power failure occurs and an 
uninterruptible power supply (UPS) is not attached to the analyzer, the data collected after exiting 
the analysis program are lost.

Select No and the program remains open and the analysis continues to run.

2. Shut down the computer using standard Windows procedure.

3. Place the monitor and printer ON/OFF switches in the OFF position.

4. Place the analyzer ON/OFF switch in the OFF position.

5. Turn off the dry diaphragm roughing vacuum pump.

Software

The application allows other computer programs to run while an automatic operation is in progress. 
The Help menu provides access to this operator’s manual and tutorials on using the software.

The MicroActive program offers a Windows interface with an easy way to collect, organize, archive 
and reduce isotherm and store sample information files for later use. The reports can be generated to 
screen, paper, or exported for use in other programs. Cut and paste graphics, scalable and editable 
graphs, and customized reports are easily generated. There are two report functions:

• User-defined reports 
• MicroActive reports 

Report options can be specified when creating the sample information file. When an analysis is per-
formed, data collected during the analysis process are compiled into the predefined reports. Reports 

Always exit the analysis program before turning off the computer. Failure to do so 
could result in loss of data.

2459- An Instrument is busy. A delay in restarting this 
application could result in loss of new data. Continue 
program exit?

              Yes                       No
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can also be defined and generated after an analysis has been run. Each selected report is displayed on 
its own tab and reflects data collected during the analysis.

MicroActive Reports

MicroActive reports are automatically generated after an analysis is performed. This feature provides a 
quick and easy way to investigate and manipulate analysis data using a variety of reporting methods.

When a sample information file with a status of Complete, Analyzing, or Entered is opened, an iso-
therm linear plot and log plot of the data collected during analysis are displayed as well as a summary 
of the analysis giving the total pore volume. From this window numerous reports are accessible from a 
dropdown menu, including:

• BET Surface Area
• Langmuir Surface Area
• t-Plot
• Alpha-S Method
• BJH Adsorption
• BJH Desorption
• Dollimore-Heal Adsorption
• Dollimore-Heal Desorption
• Horvath-Kawazoe
• DFT Pore Size
• DFT Surface Energy
• Dubinin-Radushkevich
• Dubinin-Astakhov

When a report is opened, plots and summary data are displayed, and in some reports certain parameters 
(for example, thickness curve type, pore geometry, and interaction parameters) are also displayed. 
Plots may be edited by selecting the data points or data point range to be included in the plots and mod-
ifying the parameters. When a report is edited, the results are immediately reflected in the plots and 
summary data displayed in the window.

Report Features

• After analysis, reports can be viewed, printed, and/or copied and pasted into other documents. 

• The report zoom feature provides the viewing of fine graph details and the ability to shift the axes. 

• Reports can be customized with a choice of fonts and a logo can be added to the report header.
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Using the Software

The analysis program operates in the Windows environment and requires familiarity with standard 
Windows operations, for example, using the mouse, menus and windows. While this manual provides 
brief instructions for such standard operations, if necessary, refer to Windows documentation or its 
online help system to clarify any Windows functions. The application uses a standard window and 
libraries for file selection. Refer to Libraries, page 1-17 for details on the File Selector.

Shortcut Menus

Shortcut menus are available for:

• the instrument schematic when Manual Control is enabled. Refer to
Enable Manual Control, page 4-9.

• onscreen graphs and tabular reports. Refer to Report Shortcut Menus, page 5-20.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations (when 
applicable) are listed to the right of the menu item. 

Another shortcut method of accessing a menu or function is to use the Alt key plus the underlined let-
ter in the menu command. For example, to access the File menu, press Alt + F. Then press the 
underlined letter on the submenu. For example, Alt + F opens the File menu; then press O to access the 
File Selector for opening files. 

If the underscored letters do not display menus and windows, press the Alt key on the 
keyboard.
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Shortcut Key(s) Function 

F1 Accesses the online operator’s manual.

F2 Displays the File Selector screen. 

F3 When in the File Selector screen, displays the file search box.

F4 When in the File Selector screen, opens the address bar.

F6 Cascades open windows.

F7 Tiles open windows.

F8 Opens the File Selector allowing you to start a report from a selected .SMP 
file.

F9 Closes all open reports.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save 
changes displays.

Shift + F9 Accesses shortcut menu of (1) selected component on instrument schematic, 
when manual control is enabled or (2) onscreen reports.
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Files

File Status and Description

In the File Selector window, the Mic Description column and the Mic Status column display file 
description and file status, respectively.

File Name Conventions

For sample information files, a default file name (the next available sequence number) and a default 
file extension display. For Sample tube, Degas conditions, Analysis conditions, Adsorptive properties 
and Report options, only a default file extension displays.

The following table lists the default file extensions assigned to program files:

File Status Description 

Analyzing Sample information files that are currently being used for analysis.

Complete Sample information files used in an analysis that has been completed.

Entered Sample information files containing manually entered data.

No Analysis Sample information files which have not been used to perform an analysis.

Prepared Sample information files that have been used in an automatic degas operation 
but have not been analyzed. This status is applicable only if using the 
SmartPrep degasser.

Preparing Sample information files currently being used in an automatic degas operation. 
This status is applicable only if using the SmartPrep degasser.

File Type Default File Name Extension

Alpha-s curve .ALS

Adsorptive properties .ADP

Analysis conditions .ANC

Degas conditions .DEG

Heat of Adsorption Report .HOA

Methods .MTH
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The following file types are available when printing or exporting reports:

Report options .RPO

Sample information .SMP

Sample tube properties .STB

Thickness curve .THK

Report .REP

Spreadsheet .XLS

ASCII .TXT

File Type (continued) Default File Name Extension
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Libraries

The application contains libraries of the Micromeritics application specific files. The library is located 
within the File Selector window and can only be viewed within the application. The library provides an 
easy way to locate and open application specific files. For example, to locate and open a sample infor-
mation file, click the Sample Information library folder on the left. Then select the .SMP file on the 
right and click Open.

Library Name Default Directory File extension

Adsorptive Properties ...\Param .ADP

Analysis Conditions ...\Param .ANC

Degas Conditions ...\Param .DEG

Methods ...\Data .MTH

Report Options ...\Param .RPO

Sample Information ...\Data .SMP

Sample Tube ...\Param .STB

Library
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Menu Structure

All program functions are located on menus accessed from the menu bar. Each menu contains com-
mands and, in some cases, a submenu. A submenu is indicated when the command is followed by an 
arrow.

Main Menu Bar

All program functions are accessed from the main menu bar. The following table contains brief menu 
descriptions and links to additional information on each item:

Menu Item Description 

File Use to  manage files. Refer to FILE MENU, page 3-1.

Unit [n] Use to perform analyses, calibrations and other instrument operations. 
Refer to UNIT MENU, page 4-1.

Reports Use to run reports and view the results. Refer to 
REPORTS MENU, page 5-1.

Options Use to edit default method, specify system configuration and data 
presentation formats. Refer to OPTIONS MENU, page 6-1.

Window Use to arrange open windows and display a list of open windows. Refer to 
Window Menu, page 1-19.

Help Use to access this operator’s manual, Micromeritics web page, and 
tutorials. Refer to Help Menu, page 1-20.

Arrow indicates a 
submenu is available
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Window Menu

The Window menu lists open files and provides the ability to rearrange the way open windows dis-
play. A check mark appears to the left of the active window.

Window Menu 
Option

Description 

Cascade Stacks open windows in a fanned format so that each window title bar is 
visible. F6 can also be used as a keyboard shortcut.

Tile Resizes open windows and arranges windows horizontally so that multiple 
windows can be viewed at once. F7 can also be used as a keyboard 
shortcut.

Arrange Icons Arranges the symbols for all minimized windows.
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Help Menu

The Help menu provides access to the online operator’s manual, the Micromeritics web page, tutorials, 
and information about the analyzer.      

Setup Program

The Setup program is located on the installation CD. It is used to:

• Reinstall the application
• Add an analyzer
• Move an analyzer 
• Remove an analyzer
• Change analyzer setup
• Reinstall calibration files for an analyzer
• Import an analyzer from a previous installation on this PC

Help Menu Option Description 

Operator’s Manual Provides access to the online operator’s manual.

Tutorials Provides access to instructional tutorials.

Micromeritics on the 
Web

Provides a link to the Micromeritics web page:
www.Micromeritics.com

3Flex on the Web Provides an Internet link to additional analyzer information:
3Flex on the Web

About 3Flex Provides the analysis program version number.

If the IP address needs to be changed on the computer connected to an analyzer, 
reference the Entering Ethernet Settings in Windows 7 tutorial accessed from the Help 
menu. The IP address for the computer and the IP address specified in the setup 
program must match.
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3Flex Introduction
2.  OPERATIONAL PROCEDURES

Introduction

This chapter contains information on: 

• working with Interactive Reports

• specifying method defaults

• creating sample files in advanced, basic, and restricted formats

• defining parameter files

• manually entering isotherm data

• preparing samples and performing an analysis

• generating reports

• exporting and listing file contents to the screen, printer, or file, and listing file statistics

• generating graph overlays

Working with Interactive Reports

When opening a sample file that contains data from a complete or in progress analysis, the interactive 
reporting feature is enabled. To view a tutorial on interactive reporting, choose one of the following 
options:

• click the following link: Working with Interactive Reports

• go to Help > Tutorials > Working with Interactive Reports

1. When opening a sample file that contains analysis data, a window with the following information 
displays:

• an isotherm linear plot and log plot of the data collected during analysis
• a summary of the analysis giving a single total pore volume and surface area
Apr 2013 2-1 
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2. To view the plots in either Relative or Absolute pressure, click the Relative Pressure or 
Absolute Pressure option.

3. To view another report, click the Isotherm drop-down arrow and make another selection. 

The choices in this list allow you to:

• display the sample information window in either select basic or advanced format and modify 
certain file parameters, or

• select another model from the list and edit the parameters or data range used, or edit the model 
calculations contained in the plot in various ways.
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For example, if BET Surface Area is selected, a window similar to the following displays: 

When ranges are edited, the changes are reflected immediately in the plots and the summary data 
displayed in the window. Some editing options are:

• Drag the blue bars to increase or decrease the range of data included in the plot. 

• Press CTRL, then left-click the mouse on a data point in the Isotherm Linear Plot to include or 
omit the data point from the BET plot. 

• Right-click the mouse to display a popup menu to include reports, enable or select overlays, 
edit curves, axes, legends, titles, and copy and paste the data in a graph or in tabular format.

4. After editing the report, save the changes in the sample information file by clicking Save.

Editing the Default Method

Sample files include the information required by the analyzer to perform analyses and collect data. A 
method is a template for sample files that contains the parameters to be used for an analysis. The anal-
ysis software contains a default method. When a new sample information file is created, all the 
parameters are filled with the values in the default method. They can then be edited if necessary.
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1. Go to Options > Option Presentation and select Advanced on the popup menu. Ensure a 
checkmark appears to the left of Advanced.

2. Go to Options > Default Method.

3. In the Sequence Number text box, specify an optional default alphanumeric file sequence string. 
This field must contain a minimum of 3 numbers. As files are created, this number is 
incrementally sequenced as a part of the file name and will also display in the Sample text box 
when a sample file is created.

4. In the Sample file name text box, enter an optional default file name. This information will be 
appended to the sequence number as a part of the file name and will also display in the Sample 
text box when a sample file is created. The $ character must remain in this field.

5. In the text box to the right of the Sample field, enter a format for the default sample identification. 
Include the $ character to automatically include the contents of the Sequence Number field and 
Sample file name field as part of the sample identification. 
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6. Enter default Operator, Submitter, and Bar Code identification information in the respective 
text boxes. This information will display in the Sample Description tab of new sample 
information files.

7. To specify default sample tube parameters click Edit to the right of the Sample tube dropdown 
list. Refer to Sample Tube, page 2-14 for instructions on editing and saving the sample tube 
parameters to make them available in the Sample tube dropdown list.

8. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or 
calculated by the system (Calculate). Refer to Mass group box, page 3-12.

9. In the Type of Data group box, indicate if the data is to be automatically collected by the system 
or manually entered by the operator. 

10. The optional user-defined fields in the User Parameters group box may be used to enter and 
track information from another instrument or source, along with other statistical process control 
(SPC) data. To omit these fields in sample files, select the Omit checkbox to the right of the field. 
Refer to Sample Information Files, page 3-10.

11. Use the Comments text box to enter notes about the Method.

12. After completing the Sample Description window, select the parameter tabs to edit other sample 
information file parameters. The saved parameter defaults become the defaults for new sample 
files. Refer to Defining Parameter Files, page 2-14.

13. Click Save, then click Close.

The labels for the Sample, Operator, Submitter, and Bar Code fields can be modified by 
overwriting the default labels. These fields can also be omitted from a sample file by 
selecting the Omit checkbox.
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Defining Sample Information Files

A sample information file must be created for each analysis. This file can be created prior to or at the 
time of analysis. The sample information file identifies the sample, guides the analysis, and specifies 
report options.

A sample information file may be created in Advanced, Basic, or Restricted format. 

Format Description 

Advanced Displays all parts of sample information and parameter files. Navigate to 
parameter windows by selecting the tabs across the top of the window. 

 Basic Displays the entire sample information file in a single window with no tabs 
across the top. This option is used once the parameter files have been created. 
The previously entered or default parameter files are then accessible using 
dropdown lists.

 Restricted Displays the sample information file in a single window similar to the Basic 
format with certain functions disabled. A password must be entered when the 
restricted format is selected. That same password must be entered to exit the 
format. This format is typically used in laboratories where analysis conditions 
must remain constant, for example, in the pharmaceutical industry. The 
Advanced format option is not available from the Restricted format. 
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Creating Sample Files in Advanced Format

The values specified in the parameter portions of the default sample file (Degas Conditions, Analysis 
Conditions, and Report Options) are saved as the defaults for new sample files. To navigate from one 
set of parameters to another, select the parameter tab at the top of the window.

• Sample Tube files are created on the Sample Description tab.

• Adsorptive Properties files are created on the Analysis Conditions tab.   

1. Ensure that the Advanced option is checked in the Options > Option Presentation menu.

The Degas Conditions tab displays only if enabled in Options > Option Presentation > 
Show Degas Conditions.
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2. Go to File > New Sample.

3. Select a Method from the Method dropdown list.

4. Enter a sample description in the Sample text box. 

5. Enter Operator, Submitter, and Bar Code identification information in the respective text 
boxes. Some text box fields may have been renamed or may not display if modified in Options > 
Default Method.

6. In the Sample Tube dropdown list, select a sample tube from the list or click Edit to specify a 
sample tube description, empty tube properties for calculated free space, isothermal jacket, filler 
rod, and vacuum seal type. The text entered into the Description field will display in the Sample 
Tube dropdown list of the previous window. Click OK to return to the previous window. Refer to 
Sample Tube, page 2-14.

7. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or 
calculated by the system (Calculate). Refer to Mass group box, page 3-12.

8. In the Type of Data group box, indicate if the data is to be automatically collected by the system 
or manually entered by the operator. Select Automatically collected for all sample runs where 
the data are collected. Select Manually entered when another sample has been run on a different 
instrument or different model instrument so that data can be analyzed or used for comparison. If 
Manually entered is selected, the data are entered in the Isotherm interactive report. Refer to 
Manually Entering Isotherm Data in a Sample File, page 2-23.

Some text boxes may 
have different field 
labels if renamed or 
may not display if 
omitted in Default 
Method.
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9. If SPC (Statistical Process Control) information is to be reported, enter appropriate information in 
the User Parameters group box. These are user-definable parameters that can be entered and 
tracked along with other statistical process control data. 

10. Enter any pertinent information about the sample information file in the Comments text box. 
Comments are displayed in the report header.

11. Click the Add Log Entry button to enter notes for the instrument log report. Create entries that 
cannot be recorded automatically through the application software. For example, record that the 
port filter was changed. 

12. To auto-populate fields from another .SMP file, click the Replace All button and select a .SMP 
file that contains the desired parameters. Select the file and click Replace.

13. After completing the Sample Description window, click the parameter tabs to edit other sample 
information file parameters. See Defining Parameter Files, page 2-14.

14. Click Save, then click Close to save the file with the default file name. To save as a different file 
name, go to File > Save As and enter a new file name. The file can later be retrieved from the 
Sample Information folder in the library.

Library

Sample 
Information 
folder
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Creating Sample Files in Basic or Restricted Format

The Basic and Restricted formats use predefined parameter files to create a sample information file. 
Refer to Sample Information Files, page 3-10. 

• When using the Basic format, switch to the Advanced format to edit parameter file values.

• When using the Restricted format, parameter files cannot be edited. 

1. Ensure that the Basic or Restricted option is checked in the Options > Option Presentation 
menu.

2. Go to File > New Sample.

3. Select a Method from the Method dropdown list. Refer to
Editing the Default Method, page 2-3.

4. In the Sample field, enter a sample description. 

5. Select a sample tube from the Sample Tube dropdown list. 

The Restricted format 
does not show an 
Advanced option.
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6. In the Mass group box, indicate if mass is to be manually entered by the operator (Enter) or 
calculated by the system (Calculate). Refer to Mass group box, page 4-10.

7. Click the dropdown arrows to select default parameter files for Degas conditions, Analysis 
conditions, and Report options.

8. To auto-populate fields from another .SMP file, click the Replace All button and select a .SMP 
file that contains the desired parameters. Select the file and click Replace.

9. Click the Add Log Entry button to enter notes for the instrument log report. Create entries that 
cannot be recorded automatically through the application software. For example, record that the 
port filter was changed. 

10. Click Save, then click Close. The file can be retrieved later from the Sample Information folder in 
the library.

Library

Sample 
Information 
folder
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Opening Sample Information Files       

Opening Files with a Status of Complete, Analyzing, or Entered

1. Go to File > Open or use the F2 keyboard shortcut. 

2. From the Sample Information library folder, select a .SMP file with a status of Complete, 
Analyzing, or Entered and click Open (or double click the file name). The interactive reporting 
window displays. Refer to Working with Interactive Reports, page 2-1. 

To view a tutorial on interactive reporting, go to Help > Tutorials > Working with Interactive 
Reports.

When working with an existing file, it is recommended that a copy of the file be used 
rather than the original. 

Columns in the File Selector window can be sorted by clicking the column header.
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Opening Files with a Status of Preparing, Prepared, or No Analysis

1. Go to File > Open or use the F2 keyboard shortcut. 

2. From the Sample Information library folder, select a .SMP file with a status of Preparing, 
Prepared, or No Analysis and click Open (or double click the file name). 

3. The Sample Description window displays in the specified format (Advanced, Basic, or 
Restricted). The following window is shown in Advanced format.
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Defining Parameter Files

The following file types can exist as part of the sample information file as well as individual parameter 
files:

• Sample Tube Files .STB file extension

• Degas Conditions .DEG file extension

• Analysis Conditions .ANC file extension

• Adsorptive Properties .ADP file extension

• Report Options .RPO file extension

• Method .MTH file extension

Default parameter files can be used for multiple analyses without having to re-enter the values each 
time an analysis is performed.

Predefined parameter files are included with the program and can be edited as needed or new parame-
ter files can be created. The Replace button can be used to overwrite values from an existing file. 
Changes can be made as needed to the new file while the original file remains unchanged.

Sample Tube

Sample Tube files specify information about the sample tube.

1. Go to File > Open. Select the Sample Tube library folder and enter a file name in the File name 
field.

2. Click Open.
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3. Click OK when prompted to create a new file.

4. Enter a description of the sample tube in the Description field. This description displays in the 
Sample tube dropdown list on the Sample Description tab.

5. If using calculated free space, enter the warm free space, cold free space and non-ideality factor; 
or click Load from Sample File to import the information from an existing sample information 
file. 

6. Indicate if an isothermal jacket and/or filler rod will be used by selecting the Use isothermal 
jacket checkbox and/or User filler rod checkbox. Filler rods help to ensure accuracy in samples 
with lower total surface areas by reducing the free-space volume. It is generally a good practice to 
use filler rods for samples having less than 100 square meters of total surface area. Filler rods are 
unnecessary for samples with total surface areas greater than 100 square meters.

7. Select the vacuum seal type to be used.

8. Click Save, then click Close.

Degas Conditions

Degas Conditions files contain degassing information for sample preparation.    

Degassing is a required step in preparation for the analysis; however, the Degas 
Conditions tab is only applicable if using the SmartPrep Degasser. This section 
contains degassing instructions that will be sent to the SmartPrep Degasser 
equipment. Refer to Preparation button, page 3-21 for in situ degassing.

The Degas Conditions tab only displays if enabled in Options > Option Presentation > 
Show Degas Conditions.
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1. Go to File > Open. Select the Degas Conditions library folder and enter a file name in the File 
name field.

2. Click Open. 

3. Click OK when prompted to create a new file.

4. To overwrite degas conditions with parameters from another Degas Conditions file, click the 
Degas Conditions dropdown arrow and select a file from the list or click Browse, then locate and 
select the .DEG file containing the new parameters and click Open. 
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5. Use the Insert button to enter up to three stages of degassing ( temperature, ramp rate, and time). 
When using the SmartPrep degasser, the maximum temperature that can be entered is 450 °C.

6. Click Save, then click Close.

Analysis Conditions

Analysis conditions specify the data used to guide an analysis. 

1. Go to File > Open. Select the Analysis Conditions library folder and enter a file name in the File 
name field.

2. Click Open. 

3. Click OK when prompted to create a new file.
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4. To overwrite analysis conditions with parameters from another Analysis Conditions file, either 
click the Run Conditions dropdown arrow and select a file from the list or click Browse then 
locate and select the .ANC file containing the new parameters and click Open. 

5. To overwrite adsorptive properties with parameters from another Adsorptive Properties file, click 
the Adsorptive dropdown arrow and select an adsorptive from the list or click Browse, then 
locate and select a .ADP file containing the new parameters and click Open. Refer to Adsorptive 
Properties, page 2-19 and Analysis Conditions Files, page 3-16.

6. To enter starting and ending relative pressure points, click the Insert Range button

7. To specify pressure targets in mmHg, mbar, or kPa instead of relative pressure, select the 
Absolute pressure dosing checkbox. This option is typically selected when using adsorptives at 
analysis conditions above the critical point of the gas; for example, H2 adsorption on carbon at 
liquid nitrogen temperature.

8. Click the following buttons to specify:  

9. Click Save, then click Close.

Button Use to Specify... 

Preparation evacuation rate/time/level, leak test and time values, elevator 
prompts, and in situ degassing

Free space how the free space is to be measured

pº and T how the saturation pressure (Po) is to be measured or calculated 
and the analysis bath temperature

Dosing options for absolute and/or relative pressure tolerance

Termination backfill options after analysis
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Adsorptive Properties

Adsorptive properties provide the properties of the fluid used for the analysis. 

1. Go to File > Open. Select the Adsorptive Properties library folder and enter a file name in the 
File name field.

2. Click Open. 

3. Click OK when prompted to create a new file.

4. Enter a description of the adsorptive in the Description text box (for example, the gas and the 
temperature). When saved, this description will display in the Adsorptive dropdown list of the 
Analysis Conditions tab.

5. Enter the mnemonic for the Adsorptive gas (for example, N2) in the Mnemonic text box.
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6. Enter information in the following text boxes:

• Maximum manifold pressure - the highest pressure that the manifold will be dosed. To avoid 
damage to the instrument, this number is limited to 925 mmHg. Low pressure sources, such as 
vapors, will require lower numbers.

• Therm. tran. hard-sphere diameter - an estimate of molecular size used in calculating the 
thermal transpiration correction.

• Molecular cross-sectional area - the area that a single adsorbed molecule occupies on the 
surface of the sample. It is used in surface area calculations.

• Adsorbate molecular weight - the molecular weight is used for the weight % column of the 
isotherm tabular report and for the pressure composition isotherm plot.

7. Adsorbed molecules occupy volume in the sample tube reducing the cold free space.  Select the 
Adsorbed-phase free-space correction checkbox to adjust the reported quantity adsorbed to 
correct for this effect. This option is appropriate for all sample analyses that use the real gas 
equation of state. It should be deselected for blank tube analyses.

8. To import parameters from a Fluid Properties file, click Open, then locate and select the .FPI file 
containing the new parameters and click Open. Click Save to save the changes. Changing fluid 
properties should only be necessary if an adsorptive is to be used for which no adsorptive 
properties are provided.

9. In the Dosing Method group box, select the source to dose the adsorptive:

• Normal - dose from a pressurized tank of gas attached to a gas inlet port.

• From Psat tube - the Psat tube is filled with condensed adsorptive and dosed from the Psat 
tube. This is typically used for Krypton. The instrument will determine the maximum pressure 
that can be dosed based on the analysis temperature and the saturation pressure information in 
the Fluid Properties.

• From Port 3 - the tube attached to sample port 3 is filled with condensed adsorptive and dosed 
from Port 3. The instrument will determine the maximum pressure that can be dosed based on 
the analysis temperature and the saturation pressure information in the Fluid Properties.

• Vapor Source - a container of condensed vapor is attached to the Psat port in place of the Psat 
tube, and is dosed from the Psat port. 

• Charge from inlet - select to have the tube automatically charged with condensate from a gas 
inlet port after the Dewar is raised. 

• Purify adsorptive - select to have the condensate in the tube purified after charging by 
evacuating the gas over the condensate. If Charge from inlet is selected, you may choose 
Purify adsorptive to have noncondensing contaminants automatically removed from the 
dosing tube prior to analysis. After the adsorptive has condensed in the selected Psat tube or 
Port 3, the remaining gas in the tube will be evacuated to remove noncondensing 
contaminants. A small amount of the purified adsorptive condensate will then return to gas 
phase to restore equilibrium pressure in the tube.
2-20                                                    Apr 2013



3Flex Defining Parameter Files
10. If Vapor Source is selected in the Dosing Method group box, the Vapor Source Temperature 
must be entered whether it is to be controlled by the instrument or not. The instrument will 
determine the maximum pressure that can be dosed based on this temperature and the saturation 
pressure information in the Fluid Properties. 

11. Select the Controlled by instrument using heating mantle checkbox if the vapor source 
temperature is to be controlled by the instrument with the heating mantle.

12. Click Save, then click Close.

Report Options

Report Options files specify the type of reports that will be generated from an analysis or from manu-
ally entered data. They also contain report details, for example, axis scale, axis range, and column 
headings. Report options files may contain tabular reports, plots, or both, as well as user-defined report 
tables.

Report Options files may be defined to include overlay options. This system allows the overlay of up 
to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a different 
plot type from the same analysis. Refer to Generating Graph Overlays, page 2-60.

1. Go to File > Open. Select the Report Options library folder and enter a file name in the File 
name field.

2. Click Open. 
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3. Click OK when prompted to create a new file.

4. To overwrite report options with parameters from another Report Options file, click the Report 
Options dropdown arrow and select a file from the list or click Browse, then locate and select the 
.RPO file containing the new parameters and click Open. 

5. To display a title on the report header, select the Show report title checkbox and enter the report 
title in the text box.

6. To display a graphic on the report header, select the Show report title checkbox and enter the 
report title in the text box. Click the Browse button to locate a .BMP or .EMF file. Specify the 
graphic size in the Height and Width text fields.

7. The Selected Reports list box displays the reports that may be generated.

• Select the checkbox to the left of the report to include in this file.

• To specify report options, highlight the report in the Selected Reports list box and click Edit. 
Make changes as necessary. Click OK.

8. Click Save, then click Close.

For information on the Overlays and Import buttons, see Generating Graph Overlays, page 2-60.
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Manually Entering Isotherm Data in a Sample File

This process allows the manual entry of pressure data by importing or pasting data from a sample file 
with a Complete status.

Importing Manually Entered Isotherm Data from the Interactive 
Isotherm Window

When importing isotherm data from an external ASCII text file using the Import button on the interac-
tive isotherm window, the ASCII text file must follow these rules:

ASCII text file format rules

• Data must be in two columns and separated by a comma or white-space. 

• Acceptable column headings are:

Relative Pressure
Absolute Pressure (mmHg) 
Absolute Pressure (kPa) 
Absolute Pressure (mbar) 
Quantity Adsorbed (mmol/g) 
Quantity Adsorbed (cm³/g STP) 
Quantity Adsorbed (cm3/g STP)

Sample ASCII text file

To import the ASCII text file:

1. Go to File > New Sample and open a new sample information file.

2. On the Sample Description window, select Manually entered in the Type of Data group box.

3. In the dropdown list at the bottom of the Sample Description window, select Isotherm. 

Relative Pressure Quantity Adsorbed (cm3/g STP) 
0.00156203 21.5917 
0.0453336 42.9898 
0.0667632 46.1971 
0.0944588 49.4713 
0.105895 50.6657 
0.128984 52.9288 

000-000 : Desorption 
Relative Pressure Quantity Adsorbed (cm3/g STP) 
0.969366 403.793 
0.956297 402.889 
0.944633 402.042
0.932647 401.191
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4. Resize the isotherm window until the Import button displays.

5. Ensure that all parameter fields are set appropriately then click Import.

6. On the File Selector window, locate and select the .TXT file and click Open. The isotherm data 
from the original sample file is imported and displays in the new sample file. If an error message 
appears instead, verify that the .TXT file format (listed above) is correct. 

Copying / Pasting Manually Entered Isotherm Data

1. Go to File > Open [.SMP file] and select the sample information file that contains the isotherm 
data to be copied and pasted. This file must have a Complete status. 

2. Click Open. The file will open to the interactive isotherm report window.

Import button
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3. Right click in the graph area of the interactive reports window and select Copy Data. This will 
copy the data from the active file to the clipboard.

4. Go to File > New Sample and open a new sample information file.

5. On the Sample Description window, select Manually entered in the Type of Data group box. 

6. In the dropdown list at the bottom of the window, select Isotherm. 

7. Resize the interactive isotherm window until the Paste button displays.

8. Ensure that all parameter fields are set appropriately then click Paste. The isotherm data from the 
original sample file is pasted from the clipboard and displays in the new sample file. 

Right click in the 
graph area and 
select Copy 
Data

Paste button
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Preparing for Analysis

The following table outlines the tasks to properly prepare for an analysis and the location of the task 
procedure. It is recommended to perform the tasks in the following order: 

Cleaning and Labeling Sample Tubes

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The follow-
ing table indicates which materials are supplied by Micromeritics and which are supplied by the user. 
The procedures following the table are recommended.

1. Preheat drying oven at 110 ºC.

2. Verify that the ultrasonic cleaning unit is clean.

3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the 
ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). Ensure the 
detergent is dissolved before placing the sample tubes and filler rods into the water. If too much 
detergent is used, it may be difficult to rinse from the sample tubes.

Task Name and Location 

Clean the sample tube Cleaning and Labeling Sample Tubes, page 2-26

Create the sample file Defining Sample Information Files, page 2-6

Weigh the sample Determining the Sample Mass, page 2-28

Degas the sample Degassing the Sample, page 2-30

Load sample on sample port Installing the Sample Tube, page 2-30

Fill Dewar and check LN2 level Filling and Installing the Analysis Dewar, page 2-41

Materials Supplied by Micromeritics Materials Supplied by User 

• Sample tube
• Filler Rod
• Sample tube brush
• Stopper for sample tube
• Sample tube rack
• Sample weighing support
• Sample data worksheet (copied from Appendix A 

of this manual)

• Drying oven
• Ultrasonic cleaning unit
• Detergent
• Rubber gloves or lint-free cloth
• Acetone or isopropyl alcohol
• Safety glasses
• Waste container
• Analytical balance
• Pipe cleaners
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4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit. Then place 
the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately fifteen minutes.

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler rods and 
remove the sample tubes and filler rods from the unit. 

6. Clean the interior of the sample tubes with the brush supplied with the system.

7. Rinse the sample tubes and filler rods thoroughly with hot water. Then rinse again with isopropyl 
alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in the rack. 
Bake in a vacuum oven for two hours at 110 °C.
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9. Remove the sample tubes and filler rods from the oven and allow to cool.

10. Wipe a rubber stopper with a lint-free cloth. 

11. Label the sample tube and stopper for identification.

Determining the Sample Mass

Analysis results are expressed in units of surface area per gram of sample; therefore, it is important the 
sample mass be known. The mass is best calculated as:

• weigh the empty Sample Tube Set (sample tube and stopper, check seal or TranSeal) before degas

• weigh the Sample Tube Set with sample before degas and subtract from the weight of the empty 
Sample Tube Set

• weigh the Sample Tube Set with sample after degas and subtract from the weight of the empty 
Sample Tube Set

• weigh the Sample Tube Set with sample after analysis and subtract from the weight of the empty 
Sample Tube Set

A Sample Data Worksheet for recording the weights and calculating the mass is included in Appen-
dix A. Make copies as needed.

Use a copy of the Sample Data Worksheet to record the following:

1. Record the Sample Tube Identification.

2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize at 
zero.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube 
is installed on the analysis port.
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3. Place the sample tube set on the balance. 

4. Record the stabilized weight on the Sample Data Worksheet as [A] Mass for empty sample tube 
set. Remove the sample weighing support and sample tube set from the balance.

5. Place a sample container on the balance and slowly pour the sample into the container.

6. Remove the rubber stopper (check seal or TranSeal) from the sample tube.

7. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the 
weighing container into the sample tube.

Do not touch the sample with bare hands while performing the following steps. Doing 
so could affect the accuracy of results.

Funnel
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8. Replace the rubber stopper (check seal or TranSeal).

9. Weigh the sample tube set containing the sample and record the value on the Sample Data 
Worksheet as [B] Sample tube set plus sample mass (Before Degas).

10. Subtract the [A] Mass for empty sample tube set from the [B] Mass of sample tube set plus sample 
and record this value as the [C] Sample mass (Before Degas).

Degassing the Sample

After the sample has been weighed, use a degassing unit to remove any contaminants which may have 
adsorbed to the surface or pores. Appropriate degassing units are available from Micromeritics. Refer 
to ORDERING INFORMATION, page 9-1 for ordering information.

If using the SmartPrep degasser, go to Unit [n] > Degas and degas the sample using menu commands 
and information entered in the Degas Conditions window. Refer to the SmartPrep operator’s manual 
for operating instructions.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample and record the mass on the Sample Data 
Worksheet as [B] Sample tube set plus sample mass (After Degas). 

2. Subtract the [A] Mass for empty sample tube set (Before Degas) from the [B] Sample tube set plus 
sample mass (After Degas) to obtain the sample’s mass. Record this value as [C] Sample mass 
(After Degas).

Installing the Sample Tube

Repeat the following steps for each sample to be installed. Up to three sample tubes can be installed. 
To install a sample tube to a port:    

If using... Then...

A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it 
touches the sample tube bulb. The top of the isothermal jacket 
should be aligned with the mark on the sample tube. If using 
sample material, insert it into the sample tube.

A filler rod Hold the sample tube horizontally and carefully slide the filler 
rod into the tube until the metal clip touches the end of the tube.
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1. Loosen the connector nut on the Psat tube and rotate it out of the way.

2. Position the Dewar lid so that the slot for the Psat tube is on the left between ports 1 and 2.

3. Insert the sample tube through one of the holes in the Dewar lid.

4. Place the sample port nut, ferrule and O-ring onto the sample tube stem.

Sample Tube Filler Rod Metal Clip

O-ring

Ferrule

Sample Port 
Nut Dewar lid

Psat slot
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5. Insert the sample tube to the analysis port and ensure it is completely in the port. Securely screw 
the sample port nut onto the analysis port and hand tighten the nut.

6. Repeat for each sample tube.

7. Position the Dewar lid approximately 3/4 in (19 mm) below the sample port nut.

8. Slide the Psat tube into the Psat slot in the Dewar lid and retighten the Psat tube connector nut.

9. Insert the jacket onto the Psat tube and insert the Psat tube into the slot on the Dewar lid. Ensure 
that the Psat tube jacket is below the Dewar lid.
2-32                                                    Apr 2013



3Flex Degassing on the Analysis Port
Degassing on the Analysis Port

In addition to preparing a sample using a device such as a SmartPrep, the sample may be further evac-
uated on an analysis port prior to starting an analysis.

This section includes instructions for installing two types of heating mantles.

1. Install the sample tubes and Dewar lid on the analysis port. Refer to Installing the Sample Tube, 
page 2-30.

2. Go to Unit [n] > Sample Analysis and select the sample files. Refer to Performing an Analysis, 
page 2-44. 

3. Click Start. The sample analysis window will prompt you to raise the Dewar lid and install the 
degas heating mantle. 

4. Slide the Dewar lid up against the sample port nuts. If isothermal jackets are installed, slide up to 
touch the bottom of the Dewar lid.

5. Install the heating mantle using instructions on the following pages.

It is recommended to degas micropore samples in situ after external degassing. To degas in 
situ, refer to Preparation button, page 3-23 to setup the sample information file with 
degassing parameters.
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Installing the Heating Mantle using a Shelf Support

This device has been designed to be used for sample preparation via the instrument 
control panel. Any other use may damage this device or the analyzer.

Micromeritics offers two styles of heating mantles, either of which can be supported by 
chains or a shelf. Your heating mantle may differ slightly from the following photos. If 
installing on an analyzer without shelf support, reference Installing the Heating Mantle 
using Chain Supports, page 2-38.

If using less than three sample tubes, the heating mantle position may need to be 
adjusted such that the bottom of a sample tube touches the thermocouple located on 
the bottom surface of the mantle’s interior. A single sample tube must be installed on 
port 2.

Shelf track

Shelf locking 
mechanism

Heating mantle

Heating mantle 
lid

Heating mantle 
shelf
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1. Place the mantle around the sample tube bulbs. Ensure that the isothermal jackets are pushed up 
against the Dewar lid to avoid damage to the jackets.

2. While supporting the heating mantle with one hand, slide the shelf locking mechanism into the 
shelf track. Raise the shelf on the track until the heating mantle rests securely on the shelf and the 

Thermocouple
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sample tubes touch the bottom of the inside of the heating mantle. Turn the locking mechanism 
clockwise to secure the shelf.

3. Slide the heating mantle cover between the sample tube bulbs and the bottom of the isothermal 
jackets so that the sample tubes fit within the slots of the mantle cover.

4. Secure the heating mantle tabs onto the hook and loop fasteners of the heating mantle cover. 
Ensure there is at least a 1/2 in (12 mm) gap between the top of the mantle cover and the bottom 
of the isothermal jackets. This will prevent damage to the jackets. Replace any damaged jackets.

Take care not to apply force to the tubes while installing the lid.
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5. Insert the mantle thermocouple into the instrument’s front panel thermocouple connector. 

6. Insert the mantle power plug into the instrument’s front panel mantle power connector.

7. Acknowledge the prompt on the Sample Analysis window. The degas will proceed. When the 
degas is completed and the mantle has cooled below 45 °C, the Sample Analysis window will 
prompt you to remove the degas heating mantle and shelf, properly position the isothermal jackets 
and Dewar lid, and install the Dewar.

8. To remove the heating mantle, remove the heating mantle cover, support the bottom of the heating 
mantle, then lower the shelf. The shelf must be removed prior to installing the Dewar.

Do not touch the sample tube or the heating mantle until they have cooled. Touching 
the sample tube, or heating mantle before they have cooled could result in burns.

Thermocouple 
connector

Mantle / 
Furnace power 
outlet
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Installing the Heating Mantle using Chain Supports

1. Slide the heating mantle cover between the sample tube bulbs and the bottom of the isothermal 
jackets so that the sample tubes fit within the slots of the mantle cover. 

2. Place the mantle around the sample tube bulbs and attach the hooks on the three support chains 
through the holes in the Dewar shield skirt around the sample ports. Tighten the loops in the 
chains so that the mantle is pressing firmly against the bottom of the sample tubes. Ensure that the 
isothermal jackets are pushed up against the Dewar lid to avoid damage to the jackets.

This device has been designed to be used for sample preparation via the instrument 
control panel. Any other use may damage this device or the analyzer.

Micromeritics offers two styles of heating mantles, either of which can be supported by 
chains or a shelf. Your heating mantle may differ slightly from the following photos. If 
installing with shelf support, reference Installing the Heating Mantle using a Shelf 
Support, page 2-34.
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3. Push the mantle cover down onto the mantle so that the hook and loop fasteners are firmly 
attached. Ensure there is at least a 1/2 in (12 mm) gap between the top of the mantle cover and the 
bottom of the isothermal jackets. 

4. Insert the mantle thermocouple into the instrument’s front panel thermocouple connector. 

5. Insert the mantle power plug into the instrument’s front panel mantle power connector.

6. Acknowledge the prompt on the Sample Analysis window. The degas will proceed. When the 
degas is completed and the mantle has cooled below 45 °C, the Sample Analysis window will 

Ensure there is a 1/2 in (12 mm) 
gap between the mantle cover 
and the bottom of the isothermal 
jacket.

Thermocouple 
connector

Mantle / 
Furnace power 
outlet
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prompt you to remove the degas heating mantle and shelf, properly position the isothermal jackets 
and Dewar lid, and install the Dewar.

7. Remove the heating mantle (it is not necessary to unplug the mantle), support the bottom of the 
tubes and remove the mantle cover.

Do not touch the sample tube or the heating mantle until they have cooled. Touching 
the sample tube or heating mantle before they have cooled could result in burns.
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Filling and Installing the Analysis Dewar

Prepare the analysis Dewar after installing the sample tubes.

When handling Dewars containing cryogenic liquids:

• Wear protection by using: 

–  goggles (or a face shield)
–  an insulated or rubber apron
–  insulated gloves

• When transferring cryogenic liquids from one container to another: 

–  cool the receiving container gradually to minimize thermal shock
–  pour the liquefied gas slowly to prevent splashing
–  vent the receiving container to the atmosphere

For glass Dewars:

• Use a plastic stirring rod when stirring substances in a Dewar containing cryogenic liquids (or other 
materials of extremely low temperature). Do not use a glass or metal stirring rod unless it has a 
protective coating.

• Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the 
Dewar’s opening. If an object of sufficient weight is accidentally dropped into the Dewar, shattering 
may occur.

Always handle glass Dewars with care. Any product incorporating a vacuum is a 
potential safety hazard and should be treated with caution. Always observe the 
precautions listed below.
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To fill and install the analysis Dewar:

1. Fill the Dewar with the analysis bath liquid (liquid nitrogen) to no higher than 2 1/4 in (5.7 cm) 
from the top. Filling the Dewar higher than this will cause an error in the free-space measurement.

2. Insert the dipstick into the Dewar and check the level of the analysis bath liquid. Condensation 
should not exceed the Level Indicator mark.

3. For best results, if the Dewar has not been used for a while, allow approximately 30 minutes for 
the temperature of the Dewar to stabilize with the bath liquid then recheck the level of the bath 
liquid. Add additional liquid if necessary.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath 
liquid before each analysis.

Wetness or frozen 
condensation indicates 
bath liquid level

Level indicator mark
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4. If using isothermal jackets, slide the jackets down the sample tube until the jackets touch the 
sample tube bulbs.

5. Slide the Dewar lid to approximately 3/4 in (or 19 mm) from the sample port nuts to ensure a 
proper seal on the top of the Dewar.

6. Attach the safety shield to the brackets on the front of the instrument.
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Performing an Analysis

Begin analysis after the sample has been degassed and transferred to the analysis port. 

Sample Analysis

Allows one analysis using different analysis conditions to run on each port.

When Start is selected, the selected sample file’s analysis conditions will be compared with the port’s 
hardware configuration to verify that the specified analysis is supported by the hardware:

• If Krypton is selected as the adsorptive, there must be a 10 mmHg transducer present on the port. 

• The minimum target pressure must be greater than the Minimum Record Pressure for the minimum 
range transducer present on the port.

• The selected sample files will be checked for matching adsorptive gases, matching Psat or Po gases 
if measured, and matching backfill gases. 

• If any selected sample file specifies an Adsorptive Dose Method from port 3 and a sample file is 
selected for port 3, an error message displays indicating the problem and the Start window will 
remain active. 

• If in-situ Degas is selected for any samples, the operator is prompted to raise the isothermal jackets 
and connect and install the degas heating mantle on the sample tubes. If this occurs, the operator will 
be prompted after degas to remove the heating mantle and properly position the isothermal jackets 
and Dewar lid. 

• If Vapor Source Temperature Control is selected and the vapor heating mantle is not connected, 
the operator is prompted to install and connect the vapor heating mantle. If Degas is selected for any 
samples, this will occur after the prompt to remove the degas heating mantle. Otherwise, this will 
occur immediately at the start of analysis.

Additional analyses can be scheduled by clicking Next after the completion of the first series of analy-
ses. The Next button appears after the first set of analyses is complete. Samples cannot be removed 
from or added to ports until the full set of analyses has completed.
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1. Go to  Unit [n] > Sample Analysis.

2. To manually close all instrument valves, click the Close Valves button.

3. For each port to be used, either click Browse and select a sample information file or click New to 
create a new sample information file.

4. Verify the information populated into the sample identification, Density, Mass, Sample + Tube, 
and Empty Tube fields. This information is pulled from the selected or newly created file. The 
Density value is applicable only if using the Calculate method for the free space determination.

5. Edit the po and Bath temperature fields, if necessary.

6. Click Report after analysis to automatically generate reports when the analysis is complete. On 
the Report Settings window, select the report destination. Click OK to return to the previous 
window.

7. Click Start to start the analysis. A window displays data as they are collected. A short delay is 
encountered before the port status at the bottom of the window changes from the Idle state.

If using port 3 as the vapor source, a sample tube cannot be attached to port 3.
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8. When the analysis is complete, remove the sample tube and store (or dispose of) the sample 
material as applicable.

Vapor Analysis

A vapor analysis requires that a vapor source container be installed. 

Installing the Vapor Source Container using a Shelf Support

1. Use an appropriate wrench to loosen the connecting nut from the port fitting by turning the 
connecting nut counterclockwise while using a second wrench to hold the port fitting stationary. 
Remove the connecting nut and the attached assembly. If the vapor source container will not be 
immediately installed, a seal or a tight-fitting plastic cap can be used to protect the sealing surface 

Use caution when removing the sample tube if using a hanging filler rod. The sample 
tube O-ring or Dewar lid may snag the filler rod retaining ring. Loosen the snag gently; 
excessive force may break the tip of the filler rod.

Micromeritics offers two methods of installing a vapor source container - one method 
for analyzers with a shelf support and another method for analyzers without a shelf 
support.

This device has been designed to be used for controlling the vapor source temperature 
via the instrument control software. Any other use may damage this device or the 
analyzer.

Each time the Psat tube or Vapor Source container is replaced, a new seal is required. 
Do not touch the sealing surfaces of the port fitting or seal with bare hands.
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assembly from scratches. Prior to reassembly, remove the existing seal or cap and insert a new 
seal

Port Fitting

Gasket

Connecting 
Nut

. 
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2. Install the vapor source container by attaching the connecting nut to the port fitting. Hand tighten 
the connecting nut by turning clockwise. Use an appropriate size wrench to tighten the assembly 
an additional 1/8 to 1/4 turn beyond finger tight, while using a second wrench to hold the port 
fitting stationary on the instrument. 

3. Using the manual controls on the instrument schematic, evacuate the space above the vapor 
source by opening valves 4 and 6 with all other valves closed. Then close valve 4 before turning 
the blue knob on the vapor source to open the connecting valve.

Turn the blue knob to adjust 
the vapor flow.
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4. Slide the shelf locking mechanism of the vapor source mantle shelf into the shelf track on the 
front of the analyzer. Leave room between the shelf and the underside of the upper cabinet to 
install the vapor source mantle. To tighten the shelf, turn the locking mechanism clockwise.

5. Slide the vapor source mantle over the vapor source container and secure with the hook and loop 
strap. If necessary, reposition the vapor mantle shelf until the vapor mantle sits securely on the 
shelf and the top of the mantle is pressed securely against the underside of the upper cabinet. 
Retighten the locking mechanism. This will prevent a cold spot from forming at the top fitting and 
condensing vapor.

Vapor source mantle 
shelf

Shelf locking 
mechanism

Shelf track

Hook and loop 
strap

Vapor source 
mantle

Vapor source 
mantle shelf

Shelf track

Thermocouple 
connector

Mantle power 
source

Shelf locking 
mechanism
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6. Insert the thermocouple plug into the connector labeled Thermocouple. Insert the power plug 
into the outlet labeled Mantle/Furnace Power. 

Installing the Vapor Source Container without a Shelf Support

1. Use an appropriate wrench to loosen the connecting nut from the port fitting by turning the 
connecting nut counterclockwise while using a second wrench to hold the port fitting stationary. 
Remove the connecting nut and the attached assembly. If the vapor source container will not be 
immediately installed, a seal or a tight-fitting plastic cap can be used to protect the sealing surface 
assembly from scratches. Prior to reassembly, remove the existing seal or cap and insert a new 
seal

Port Fitting

Gasket

Connecting 
Nut

. 

This device has been designed to be used for controlling the vapor source temperature 
via the instrument control software. Any other use may damage this device or the 
analyzer.

Each time the Psat tube or Vapor Source container is replaced, a new seal is required. 
Do not touch the sealing surfaces of the port fitting or seal with bare hands.
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2. Install the vapor source container by attaching the connecting nut to the port fitting. Hand tighten 
the connecting nut by turning clockwise. Use an appropriate size wrench to tighten the assembly 
an additional 1/8 to 1/4 turn beyond finger tight, while using a second wrench to hold the port 
fitting stationary on the instrument. 

3. Using the manual controls on the instrument schematic, evacuate the space above the vapor 
source by opening valves 4 and 6 with all other valves closed. Then close valve 4 before turning 
the blue knob on the vapor source to open the connecting valve.

Turn the blue knob to adjust 
the vapor flow.
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4. Slide the vapor source mantle over the vapor source container and secure with the hook and loop 
strap. Insert the thermocouple plug into the connector labeled Thermocouple. Insert the power 
plug into the outlet labeled Mantle/Furnace Power.

Running a Vapor Analysis

1. Open the sample file to be used for the analysis.

2. Go to the Analysis Conditions tab. Verify that the selected Adsorptive is correct. If not, select 
the correct Adsorptive from the dropdown list. 

a.) Use the Edit button to the right of the Adsorptive dropdown to display the Analysis 
Adsorptive Properties window. 

b.) Select Vapor source in the Dosing Method group box. If running the vapor analysis on Port 
3, select From Port 3 and skip Step C.
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c.) Set the Vapor Source Temperature to the correct value, and select the Controlled by 
instrument using heating mantle checkbox if the vapor source is to be automatically heated 
to this temperature.

3. Click OK, then click Save to save any changes.
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Blank Analysis

A blank analysis is performed in the same manner as a sample analysis however, the sample tubes will 
not contain sample material. 

1. Install blank tubes with filler rods and isothermal jackets into each of the sample ports. 

2. Be sure to use new O-rings that are new or in good condition on the sample tubes. 

3. Make sure the Dewar lid is attached. 

4. Verify that the isothermal jacket and filler rods are checked as being used in the sample tube file.

5. Reference Defining Sample Information Files, page 2-6 for instructions on defining the sample 
information file.

Reference Material Analysis

Refer to Reference Analysis, page 4-7 for instructions on performing a reference material analysis.
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Generating Reports

Reports > Start Report (or use the F8 keyboard shortcut)

1. Select a .SMP file from the library. The selected report name appears in the File name text box. 
To select more than one file, hold down the Ctrl key on the keyboard while selecting the files, or 
hold down the Shift key to select a range of files. Click Report.

2. Select the report destination in the Report Settings window and click OK. 
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3. If only one file was selected in Step 1, the Select Reports window displays. Verify the reports to 
generate and select additional reports if necessary. Click OK. If multiple files were selected, this 
window is not displayed.

4. Click a tab across the top of the window to review each report.
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Exporting Files

File > Export

Provides the option to print the contents of one or more sample files to either the screen, a printer, or to 
a file. Isotherm data can be exported as a .REP, .TXT, or .XLS file format. You can select the type of 
data to include or exclude during the export process. When exported to a file, the data can be imported 
into other applications that read .TXT or .XLS file formats. 

1. Select a file from the library. To select more than one file, hold down the Ctrl key on the 
keyboard while selecting the files, or hold down the Shift key to select a range of files.

2. Click Export.

3. In the Export Options window, select the type of data to include in the export file. 
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Types of data that can be included:

• Options
–  Target pressures

• Quantity adsorbed versus relative pressure
• Quantity dosed, absolute pressure, elapsed time, free space, Psat measurements
• Sample log
• Labels

4. Specify the export destination in the Destination section of the window:

• Preview - to send the file to the screen.

• Print - to send the file to the default printer.

• Copies - select the number of copies to print. This field is only enabled when Print is selected.

• File - select the destination directory. Enter a new file name in the File name field or accept 
the default. Select to save the file as a report system (.REP), a spreadsheet (.XLS), or an ASCII 
text (.TXT) file format.

5. Click OK. The following example shows a sample information file previewed on the screen.
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Listing Files

File > List

Provides the option to create a list of sample file information, for example, file name, date, time the file 
was created or last edited, file identification, and file status. 

1. Select a file from the library. To select more than one file, hold down the Ctrl key on the 
keyboard while selecting the files, or hold down the Shift key to select a range of files.

2. Click List.

3. In the Report Settings window, select one of the following: 

• Preview - to send the file to the screen.

• Print - to send the file to the default printer.

• Copies - select the number of copies to print. This field is only enabled when Print is selected.

• File - select the destination directory. Enter a new file name in the File name field or accept 
the default. Select to save the file as a report system (.REP), a spreadsheet (.XLS), or an ASCII 
text (.TXT) file format.
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4. Click OK. The following example shows a sample information file printed to the screen.

Generating Graph Overlays

Use the graph overlay function to compare multiple graph options. Graphical lines are differentiated 
by the use of varying colored symbols outlined on a legend. Overlays may be generated in two ways:

• Multiple Sample Overlays - overlay up to 25 plots of the same type with that of the current plot.

• Multiple Graph Overlays - overlay two different types of plots from one sample. This type of 
overlay is available only for: 

–  BJH Adsorption/Desorption 
–  DFT Pore Size/Surface Energy
–  Dollimore-Heal Adsorption/Desorption
–  Horvath-Kawazoe
–  M-P Method

Only the Advanced format can be used to generate overlays. Go to  Options > Options Presentation > 
Advanced to access the Advanced format or select Advanced from the dropdown list at the bottom of 
the window.
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Multiple Sample Overlays

To overlay the same type of graph on multiple samples:

1. Go to File > Open.

2. Select the .SMP file and click Open.

If a file with a status other than Preparing, Prepared, or No Analysis is selected, the Isotherm plot 
displays. Select Advanced from the dropdown list at the bottom of the window.

3. Click the Report Options tab at the top of the window. Refer to the following table for 
instructions for the selected report.   

When working with an existing file, a copy of the file should be used rather than the 
original. 

Highlight the report to 
overlay, then click Edit.
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4. On the Report Options tab, click the Overlays button.

If overlaying this type of 
report...

Then... 

• Isotherm

a.) In the Selected Reports list box, highlight Isotherm and 
click Edit. 

b.) On the Isotherm Report Options window, select a plot in 
the Selected Reports group box then click the Options 
button to the right of the selected plot. 

c.) On the Plot Options window, select Plot curve and/or Plot 
points if they are to be included in the overlay. If the x- 
and/or y-axes are to be autoscaled, select the Autoscale 
checkbox, otherwise, enter the From and To points for the 
axes. Click OK to save and close the window.

d.) On the Report Options window, in the Plot Options group 
box, select Plot overlays. Click OK.

e.) Continue with Step 4.

• BET Surface Area
• Langmuir Surface Area
• Freundlich
• Temkin
• t-Plot
• Alpha-S
• f-Ratio

a.) In the Selected Reports list box, highlight one of the report 
options shown on the left and click Edit. 

b.) On the Report Options window, select the Overlay 
samples checkbox for the Transform plot and/or the 
Isotherm plot. Verify other fields. Click OK to return to the 
Report Options tab.

c.) Continue with Step 4.

• BJH Adsorption
• BJH Desorption
• Dollimore-Heal Adsorption
• Dollimore-Heal Desorption
• MP-Method

a.) In the Selected Reports list box, highlight a report option 
shown on the left and click Edit. 

b.) Select the report variable from the Selected Reports group 
box and click Edit.

c.) Click the dropdown arrow on the Overlay field and select 
the Samples option. Verify other fields. Click OK to return 
to the Report Options window.

d.) Click OK again to return to the Report Options tab.

e.) Continue with Step 4.
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5. On the Plot Overlay Sample Selection window, use one of the following options to move up to 
25 files from the Available Files box to the Selected Files box.

• To move a file from the Available Files box to the Selected Files box, either:

–  Double click a file name in the Available Files box, or

–  Select a file name in the Available Files box and click Add. 

• To move a file from the Selected Files box to the Available Files box, either:

–  Double click a file name in the Selected Files box, or

–  Select a file name in the Selected Files box and click Remove. 

6. Click OK.

To select more than one file, hold down the Ctrl key on the keyboard while selecting the files, 
or hold down the Shift key to select a range of files.
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7. To view the report, click the Preview button on the sample file window. 

If the sample file has been closed, go to  Reports > Start Report. Select the file used in the 
previous steps and click Report. To select more than one file, hold down the Ctrl key on the 
keyboard while selecting the files, or hold down the Shift key to select a range of files. Choose 
the report destination on the Report Settings window and click OK. If only one file was selected 
as an overlay, the Select Reports window displays. Verify the reports to generate and add or 
remove reports as necessary. Click OK. If multiple files were selected, the Selected Reports 
window will not display. 
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8. The report screen displays with tabs across the top of the screen. Click each tab to view the 
reports. Refer to Report Tool Bar, page 5-17.
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Multiple Graph Overlays

The overlay process allows the importing of pore-size distribution data from an ASCII text file. The 
ASCII text file must follow the format rules outlined below.

Multiple graph overlays can only be generated for: 

• BJH Adsorption/Desorption 

• Dollimore-Heal Adsorption/Desorption

• Horvath-Kawazoe

• DFT Pore Size/Surface Energy

• M-P Method


ASCII text file format rules

• The header must consist of one line to include title, two unit specifications, and distribution type:

- Accepted pore dimension units are: A, nm, um
- Accepted pore volume units are: cm3/g cm3/g, ml/g
--Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g incremental) 
My Title (A, cm3/g, cumulative) 

• The data must be in two columns and should be separated by a comma or white-space. 

• The data lines must be ordered so that pore dimensions are monotonically increasing or decreasing.

Sample ASCII text file

silica alumina bjh ads (A, cm3/g, cumulative) 

456.657 0.0133559 
444.847 0.0546427 
429.168 0.0869924 
425.419 0.119721 
419.629 0.132681 
360.634 0.156611 
340.859 0.197672 
326.601 0.233092 
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To import the ASCII text file to generate graph overlays:

The following steps use BJH Adsorption as an example. Screen appearance will vary depending on the 
selected report.

1. Go to File > Open. Select a sample file to overlay graphs of other samples. To select more than 
one file, hold down the Ctrl key on the keyboard while selecting the files, or hold down the Shift 
key to select a range of files. Click Open.

If a file with a status other than Preparing, Prepared, or No Analysis is selected, the isotherm plot 
displays. Select Advanced from the dropdown list at the bottom of the window to return to the 
Sample Description tab.

2. Click the Report Options tab, click the Import button. 

If the ASCII text file does not display on the Select Imported Overlays window, click Import. 
Locate the file, then click Open. Header information from the ASCII text file will then appear in 
the Select Imported Overlays window. If an error message appears instead, verify that the .TXT 
file format (listed above) is correct. Select the entry and click OK..

Click Import to 
import a .TXT file 
for the overlay

Click Import to browse 
for the .TXT file.
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3. In the Selected Reports list box, highlight the type of report to overlay with a graph and click 
Edit.

4. From the Report Options window, in the Selected Reports list box, select a sub-report and click 
Edit.

Highlight the 
report then click 
Edit.

Select a sub-
report

Click Edit
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5. Click the dropdown arrow at the Variable field and select a variable to overlay. Then click the 
dropdown arrow of the Overlay field and select the Imported Data entry. Click OK to return to 
the Report Options window.

6. Click OK again to return to the Report Options tab.

7. Click Save to save the selections. 

8. To view the report, click the Preview button on the Sample Description window. 

If the sample file has been closed, go to  Reports > Start Report. Select the file used in the 
previous steps and click Report. To select more than one file, hold down the Ctrl key on the 
keyboard while selecting the files, or hold down the Shift key to select a range of files. Choose 
the report destination on the Report Settings window and click OK. If only one file was selected 
as an overlay, the Select Reports window displays. Verify the reports to generate and add or 
remove reports as necessary. Click OK. If multiple files were selected, the Selected Reports 
window will not display. 

Displays the first 
report variable

Select the second 
variable
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9. The report window displays with tabs across the top. Click each tab to view the reports. Refer to 
Report Tool Bar, page 5-17.
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3.  FILE MENU

Introduction

This chapter contains information specific to the File menu options used in sample and parameter files. 
This chapter provides details of File menu options, commonly used functions and buttons, and field 
descriptions.

Common Fields and Buttons - File Menu Options

The following fields and buttons are common to many of the File Menu windows. Field and button 
descriptions not listed below are found in their respective sections.

Common field and button descriptions are listed in a Common table at the beginning 
of their respective chapters. Field and button descriptions not listed in the Common 
table are listed in their appropriate heading.

Refer to the Appendix section of this manual for further details on report calculations 
(CALCULATIONS, page C-1), free space correction (FREE SPACE CORRECTION, 
page D-1), and DFT models (DFT MODELS, page F-1).

Field or Button Description 

Autoscale checkbox When enabled on report parameters screens, allows the x- and y-axes to be 
scaled automatically. Autoscale means that the x- and y- ranges will be set 
so that all the data is shown. If Autoscale is not selected, the entered range 
is used.

Axis Range On report parameters screens, the From / To fields are enabled when 
Autoscale options are not selected. Enter the starting and ending values for 
the x- and/or y-axes.

Menu bar
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Browse button or icon Click to search for a file. Select a file from either the Name column or from 
the library and click Open or double click the file name to open (or import) 
the file.

Cancel button Cancels any changes made to the screen.

Close Closes the active window. If changes were made to the file and not yet 
saved, a prompt displays providing the option to save the file.

Close All Closes all active windows. If changes were made and not yet saved, a 
prompt displays for each changed file providing the option to save the 
file.

Delete button When working with report parameters screens, click Delete to remove the 
selected report. Deleted reports will have to be regenerated if deleted in 
error.

Destination 
group box

• Preview - sends the file to the screen. Click Print on the report screen to 
send the file to the printer.

• Print - sends the file to the default printer.

• Copies - select the number of copies to print. This field is only enabled 
when Print is selected.

• File - saves the report as a file. Click the Browse icon to the right of the 
text field to select the directory where the new file will be stored. Enter 
the new file name in the File name text box.

• File Type - use to save the new file with a .TXT, .XLS or .REP file 
extension. This field is only enabled when File is selected.

.REP (Report system) - saves the report in a format that can be opened 
within any MicroActive program.

.TXT (ASCII text) - saves the report as a text file.

.XLS (Spreadsheet file) - saves the report in a format that can be opened 
within a spreadsheet program.

Field or Button Description (continued)
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Edit button When working with report parameters screens, highlight the item in the 
Selected Reports list box and click Edit to modify report details.

Exit Exits the program. 

If a file is open with unsaved changes, a prompt displays providing the 
option to save the changes and exit or to exit the program without saving 
the changes.

• Yes - saves the changes, then closes the window

• No - closes the window without saving the changes

• Cancel - cancels the Close command

Export Exports isotherm data in a sample information file as a .REP, .TXT or .XLS 
file. When saved to a file, the data can be imported into other applications.

File name text box Select a file from either the Name column or from the library. The file name 
displays in the File name text box. Click Open or double-click the file 
name to open the file. Multiple files can be selected by holding down the 
Ctrl key on the keyboard while selecting multiple files.

Field or Button Description (continued)
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From / To text boxes When working with report parameters screens, enter the From and To range 
for x- and/or y-axes.

List Provides the option to create a list of sample or report options file 
information, for example, file name, date / time the file was created or last 
edited, file identification and file status.

Name column A list of files in the selected directory or library.

OK button Click to save and close the active window.

Open button Click to open the selected file (or double-click the file name in the Name 
column to open the file).

Preview button Click to preview predefined reports. Click the tabs across the top of the 
window to preview each selected report. When an analysis has not been run 
on a sample, this button is disabled. Refer to Report Tool Bar, page 5-17. 

Print button Sends the report to the selected destination (screen, printer or file).

Remove Removes an item from a list.

Replace button Click to select another file where the values will replace the current file’s 
values.

Save Saves the active window under the current file name.

Save All Saves all active windows under the current file names.

Save As • Saves a file in the active window under a different file name.

• Saves a subset (parameter) of the sample file in the active window as a 
standalone parameter file. For example, to create a standalone parameter 
file of the analysis conditions portion of the active sample file, go to File 
> Save As, select the Analysis Conditions folder in the library and enter 
a file name in the File name field. Click Save.

Table buttons • Insert - inserts one row above the selected row.
• Delete - deletes the selected row.
• Clear - clears all table entries and displays only one default value.
• Append - inserts one row at the end of the table.

Field or Button Description (continued)
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New Method

A Method determines the default sample identification format and sequence number. A Method is a 
template of specifications that go into a newly created sample file. It allows for the definition of com-
plete sets of parameters for each type of sample commonly analyzed, so that only a single selection is 
required for each new sample file created. 

Methods are created using a wizard that guides you through the process. The Material Type and Char-
acterization list and the Isotherm Collection list are system defaults and cannot be modified. 

Go to File > New Method to start the New Method wizard.

View Instrument Log For use by a Service Technician. Operators should use Unit [n] > Show 
Instrument Log. Refer to Show Instrument Log, page 4-20.

Field or Button Description (continued)
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New Sample

Provides the option to create a new sample file or parameter file. Refer to Sample Information Files, 
page 3-10.
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Open

Provides access to the library. Refer to Manage Libraries, page 6-2 for information on managing 
libraries.

• Sample Information files - the File name text box contains the next sequential sample information 
file name generated by the program. The sample information file extension is .SMP.

• Parameter files - the File name text box contains an asterisk (*) and a default file extension 
depending on the type of parameter file selected. Default file extensions are:

*.ADP Adsorptive Properties
*.ANC Analysis Conditions
*.DEG Degas Conditions
*.FPI Fluid Properties
*.RPO Report Options 
*.STB Sample Tube Properties
*.MTH Method

Library
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Create a New Method

File > New Method

1. On the Create a Method window, select the Sample Morphology to be used and the Material 
Type and Characterization. Click Next.

2. Enter a Degas temperature then select an Analysis gas from the dropdown list.

3. The Isotherm Collection options determine the pressures of the data points measured in the 
analysis. Click Finish to close the wizard and open an editor for the new Method.
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4. On the Method tab, if files created using this Method are to be saved in a file directory other than 
the default, select the Use separate sample file directory checkbox and click the Browse icon to 
select a directory. The Browse icon is enabled only when the Use separate sample file directory 
checkbox is selected. Select the new directory then click OK on the Browse for Folder window.

5. If the file sequence numbers for this Method will differ from other Methods, select the Use 
separate sequence number checkbox and enter the new sequence number in the text box.

6. In the Sample file name text box, enter a default form for file names. The $ symbol is required 
and represents the position of the sequence number in the file name.

7. Refer to Sample Information Files, page 3-10 for details on completing the remainder of this 
window. The Type of Data group box is disabled when creating a Method.

8. Click Save. The Save as Sample Information File window displays. Select Methods in the 
library and enter a file name for the Method in the File name text box.

9. Click Save.
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Sample Information Files

File > New Sample 

Each analysis must be linked with a sample information file before the analysis can proceed. A sample 
information file can consist of parameter files, however, parameter files can also stand alone.

Parameter files allow repeated use of the file, for example, if the same analysis conditions exist for 
multiple analyses, create an Analysis Conditions file containing the recurring conditions. When the 
sample file is created, select the Analysis Conditions file for the analysis conditions. Once it becomes 
part of the new sample file, edit the new file as needed without affecting the original Analysis Condi-
tions file. Sample Information files can be created or opened in Advanced, Basic, or Restricted 
format.    

Specify or change the default format by selecting Options > Option Presentation or 
select Basic / Advanced from the dropdown list at the bottom of the window. Refer to 
Editing the Default Method, page 2-3 for a description of the Advanced, Basic, and 
Restricted formats.
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Field or Button Description 

Method dropdown 
list

Select a method to use for the sample information file. To select an ASTM 
method, click Browse and navigate to C:\3Flex\Data\Examples. Select an 
ASTM method from the list.

Sample text box Enter a description of the sample.

Operator / Submitter 
text boxes

Enter identification information in the respective text boxes. Some text 
boxes may have been renamed or may not display if modified in Options > 
Default Methods.

Bar Code text box Enter bar code reader information if a bar code reader is connected to the 
computer’s USB port. If a bar code reader is not used, this alphanumeric 
field can be used to enter additional information about the sample, such as a 
sample lot number, sample ID, etc. 

Sample Tube 
dropdown list

• Edit button - click to edit the sample tube parameters. To save the 
sample tube parameters as a file, go to File > Save As. Select .STB as the 
File Type and enter a File name.

• Sample tube - enter a description of the sample tube, such as the tube 
size.
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Sample Tube 
dropdown list 
(continued)

• Empty Tube Properties group box - use for calculated free space, enter 
the values for the following or use the Load from Sample File button to 
import this information from a sample information file:

–  Warm free space - empty sample tube gas capacity measured at 
room temperature. 

–  Cold free space - empty sample tube gas capacity measured with 
the Dewar raised.

• Use isothermal jacket checkbox - select if an isothermal jacket is to be 
used. An isothermal jacket maintains a constant temperature profile 
along the sample tube stem during an extended analysis of more than 1 
or 2 hours.

• Use filler rod checkbox - select if a filler rod is to be used in the sample 
tube. A filler rod reduces the stem free space volume resulting in 
reduction of free space error.

• Vacuum seal type option - select the seal type to be used.

Mass group box If mass = 1, the reported surface area equals the total surface area but it is 
always shown as m2/g. If the actual mass is entered, the surface area is 
reported as m2/g. Choose whether to enter mass manually or have the 
system automatically calculate mass. Enter a value for sample mass and/or 
density. Both of these values may be edited at the time of analysis. 

• Enter - enables the Sample Mass field. Enter a value for the sample 
mass.

• Calculate - enables the Empty tube and Sample + tube fields. Enter the 
values necessary to calculate the sample mass. Equation used to calculate 
sample mass:

Masssample = Masssample+tube – Masstube

• Density - value is used for the Calculated free space method only. Use 
0.000 for a blank analysis.

Field or Button Description (continued)
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Type of Data group 
box

• Automatically collected - select if the type of data will be automatically 
collected by the system while an analysis is running.

• Manually entered - use to manually enter data collected from another 
source. If Manually entered is selected, the Isotherm Report becomes 
available in the Basic/Advanced dropdown list to allow you to paste or 
import data into the file. Refer to Manually Entering Isotherm Data in 
a Sample File, page 2-23.

User Parameters 
group box

These fields are primarily used for the SPC (Statistical Process Control) 
reporting to specify sample characteristics or its manufacturing process but 
may be used for other data by entering specific analysis conditions or 
sample criteria. 

The entered parameters display on the Sample Description window, in 
Reports > SPC Report Options, and the Summary Report.

Choose to hide or display these fields or modify the default alphanumeric 
field labels in Options > Default Method.

Comments text box Enter comments about the sample or analysis. Comments display in the 
report header.

Add Log Entry 
button

Use to enter information to appear in the sample log report that cannot be 
recorded automatically through the application. Click the button again to 
enter multiple log entries.

Replace All button Click to select another .SMP file where the values will replace all values for 
the active Sample Information file. The original file will remain unchanged.

Close button

Preview button

Save button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Degas Conditions File

File > Open > [.DEG file] (or click the Degas Conditions tab when in Advanced format)

The Degas Conditions tab provides details for setting up the Degas Conditions parameter file. This 
information will be automatically applied during the degassing procedure if using the SmartPrep 
Degasser.   

Use this option only when the SmartPrep Degasser is installed. To specify in situ 
degas, on the Analysis Conditions tab click the Preparation button.

The Degas Conditions tab displays only if enabled in Options > Option Presentation > 
Show Degas Conditions.

Field or Button Description 

Degas Conditions 
dropdown list

Use to browse for a .DEG file that contains degas condition parameters to 
be used in the analysis.
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Heating Phase table Enter up to five stages of degas conditions.

• Temperature - soaking temperature with flowing gas.

• Temperature Ramp Rate - rate at which the temperature is to change 
when advancing to the soak temperature. 

• Time - amount of time to soak the sample.

Close button

Preview button

Save button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Analysis Conditions Files

File > Open > [.ANC file] (or click the Analysis Conditions tab when in Advanced format)

The Analysis Conditions tab provides details for setting up the sample analysis conditions file.   

Field or Button Description  

Run Conditions 
dropdown list

Use to browse for a .ANC file that contains analysis condition parameters 
to be used in the analysis.
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Adsorptive
dropdown list

Displays a list of defined gases. Select the adsorptive to be used for the 
analysis. Click the Edit button to edit the adsorptive properties.

Field or Button Description  (continued)
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Adsorptive (continued) • Description text box - defaults to the adsorptive listed on the previous 
window.

• Mnemonic - enter the mnemonic name for the adsorptive.

• Maximum manifold pressure - the highest pressure that the manifold 
will be dosed to. To avoid damage to the instrument, this number is 
limited to 925 mmHg. Low pressure sources, such as vapors, will 
require lower numbers.

• Therm. tran. hard-sphere diameter - an estimate of molecular size 
used in calculating the thermal transpiration correction.

• Molecular cross-sectional area - the area that a single adsorbed 
molecule occupies on the surface of the sample. It is used in surface 
area calculations.

• Adsorbate molecular weight - the molecular weight is used for the 
weight % column of the isotherm tabular report and for the pressure 
composition isotherm plot.

• Adsorbed-phase free-space correction checkbox - use to adjust the 
reported quantity adsorbed to correct for this effect. This option is 
appropriate for all sample analyses that use the real gas equation of 
state. It should be deselected for blank tube analyses.

• Fluid properties - use to import parameters from a Fluid Properties 
file. Click Open to browse and select an .FPI file. Locate and select the 
file then click Open on the file selector screen. Click Save to save the 
changes made from the importing selected the .FPI file. Changing fluid 
properties should only be necessary if an adsorptive is to be used for 
which no adsorptive properties are provided.

• Dosing Method group box - select the dosing method to be used.

–  Normal - select for standard and high throughput analyses. Dose 
from a pressurized tank of gas attached to a gas inlet port.

–  From Psat tube - select if the Psat tube is filled with condensed 
adsorptive and dosed from the Psat tube. Select this option if using 
Krypton.

–  From Port 3 - select if the tube attached to sample port 3 is filled 
with condensed adsorptive and dosed from Port 3. 

Field or Button Description  (continued)
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Adsorptive (continued) –  Vapor Source - select if a container of condensed vapor is attached 
to the Psat port in place of the Psat tube, and is dosed from the Psat 
port. 

–  Charge from inlet - use to have the tube automatically charged with 
condensate from a gas inlet port after the Dewar is raised. To import 
parameters from a Fluid Properties file, click Open to browse and 
select an .FPI file. Locate and select the file then click Open on the 
file selector screen. Click Save to save the changes made from the 
importing the .FPI file.

–   Purify adsorptive - use to have the condensate in the tube purified 
after charging by evacuating the gas over the condensate. If Charge 
from inlet is selected, select Purify adsorptive to have 
noncondensing contaminants automatically removed from the dosing 
tube prior to analysis. After the adsorptive has condensed in the 
selected Psat tube or Port 3, the remaining gas in the tube will be 
evacuated to remove noncondensing contaminants. A small amount 
of the purified adsorptive condensate will then return to gas phase to 
restore equilibrium pressure in the tube.

• Vapor Source Temperature checkbox - select if the vapor source 
temperature is to be controlled by the instrument. If the vapor source 
temperature is to be controlled by the operator, do not select this 
checkbox. This field is enabled only if Vapor source is selected.

Insert Range button To change the screen options to Absolute pressure, select the Absolute 
pressure dosing checkbox.

Click to display the Insert Pressure Range window for entering 
parameters for the system to autofill the Up to column with starting 
pressure, ending pressure, the number of points to insert within the 
specified range and whether to have linear or geometric progression.

Field or Button Description  (continued)
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Insert Range button 
(continued)

•  Starting relative pressure field - enter the relative pressure at which 
data points will start to be taken.

• Ending relative pressure field - enter the relative pressure at which 
data points will no longer be taken.

• Number of points field - enter the number of points to be taken 
between the specified starting and ending relative pressures.

Progression group 
box

• Linear - use to insert evenly spaced points into the table. 

• Geometric from low pressure - use to insert geometrically spaced 
points from the low pressure range. For example, to insert 5 points with 
a 0.01 starting pressure and a 0.16 ending pressure, the following points 
are inserted into the table:

0.01
0.02
0.04
0.08
0.16

• Geometric towards saturation - use to insert geometrically spaced 
points from the saturation pressure. For example, to insert 5 points with 
a 0.99 starting pressure and a 0.84 ending pressure, the following points 
are inserted into the table:

0.99
0.98
0.96
0.92
0.84

Absolute pressure 
dosing checkbox

Use to specify pressure targets in mmHg, mbar, or kPa instead of relative 
pressure. This option is typically selected when using adsorptives at 
analysis conditions above the critical point of the gas; for example, H2 
adsorption on carbon at liquid nitrogen temperature.

If this option is selected, the Relative Pressure labels and entries change 
to Absolute Pressure in the selected pressure units.

Field or Button Description  (continued)
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Preparation button Use to enter analysis preparation details.

• Match transducer checkbox - use to backfill the sample tube to 
760 mmHg at the beginning of the analysis and to recalibrate the 
sample port pressure transducer scale to match the manifold pressure 
transducer. 

• Backfill gas dropdown list - select the backfill gas to be used.

• Evacuation rate - enter the rate for restricted evacuation.

• Unrestricted evac. from - enter the pressure at which unrestricted 
evacuation is to begin.

• Vacuum level - enter the pressure for unrestricted evacuation.

• Evacuation time - enter the length of time for preliminary evacuation 
which takes place prior to the free space measurement or sample 
analysis if free space is to be entered or calculated. The timer starts 
when the entered vacuum level is reached.

Field or Button Description  (continued)
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Preparation button
(continued)

• Degas in situ - use to degas the sample on the analysis port prior to 
analysis.

–  Evacuation Temperature - temperature of the gas during 
evacuation.

–  Ramp Rate - rate at which the temperature is to change when 
advancing to the hold pressure.

–  Hold pressure - pressure at which heating will stop and hold the 
sample temperature approximately constant until the pressure 
falls below the Hold pressure. This feature prevents damage to 
the sample structure due to 'steaming', as well as sample 
elutriation due to excessive escaping gas velocity.

• Leak test - select if a leak test is to be performed.

• Leak test duration - enter the duration of the leak test.

• Elevator - select the appropriate elevator control option.

–  Automatic - the elevator is raised and lowered automatically.

–  Wait for operator - the operator will be prompted to set the 
elevator or analysis bath to the desired height. When the prompt 
is acknowledged, the analysis will continue. This option should 
be used if the analysis bath must be placed manually in the 
desired position, or the elevator must be raised to a height other 
than the standard analysis height.

–  Do not move - use to have the analysis proceed without pausing 
or moving the elevator. This option should be used when the 
analysis bath is already in position and should not be moved 
during analysis.

Field or Button Description  (continued)
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Free Space button Use to enter the type of free space measurement and if it is to be measured, 
entered or calculated.

• Measure before analysis - select if the free space is to be measured 
before the analysis begins.

–  Lower dewar for evacuation - select if the Dewar is to be 
lowered for evacuation.

Evacuation time - if the Dewar is to be lowered for evacuation, 
enter the length of time for evacuation after the free-space 
measurement.

–  Outgas test - select if an outgas test is to be performed before 
analysis.

–  Outgas test duration - if an outgas test is to be performed, enter 
the duration of the outgas test.

• Measure after analysis - select if free space is to be measured after 
analysis ends. Enter the evacuation time and the estimated warm and 
estimated cold free space or accept the defaults.

• Enter - use to enter warm and cold free space manually and enter the 
amount in the text box.

• Calculate - use to have the free space measurement calculated using 
the sample and tube parameters.

Field or Button Description  (continued)
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po and T button Use to select options for obtaining the saturation pressure (po) and analysis 
bath temperature.

• p° Options - select one option indicating how po is to be measured or 
calculated.

Psat Gas dropdown list - if choosing to measure the Psat for each 
isotherm port, select the Psat gas from the dropdown list and click the 
Edit button to edit the Psat adsorptive properties. Refer to Adsorptive 
dropdown list earlier in this table for details on editing this window.

• Analysis Temperature Options - select an option to manually enter 
analysis temperature or choose to have it automatically calculated from 

po or Psat.

Field or Button Description  (continued)
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Dosing button

• Absolute / Relative pressure tolerance - values used to determine 
how close the actual pressure must be to each target pressure from the 
pressure table. At lower pressures, the relative tolerance value is less. 
At higher pressures, the absolute tolerance value is less. For example:

Experiment 1: You have an absolute tolerance of 5 mmHg, a relative 
tolerance of 5%, and a target pressure of 40 mmHg; 5% of 40 mmHg is 
2 mmHg. Since 2 mmHg (relative tolerance) is less than 5 mmHg 
(absolute tolerance), 2 mmHg is used. Therefore a minimum pressure 
of 38 mmHg (40 - 2) must be attained to collect data for a target 
pressure of 40 mmHg.

Experiment 2: You have an absolute tolerance of 5 mmHg, a relative 
tolerance of 5%, and a target pressure of 200 mmHg; 5% of 200 mmHg 
is 10 mmHg. Since 5 mmHg (absolute tolerance) is less than 
10 mmHg (relative tolerance), 5 mmHg is used. Therefore a minimum 
pressure of 195 mmHg (200 - 5) must be attained to collect data for a 
target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced and the 
resulting measurement is not very sensitive to the precise location of 
points so wider tolerances may be used. Unnecessarily tight tolerances 
lengthen the analysis.

• Minimum equilibration delay at p/po > = 0.995 - the minimum 
number of seconds required before equilibration can occur for a 
relative pressure greater than or equal to 0.995. This field is not 
available if Absolute pressure dosing is selected on the Analysis 
Conditions tab.

• Low pressure equilibration delay - these delays will be used until the 
first pressure in the table is reached.

Field or Button Description  (continued)
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Termination button Select if backfill is to be done after the analysis. Click the dropdown list to 
select the backfill gas to be used.

Cancel button

Close button

OK button

Preview button

Save button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description  (continued)
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Report Options Files

File > Open > [.RPO file] (or click the Report Options tab when in Advanced format)

Use to specify report options for collected (from an analysis) or manually entered data. Report Options 
files also help in customizing report details such as axis scale, axis range, column headings, and com-
ponents of thickness curve equations. Refer to REPORTS MENU, page 5-1.

Customized report options files can be created then loaded into a sample file allowing quick and easy 
generation of reports.   

Field or Button Description 

Report Options 
dropdown list

Use to browse for a .RPO file that contains report options parameters to be 
used in the report.

Show report title 
text box

Enter a report title to appear on the report header.

Show graphic 
text box

Use to show a graphic on the report header. Click the Browse button to 
locate the graphic.

• Height / Width - enter the height and width of the selected graphic. 
These values determine the graphic appearance on the generated report.
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Overlays button Refer to Multiple Sample Overlays, page 2-61.

Import button Use to import up to 25 pore distribution data files. These datasets are 
shown only in BJH and Dollimore-Heal reports.

Apply thermal 
transpiration 
correction checkbox

Use to correct the temperature-induced pressure difference between the 
manifold and the chilled sample tube. This option is most significant for 
pressures less than 1.0 mmHg. It is OK to use a sample tube filler rod and 
thermal transpiration if the filler rod has a bore.

Always use thermal transpiration when performing micropore analyses. 
Refer to CALCULATIONS, page C-1 for additional information on 
thermal transpiration.

• Inside diameter of sample tube text box - Enabled when Apply 
thermal transpiration correction is selected. Enter the inside 
diameter of the sample tube used in the analysis.

Selected Reports list 
box

Select the checkbox to the left of the report names to include in the report.

For BJH reports, BJH pore dimension can be calculated in pore width (w), 
pore radius (R) or pore diameter (D). Go to Options > Units to specify 
default calculations.

Browse button

Cancel button

Close button

Edit button

OK button

Preview button

Save button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Summary Report

The Summary Report provides a condensed listing of selected data results. In the Selected Reports 
list box, highlight Summary, then click Edit. Select the data types to include in the Summary report.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is 
enabled. Enter the relative pressure used to calculate the total pore volume.

If Use calculation assignments is not selected on the Collected Data window, the isotherm is interpo-
lated to the value in the p/po fields and the point is used for the total pore volume calculation. 
Otherwise, the point selected with calculation assignment is used. Pass/Fail criteria can be specified 
for up to four parameters.

Field or Button Description 

Select All / Deselect 
All buttons

Selects (or deselects) all options.
Dec 2012 3-29 



Report Options Files 3Flex
Item [n] Use to enable the first Pass/Fail item. Until the Summary Report is 
selected, S A Single-point BET will be displayed by default. When the 
checkbox is selected, click the Pass/Fail button and select criteria options 
for pass/fail options.

• S A: Single-point BET checkbox - use to enable the Pass/Fail [n] 
button in the Item [n] group box.

• Pass/Fail [n] button - select the S A: Single-point BET checkbox to 
enable this button. Click the Pass/Fail [n] button to display the Pass/
Fail Options window for selection of pass/fail criteria. 

• Upper/Lower options and text boxes - specify upper and lower limits 
for the selected parameter. A range can be left open by not selecting the 
limit. In the text box to the right of Upper / Lower, enter operator 
instructions to be displayed if a failure is encountered.

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Isotherm Report Options

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from satu-
ration pressure) of a gas by a solid held at constant temperature. In the Selected Reports list box, 
highlight Isotherm, then click Edit. 

Field or Button Description 

Select Reports 
group box

Select the checkbox to the left of each option to include on the final report.

Options buttons Click to display related linear plot options. All plot windows contain 
identical fields.

• Plot curve / Plot points - use to plot curves and/or points.

• Autoscale x-axis - linear x-axes begin at zero. Logarithmic x-axes 
begin at an appropriate value. The x-axis field shows the relative or 
absolute pressure.

• Autoscale y-axis - the y-axis field shows the quantity of gas adsorbed.
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Tabular Options 
group box

Select the options to include on the report.

• Weight %
• Elapsed time
• Time between points 

Plot Options 
group box

Select the types of isotherm to plot:

• adsorption
• desorption
• overlays

Quantity Adsorbed 
group box

Select how to report the quantity adsorbed. 

• Per gram (cm3/g) STP
• Per BET Surface Area (cm3/m2) STP or mmol/g
• Per other Surface Area (cm3/m2) STP or mmol/m2

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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BET/Langmuir Surface Area Report Options

The Langmuir and BET Surface Area windows are identical unless otherwise specified. In the 
Selected Reports list box, highlight BET (or Langmuir) Surface Area, then click Edit.

• The BET calculation obtains the sample surface area value by determining the monolayer volume of 
adsorbed gas from the isotherm data. BET uses a multilayer model.

• The Langmuir calculation determines the surface area of a sample by relating the surface area to the 
volume of gas adsorbed as a monolayer Langmuir uses a single layer model.

Field or Button Description 

Select Pressure Range 
for BET (or 
Langmuir) fit text 
boxes

Enter values to indicate the fitted pressure range.

Tabular report 
checkbox

Use to have a table of measured and calculated values generated.

Displays as Langmuir Surface 
Area Report Options if the 
Langmuir report is being 
edited.
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BET (or Langmuir)
Transform plot

Use to generate a traditional BET (Langmuir) surface area plot used to 
determine monolayer volume and BET C constant.

• Overlay samples checkbox - use to overlay sample files on the BET 
(or Langmuir) transform plot.

• Autoscale x-axis - linear x-axes begin at zero. The x-axis field shows 
the relative pressure for BET and show absolute pressure for Langmuir.

• Autoscale y-axis - the y-axis field shows BET (Langmuir) 
transformation.

BET (or Langmuir)
Isotherm plot

Uses the BET (Langmuir) monolayer volume and constant to produce an 
isotherm.

• Overlay samples checkbox - use to overlay sample files on the BET 
(or Langmuir) isotherm plot.

• Autoscale x-axis - linear x-axes begin at zero. The x-axis field shows 
the relative pressure for BET and show absolute pressure for Langmuir.

• Autoscale y-axis - the y-axis field shows the quantity of gas adsorbed.

Field or Button Description (continued)
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Pressures button This option is not available if the active file has a status of No Analysis.

Use to enter a range of pressure points or to modify table values for 
pressure points.

To exclude a point from the calculations used to generate the report, select 
the Exclude checkbox.

• Calculation pressure range group box - enter the minimum and 
maximum pressures to be used in the pressure table if not using the Use 
Interpolation option.

• Use Interpolation checkbox - use to indicate if the system should use 
the table or entered data.

• Insert Predefined button - click to insert a predefined (default) set of 
points into the report. Use Interpolation checkbox must be selected to 
enable this button. This button does not display for the Langmuir 
report.

Refer to Table buttons, page 3-4 for a description of the Insert, Delete, 
Clear and Append buttons.

Field or Button Description (continued)
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Freundlich Report Options

The Freundlich Isotherm is an empirical isotherm used to model low-pressure adsorption data. It can 
also be applied to model some micropore isotherms. In the Selected Reports list box, highlight 
Freundlich, then click Edit.     

Cancel button

Close button

From / To text boxes

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description 

Specify monolayer 
capacity checkbox and 
text box

Select and enter the monolayer capacity of the sample.

Tabular report 
checkbox

Use to have a report of the pressure points generated.

Field or Button Description (continued)
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Transform plot 
checkbox

Plots the log(P) vs log(Q) and the best fit.

• Overlay samples checkbox - use to overlay sample files on the 
Freundlich transform plot.

• Autoscale x-axis - the x-axis field shows the absolute pressure.

• Autoscale y-axis - the y-axis field shows the quantity of gas adsorbed.

Freundlich Isotherm 
plot checkbox

Plots the absolute pressure vs quantity adsorbed. Shows best fit line.

• Overlay samples checkbox - use to overlay sample files on the 
Freundlich isotherm plot.

• Autoscale x-axis - linear x-axes begin at zero. The x-axis field shows 
the absolute pressure.

• Autoscale y-axis - y-axes begin at zero. The y-axis field shows the 
quantity of gas adsorbed.

Field or Button Description (continued)
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Pressures button This option is not available if the active file has a status of No Analysis.

Use to select a pressure range for report calculations and points for 
exclusion from calculations.

To exclude a point from the calculations used to generate the report, select 
the Exclude checkbox. To include or exclude all points, click the Include 
All or Exclude All button.

• Calculation pressure range group box - enter the minimum and 
maximum pressures to be used in the pressure table.

Refer to Table buttons, page 3-4 for a description of the Insert, Delete, 
Clear and Append buttons.

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Temkin Isotherm Report Options

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly with 
increasing coverage. In the Selected Reports list box, highlight Temkin, then click Edit.     

Field or Button Description 

Specify monolayer 
capacity checkbox and 
text box

Select and enter the monolayer capacity of the sample.

Specify differential 
heat of adsorption 
checkbox and text box

Select and enter the differential heat of adsorption at zero surface 
coverage. This allows inclusion of all Temkin constants.

Tabular report 
checkbox

Use to have a report of the pressure points generated.

Transform plot 
checkbox

Plots a linear form of the Temkin transform plot.

• Overlay samples checkbox - use to overlay sample files on the 
transform plot.

• Autoscale x-axis - the x-axis field shows the logarithm of pressure (ln).

• Autoscale y-axis- the y-axis field shows the quantity of gas adsorbed.
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Temkin Isotherm plot 
checkbox

Overlays the Temkin isotherm with the analysis data.

• Overlay samples checkbox - use to overlay sample files on the 
isotherm plot.

• Autoscale x-axis - linear x-axes begin at zero. The x-axis field shows 
the absolute pressure.

• Autoscale y-axis - y-axes begin at zero. The y-axis field shows the 
quantity of gas adsorbed.

Pressures button Refer to Pressures button, page 3-38.

Cancel button

From / To text boxes

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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t-Plot Report Options

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to micropores. 
Matrix area (the area external to micropores) is directly determined and often proves to be a valuable 
way of characterizing complex mixed materials. In the Selected Reports list box, highlight t-Plot, 
then click Edit.  

Field or Button Description  

Thickness Curve group box Select the thickness curve and click Edit to modify the values in 
the equation for the selected curve. The Frenkel-Halsey-Hill 
thickness curve can be applied using the Halsey option. 

Reference option - select Reference and click Edit to define a t-
curve by entering the relative pressure and thickness values. One 
predefined curve is shipped with the analysis program and is 
found in the Reference directory.
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Thickness Curve group box 
(continued)

To import values from an existing thickness curve (.THK file), 
click Open and select the file containing the values. The table to 
be imported must have a .TXT or .THK file extension and have 
a two-column format with the relative pressures in the first 
column and the thickness values in the second column. Columns 
must be separated by a space or a tab.

Refer to Table buttons, page 3-4 for a description of the Insert, 
Delete, Clear, and Append buttons.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / 
Broekhoff-de Boer / Carbon Black STSA - select the 
thickness curve option and click Edit. Modify the equation for 
the selected curve as needed. 

Surface Area 
group box

Select the surface area value used for thickness calculations. 
BET is the most commonly used option.

Field or Button Description  (continued)
3-42                                                    Dec 2012



3Flex Report Options Files
Surface area correction factor 
text box

Enter the value to correct for surface areas that are not smooth. 
This brings the values for BET surface area and micropore 
surface area into accordance. For most samples, the default 
value of 1.000 is adequate.

Fitted thickness range text boxes Enter the minimum and maximum thicknesses (in angstroms or 
nanometers) to include in the thickness curve. Go to Options > 
Units to specify default units. Refer to UNIT MENU, page 4-1.

Tabular report checkbox Use to have a tabular report of data generated.

t-Plot checkbox Use to have a graphical representation of data generated.

• Overlay samples checkbox - use to overlay sample files on 
the t-plot.

• Autoscale x-axis - the x-axis field shows the statistical 
thickness of the adsorbed film.

• Autoscale y-axis - the y-axis field shows the quantity of gas 
adsorbed.

Pressures button Refer to Pressures button, page 3-38.

Cancel button

From / To text boxes

OK button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description  (continued)
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Alpha-S Method

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using the 
quantity adsorbed at a relative pressure of 0.4. In the Selected Reports list box, highlight Alpha-S 
Method, then click Edit. 

One predefined curve is shipped with the analysis program and is located in the Reference directory. 
Use the table to enter relative pressure and the alpha-s values.

Field or Button Description 

Open button To import values from an existing thickness curve (.ALS file), click Open 
and select the file containing the values. 

The table to be imported must be saved as ASCII text with a .ALS file 
extension. It must have a two-column format with the relative pressures in 
the first column and the alpha-s values in the second column. Columns 
must be separated by a space or a tab.

Insert / Delete / Clear / 
Append buttons

Refer to Table buttons, page 3-4 for a description of the Insert, Delete, 
Clear, and Append buttons.
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Ref. surface area 
text box

Enter the surface area from the reference curve. This value is used to 
calculate the sample surface area.

Select Range for 
Alpha-S Fit text boxes

Enter minimum and maximum relative pressures to determine the fit.

Tabular report 
checkbox

Use to have a tabular report of data generated.

Alpha-S plot 
checkbox

Use to plot data in graph format.

• Overlay samples checkbox - use to overlay sample files on the plot.
• Autoscale x-axis - the x-axis field shows the relative pressure.
• Autoscale y-axis - the y-axis field shows the quantity of gas adsorbed.

Pressures button Refer to Pressures button, page 3-38.

Browse button

Cancel button

From / To buttons

OK button

Save As button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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f-Ratio Method

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm. In the 
Selected Reports list box, highlight f-Ratio Method, then click Edit.    

Field or Button Description 

Reference isotherm Click Browse to select a sample file to use as a reference for the isotherm. 
Select a file containing an isotherm measured from a non-porous sample of 
the same material as the current sample. When the referenced file is 
selected, the file name appears to the left of the Browse button.

Tabular report 
checkbox

Select to have a tabular report of data generated.

f-Plot checkbox Use to generate a normalized isotherm.

• Overlay samples checkbox - use to overlay sample files on the 
f-plot.

• Autoscale x-axis - the x-axis field is dimensionless in units of f-ratio.

• Autoscale y-axis - the y-axis field shows the quantity of gas adsorbed.

Pressures button Refer to Pressures button, page 3-38.

Browse button

Cancel button

From / To text boxes

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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 BJH Adsorption/Desorption Report Options

The BJH calculation determines the mesopore volume/area distribution which accounts for both the 
change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be generated 
from both adsorption and desorption data. 

The fields for both report options are identical unless otherwise specified. 

In the Selected Reports list box, highlight BJH Adsorption (or BJH Desorption), then click Edit. 
      

Field or Button Description 

Thickness Curve 
group box

Refer to Thickness Curve group box, page 3-41.

BJH Correction 
group box

Select the type of correction to apply to calculations. The selected type 
displays in the report header.

• Standard - uses original BJH models
• Kruk-Jaroniec-Sayari - good for reference thickness curves
• Faas - good for statistical thickness curves

Does not display on the 
Desorption window.
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Pores group box Enter the minimum and maximum diameter (radius or width) of pores to 
include in the BJH reports.

• Fraction of pores open at both ends - This field is not available for 
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that 
all pores are closed at one end. Occasionally, a percentage of pores 
may be open at both ends causing disagreement in the adsorption 
and desorption data or in the values for total volume and total BJH 
pore volume. Enter the fraction of pores open at both ends to 
compensate for this error.

Cumulative Reports 
options

• Larger - use to report the total volume found in pores larger than the 
current pore size.

• Smaller - use to report the total volume found in pores smaller than the 
current pore size.

Adsorptive button Displays the BJH Adsorptive Options window. The recommended 
adsorptives and their values are shown. Up to eight adsorptive and 
adsorbate property factor combinations may be specified.

Smooth differentials 
checkbox

Use to smooth all differential calculations thus eliminating variations in the 
differential computation caused by noise in the input data.

Selected Reports 
list box

Select the checkbox to the left of the report names to include in the report. 
Highlight the report name and click the Edit button to modify report 
parameters.

Field or Button Description (continued)
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Tabular Report Options

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report 
Options window and click Edit to specify the method of data reduction.   

Pressures button Refer to Pressures button, page 3-38.

Cancel button

Edit button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description 

Fixed pore size table Use to specify exact pore sizes for volume or area data. 

Click the Table button to modify the fixed pore size table. Refer to Table 
and Columns below for information on the use of these buttons.

Collected points Use to include all relative pressure points collected. Refer to the Columns 
button shown below.

Columns button Select the data types to include in the report. Column [n] indicates the 
column order and data contents for the report.

Field or Button Description (continued)
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Table button The fixed pore size table must contain a minimum of two points. The 
points must be strictly decreasing. Enabled only when Fixed pore size 
table is selected. 

Cancel button

OK button

Table buttons

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Plot Options

The fields for all plot options are identical for specifying plotting methods and customizing plots. 
Highlight any plot option in the Selected Reports list box in the BJH Report Options window and 
click Edit.

Field or Button Description 

Plot curve / Plot 
points checkboxes

Refer to Isotherm Report Options, page 3-31.

X-Axis Use to have the x-axis on a logarithmic or linear scale.

Y-Axis • Variable dropdown list - select a variable.

• Overlay dropdown list - select an option to overlay on the current 
report.

Autoscale checkbox

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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Dollimore-Heal Adsorption/Desorption Report Options

This report option generates Dollimore-Heal reports from both adsorption and desorption data. In the 
Selected Reports list box, highlight Dollimore-Heal Adsorption (or Dollimore-Heal Desorption), 
then click Edit. 

Dollimore-Heal Adsorption/Desorption fields and buttons are identical to the  BJH Adsorption/
Desorption Report Options, page 3-47.

Or Dollimore-Heal 
Desorption Report 
Options
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Horvath-Kawazoe Report Options

The Horvath-Kawazoe method plots individual peaks for different pore sizes even if the difference 
between one pore size and the next is only one angstrom (0.10 nm) or less. In the Selected Reports list 
box, highlight Horvath-Kawazoe, then click Edit.   

Field or Button Description 

Pore Geometry 
group box

Select the option that best represents the physical geometry of the 
micropores in the sample material. When Sphere is selected, options in the 
Interaction Parameter group box are disabled.

Interaction Parameter 
group box

Use to determine which interaction parameter will be used in the report. 
These options are disabled if Sphere is selected in the Pore Geometry 
group box.

• Computed - use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click the Properties button to 
display the Physical Properties window). The interaction parameter is 
recalculated each time a parameter in the Physical Properties window 
is edited.

• Entered - select to calculate using the value entered in the text box.
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Properties button Click to view or edit the constants describing the physical properties of the 
adsorbent and adsorptive.

Adsorbent group box:

Contains the parameters for the sample. If using Computed for the 
interaction parameter, all fields are enabled. If using Entered, only the 
values in the Diameter and Diameter at zero energy text fields may be 
edited.

• Description - select the name of the sample used in the analysis.

• Diameter - enter the diameter of the sample atom.

• Diameter at zero energy - enter the diameter of an atom at zero 

interaction energy: (2/5)1/6 × diameter.

• Polarizability - enter the polarizability of the sample.

• Magnetic susceptibility - enter the magnetic susceptibility of the 
sample.

• Density - enter the density per unit area of the sample.

Field or Button Description (continued)

These options are disabled if Entered is selected in the 
Interaction Parameter group box.
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Properties button 
(continued)

Adsorptive group box: 

Contains the parameters for the adsorptives (provided with the software 
and/or user-defined). If using Computed for the interaction parameter, all 
fields are enabled. If using Entered, only the values in the Diameter and 
Diameter at zero energy text fields may be edited.

• Mnemonic - select the mnemonic of the adsorptive gas in use.

• Diameter - enter the diameter of the gas phase atom.

• Diameter at zero energy - enter the diameter of an atom at zero 

interaction energy: (2/5)1/6 × diameter.

• Polarizability - enter the polarizability of the adsorptive.

• Magnetic susceptibility - enter the magnetic susceptibility of the 
adsorptive.

• Density - enter the density per unit area of the adsorptive.

Apply Cheng-Yang 
correction checkbox

Use to apply the Cheng/Yang correction to the pore size analysis. This 
correction substitutes the Langmuir equation of state for Henry’s Law in 
the Horvath-Kawazoe derivation. 

Smooth differentials 
checkbox

Refer to  BJH Adsorption/Desorption Report Options, page 3-47.

Selected Reports 
list box

Select the types of reports to generate.

Cancel button

Edit button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Tabular Report Options

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report 
Options window and click Edit. Select the data types to include in the report. Column [n] indicates 
the column order and data contents for the report.

Plot Options

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options 
window and click Edit to customize the plotting method.

Field or Button Description 

Plot curve / Plot points 
checkboxes

Use to plot curves and/or points.
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X-Axis / Y-Axis • X-Axis - the x-axis field shows pore radius or diameter in angstroms or 
nanometers.

• Y-Axis - the y-axis field shows the quantity adsorbed.

• Variable dropdown list - select a y-axis variable for the report.

• Overlay dropdown list - select an option to overlay on the current 
report.

Autoscale checkbox

Cancel button

Edit button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1

Field or Button Description (continued)
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DFT Pore Size Report Options

The Dubinin method provides pore volume distributions for microporous materials by making use of 
an expression for the adsorption potential. In the Selected Reports list box, highlight Dubinin, then 
click Edit    

Field or Button Description 

Type dropdown list •  DFT - model based on the density functional theory. 

• Classical - model based on the Kelvin equation and thickness 
for determining the pore size distribution.

Refer to DFT MODELS, page F-1 for further discussion on 
models.

Geometry dropdown list Select the pore shape.

Models list box Lists the models that meet the specified criteria and match the 
adsorbate and temperature of the sample data. If no models 
appear, no models meet the selected criteria. One model must be 
selected.

Link to Micromeritics NLDFT 
Models button

Click to hyperlink to the NLDFT Model Table on the 
Micromeritics web page.
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Regularization 
dropdown list and text box

Select the extent of smoothing to apply to the data.

If 0.20000 (user) is selected, enter a number in the text box 
giving a relative weight for the smoothing during deconvolution. 
Larger values produce more smoothing.

Selected Reports
group box

Select the reports to generate. To edit graph details, highlight the 
graph option and click Edit. The Log Goodness of Fit and 
Goodness of Fit graphs cannot be edited.

• Plot Type group box - select the method for data display.

• Autoscale Options group box - use to autoscale the x-axis 
and/or y-axes.

• Overlay dropdown list - select an overlay for the report.

• Axis Range group box - From / To fields are enabled when 
Autoscale options are not selected. Enter the starting and 
ending values for the x- and/or y-axes.

–  X-axis - shows the pore size.
–  Y-axis - shows the area.

Pressures button Refer to Pressures button, page 3-38.

Cancel button

From / To text boxes

OK button

Refer to Common Fields and Buttons - File Menu Options, 
page 3-1.

Field or Button Description (continued)
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 DFT Surface Energy Report Options

The DFT Surface Energy report contains the results of surface energy distribution analyses. In the 
Selected Reports list box, highlight DFT Surface Energy, then click Edit.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report 
Options, page 3-58.   
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Dubinin Report Options

The Dubinin method provides pore volume distributions for microporous materials by making use of 
an expression for the adsorption potential. In the Selected Reports list box, highlight Dubinin, then 
click Edit.    

Field or Button Description 

Report Type 
group box

Select report types. If Astakhov is selected, either select the Optimize 
exponent checkbox or enter an appropriate exponent value in the text box.

Fitted Relative 
Pressure Range 
text boxes

Enter the minimum and maximum limits for Radushkevich or Astakhov 
relative pressures included in the line fit.

Selected Reports 
list box

Select the reports to generate. Highlight the report and click the Edit 
button to modify report options.

Pressures button

Adsorptive button

Refer to  BJH Adsorption/Desorption Report Options, page 3-47.

Cancel button

Edit button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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Tabular Report Options

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports 
list box and click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n - the value for [n] is the optimized exponent if Optimized exponent is selected on the 
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.

Transformed Isotherm Plot Options

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options 
window and click Edit. 

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of rel-
ative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce 
straight lines when transformed in this way.    

Field or Button Description 

Overlay samples 
checkbox

Use to overlay sample files on the plot.
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Autoscale x-axis / 
Autoscale y-axis 
checkboxes

Select an option to have the axis scaled automatically. Both axes begin at 
0; the system uses the maximum values collected during analysis as the 
ending points for axis ranges.

To enter beginning and ending values manually, deselect these 
checkboxes.

Autoscale x-axis - shows the quantity of gas adsorbed at standard 
temperature and pressure.

Autoscale y-axis - shows the log of relative pressure.

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.

Field or Button Description (continued)
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Pore Volume Options

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list 
box and click Edit. 

This option plots differential pore volume as a function of pore width.

Field or Button Description 

Plot curve / Plot points 
checkboxes

Use to plot curves and/or points.

Overlay samples 
checkbox

Use to overlay sample files on the plot.

Autoscale x-axis / 
Autoscale y-axis 
checkboxes

Select an option to have the x- and/or y-axes scaled automatically. Both 
axes begin at 0; the system uses the highest values collected during 
analysis as the ending points for axis ranges.

To enter beginning and ending values manually, deselect these 
checkboxes.

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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MP-Method Report Options

The MP-Method provides pore volume distributions for microporous materials by correlating quantity 
adsorbed with the thickness of the adsorbed layer as determined from a user-selected thickness curve. 
In the Selected Reports list box, highlight MP-Method, then click the Edit button. 

Pore size can be expressed in angstroms or nanometers. Go to Options > Units to 
specify the unit. Refer to UNIT MENU, page 4-1.

Field or Button Description 

Thickness Curve 
group box

Refer to Thickness Curve group box, page 3-41.

Selected Reports 
list box

Select the reports to generate. Highlight the report and click the Edit 
button to modify report options.

Pressures button Refer to Pressures button, page 3-38.

Cancel button

OK button Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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Tabular Report Options

In the MP-Method Report Options window, highlight MP Tabular Report in the Selected Reports 
list box and click Edit. Column [n] indicates the column order and data contents for the report. 

The MP-Method reports hydraulic radius only. If Pore size in diameter is selected from 
the Unit Selection window, pore size in radius will be reported.
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Plot Options

In the MP-Method Report Options window, highlight a plot option in the Selected Reports list box 
and click Edit to customize the plotting method.

Field or Button Description 

Plot curve / Plot points 
checkboxes

Use to plot a curve and/or points.

X-Axis Use to have the x-axis autoscaled or enter beginning and ending values.

Y-Axis • Variable dropdown list - select a variable.

• Overlay dropdown list - select an option to overlay on the current 
report.

• Autoscale checkbox - use to have the y-axis autoscaled or enter 
beginning and ending values.

Cancel button

OK button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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User-Defined Reports

Up to five user-defined reports may be created, each with up to 10 summary reports, 10 tabular reports, 
and 10 graphical reports. In order to use this feature you must create a file containing a Python script 
that imports a "mic" python module. Appendix G provides an example of python script and provides 
functions for the "mic" python Module.

Once python scripts have been created for user-defined reports, you can select the reports from the 
Reports Options window. 
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Click User-Defined, then click Edit. The User-Defined Report Options window is displayed.

Field or Button Description 

User Report 1 through 
User Report 5

Use the dropdown lists to select currently-defined functions used to define 
the report calculations and output. 

Edit button Use to edit a function.

Overlay samples 
checkbox

Use to overlay samples as defined by the function.

Available Reports 
group box

Lists the available reports and allows you to replace, edit or remove reports.

Add button

Cancel button

Edit button

OK button

Remove button

Replace button

Refer to Common Fields and Buttons - File Menu Options, page 3-1.
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Options Report

The Options report lists the conditions used to perform the analysis. It contains analysis information 
including:

• Degas conditions
• Adsorptive properties
• Analysis conditions
• Free space
• Saturation pressure (Po) and temperature
• Analysis method

Sample Log Report

In the Selected Reports list box, select Sample Log. This report provides the following information:

• Manual control operations performed during analysis
• Information entered using Add Log Entry on the sample file editor
• Warnings and/or errors which occurred during analysis

Validation Report

In the Selected Reports list box, highlight Validation, then click Edit. This report allows data to be 
examined by the analysis program to determine if the results are within typical ranges. If the data for 
any reports selected for validation are determined to be out of range, a warning displays, and sugges-
tions are given for corrective action. This information is detailed in the report and plotted on the graph 
as a unique plot symbol.
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4.  UNIT MENU

Introduction

This chapter contains information specific to the Unit menu options. These options are used to run 
analyses on one or more units attached to a controlling computer. This chapter provides details of Unit 
menu options, and descriptions of commonly used functions and buttons.

The title bar of the main window displays as Unit [n] for each attached unit. Each unit has a status win-
dow displayed in different colors.            

Common field and button descriptions are listed in a Common table at the beginning 
of their respective chapters. Field and button descriptions not listed in the Common 
table are listed in their appropriate heading.
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Common Fields and Buttons - Unit Menu Options

The following fields and buttons are common to many of the Unit menu options. References are made 
to these fields and buttons throughout this manual.

Field or Button Description 

Browse button Click to search for a file. Select a file from either the Name column or 
from the library and click Open or double click the file name to open (or 
import) the file.

Cancel button Discards any changes made to the screen or cancels the current process. On 
the Analysis window, at the prompt, choose the port(s) to cancel.

Close button Click to close the active window. 

Edit button On the analysis window, click to edit the sample information file. Refer to 
Sample Information Files, page 3-10.

OK button Click to save and close the active window.

Start button Click to start an analysis or calibration procedure.
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Sample Analysis

Unit [n] > Sample Analysis

Use to schedule up to three analyses with different analysis conditions and/or report options. Sample 
files can be loaded into ports, 1, 2, and 3 in the order they appear on the screen.     

Field or Button Description 

View dropdown list • Operation - use to display the current mode of operation.

• Instrument Log - use to display recent analyses, calibrations, errors or 
messages. Refer to Show Instrument Log, page 4-20.

• Instrument Schematic - use to display a schematic of the analyzer 
system. Refer to Show Instrument Schematic, page 4-15.

Close Valves button Click to close all valves on the unit.

New button Click to create a new sample information file.
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Browse button Click to select a sample file to be used for analysis on the associated port. 
On Port 1, you can select up to three sample files. The files will be loaded 
into ports 1, 2, and 3 in the order they appear in the file selector. 

Edit button Click to edit the selected sample file.

Clear button Click to clear all fields for this port.

Density / Mass / 
Sample + Tube / 
Empty Tube text boxes

Enter default values for the sample’s mass and density. Refer to Mass 
group box, page 3-12.

po text box Enabled if Entered is selected for the Po measurement for at least one file.

Bath temperature
text box

Enter the temperature for the analysis bath.

Report after analysis 
button

Click to select a print destination.

• Report after analysis checkbox - use to send the report to the screen, 
printer, or file in either ASCII, .XLS, or REP format.

• Export after analysis checkbox - use to export Isotherm data to the 
screen, printer, or file in either ASCII, or .XLS format.

Refer to Destination group box in New Sample, page 3-6.

Field or Button Description (continued)
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Field or Button Description 

Suspend button Click to suspend an analysis in progress. Select the ports containing the 
analysis to suspend.

Resume button Click to resume an analysis. Select the ports containing the analysis to 
resume.

Skip button Click to skip to the next step. This button is visible only when an analysis 
is in progress. Select the ports containing the step to skip.

Report Port [n] 
button

Click to generate reports on data being collected on the respective port. 
The reports are printed to the screen only.

 
Report port buttons Live graph settingsSuspend Resume Skip
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Live Graph Settings 
button

Allows you to select Thermal transpiration, X-axis Quantity (relative or 
absolute pressure) and the X-Axis Scale (linear or logarithmic).

Status window Displays the last point pressure and relative pressure for each port with 
varying numbers of digits after the decimal if 10 mmHg and 0.1 mmHg 
transducers are present on that port, as follows: P < 0.1: 6 digits, 0.1 <= P 
< 10: 4 digits, P >= 10: 2 digits. Relative pressure will show 3 more digits 
than absolute pressure.

Browse button

Cancel button

OK button

Refer to Common Fields and Buttons - Unit Menu Options, page 4-2.

Field or Button Description (continued)
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Reference Analysis

Unit [n] > Reference Analysis

A reference analysis is used to verify that the instrument is operating properly and producing optimum 
results. These methods provide specifications for critical report quantities and reporting of whether the 
quantities are in or out of specification. Predefined SPC reports are provided that include all sample 
files in a specified directory for a given reference and show SPC results for the critical report 
quantities.

When running a reference analysis, use the Silica Alumina reference material provided in the accesso-
ries kit to perform this analysis. The results should match those shown on the label of the reference 
material bottle, within the tolerance level.

Refer to Defining Sample Information Files, page 2-6 for instructions on creating a sample file.

1. Go to Unit [n] > Reference Analysis.

2. Click Browse from the Method dropdown list and select a method.

3. To manually close all instrument valves, click the Close Valves button.

4. Enter Sample Mass for each sample. Verify the information populated into the remaining fields is 
correct and modify if necessary. This information is pulled from the selected file. The density 
value is applicable only if using the Calculate method for the free space determination.

5. Edit the po and Bath temperature fields, if necessary.
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6. Click Report after analysis to automatically generate reports when the analysis is complete. On 
the Report Settings window, select the report destination. Click OK.

7. Click Start to begin the analysis. A window displays data as they are collected. A short delay is 
encountered before the port status at the bottom of the screen changes from the Idle state.

8. When the analyses are complete, click the Report Port 1 icon and compare the BET Surface 
Area shown on the Summary Report with the BET Surface Area shown on the reference material 
bottle. The values should match within the tolerance level shown on the bottle. Repeat for Ports 2 
and 3.

• If the results are within tolerance, the instrument is operating properly. If the BET Surface 
Areas match, click Close.

• If the results are not within tolerance, refer to the following table for possible causes and 
actions. After performing the action, perform the reference analysis again

Cause Action 

The sample was not degassed properly. Degas the sample again.

The gas lines are not clean. Perform the procedure for cleaning and verifying 
gas lines, then try again.

The measured free space is too high. This 
indicates the helium is not pure enough.

Use helium that is 99.999% pure, then try again.
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Enable Manual Control

Unit [n] > Enable Manual Control

Use to enable the manual control of certain system valves and elevator components. When this option 
is enabled, a checkmark appears to the left of the menu item.

If the following instrument schematic is not immediately visible, go to Unit [n] > Show Instrument 
Schematic. 
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Instrument Schematic Components

Component Description 

Valve - open. The icon color changes to green when open.

Valve - closed. The icon color changes to yellow when closed.

Servo Valve - open

Servo Valve - closed

Elevator

Sample tube - cannot be manually controlled.

Manifold 
Vacuum

Vacuum Gauge

 Port 2
Transducer

 Port 3
Transducer

Po
Transducer

Servo Supply

Elevator

Inlet 
Vacuum

Port 1
Transducer

Temperature 
sensors

Manifold 
Transducer

Servo

Vacuum 
Gauge 
Isolation Valve
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Alternate Schematic Icons

Po Port

The following icons will display instead of the po port icon under the conditions described below.

A - Reference volume icon displays when a reference volume is attached to the instrument (Service 
test mode only).

B - Vapor source with heating mantle icon displays when a vapor source is used. The current and target 
vapor source temperatures, as well as the rate of temperature increase is also displayed.

Transducers

The schematic shows the transducers present in the system. 

• All systems have 1000 mmHg transducers on the manifold and the analysis ports.
• Optional 10 mmHg transducers on the manifold and one or more analysis ports may be present. 
• Optional 0.1 mmHg transducers on one or more analysis ports may be present.
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Heating Mantle

When samples are being degassed on the analysis ports, the following icons appear beneath the eleva-
tor. When the target temperature is reached, the sample tube icons turn red.

Right-click on the Degas Mantle box to change the target temperature or the rate of temperature 
increase.

Select Enable Temperature Control and enter the Target Temperature and Ramp Rate. The Set 
Heater Power Percent field is enabled in Service Test Mode only.

System Valves

Go to Unit [n] > Show Instrument Schematic to display the instrument schematic. 

Valves Description 

1 - 3 Sample ports

4 Po port

5 Servo Isolation Valve

6 Manifold Vacuum

7 Vacuum Gauge

8 Inlet Vacuum

10 Reference Volume (shown in Service Test mode only)

11 - 16 Inlet Valves
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Instrument Schematic Shortcut Menus

Each manually controlled component has a shortcut menu displaying the operations available for that 
particular component, such as, Open, Close, Pulse. To access the shortcut menu, hover the mouse cur-
sor over the component and right click.

Shortcut Icon Description 

When the cursor changes to this icon, right click to display options for the 
selected component:

• For Valves 1-8, 11-16

Open - opens the selected valve. The valve symbol changes to green. An 
alternate method is to either double click the valve or select the valve 
and press the keyboard spacebar to turn it off/on.

Close - closes the selected valve. The valve symbol changes to yellow. 
An alternate method is to either double click the valve or select the valve 
and press the keyboard spacebar to turn it off/on.

Pulse - use to quickly turn the valve on and off allowing the operation to 
proceed in small increments.

• For Servo Valve:

Set - use to set the servo valve target pressure and to Dose or Evacuate. 

Open - opens the servo valve. The valve symbol changes to green. 

Close - closes the servo valve. The valve symbol changes to solid black.
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Automatic - automatically operates the servo valve during dosing or 
evacuation. Enter the target pressure.

Direct - used in Service Test mode only under the direction of a 
Micromeritics service representative.

When the cursor changes to this icon, right click to display options for the 
elevator:

• Raise - raises the elevator. Select Raise and press the keyboard space 
bar to raise the elevator.

• Lower - lowers the elevator. Select Lower and press the keyboard space 
bar to lower the elevator.

• Stop - use to stop the elevator from raising or lowering.

When the cursor changes to this icon, right click to enable or disable the 
temperature control.

Heating Mantle - Set Heating Mantle

Refer to Heating Mantle, page 4-12 for field descriptions.

Shortcut Icon Description (continued)
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Show Instrument Schematic

Unit [n] - Show Instrument Schematic

Use to display an analyzer schematic. To operate the valves and elevator from this window, Manual 
Controls must be enabled (Unit [n] > Enable Manual Control).

Refer to Instrument Schematic Components, page 4-10 for details on this schematic. 

Valve State Description 

Green indicates an open valve.

Yellow indicates a closed valve.
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Show Dashboard

Unit [n] > Show Dashboard

The dashboard displays the following:

• Number of analyses started and the number completed
• Number of days until roughing pump maintenance is due
• Manifold outgas rate
• Manifold temperature statistics
• Nitrogen Po statistics
  

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically kept 
current as the relevant diagnostic data are updated. The gauges will be updated even if the dashboard 
window is not open.         

Red numbers on the dashboard require attention.

To reset the dashboard numbers, right-click on the dashboard setting and click Reset.

Gauge Description 

Analyses completed/started Displays N/M where N is the number of analysis that have 
finished data collection and M is the number of analyses that 
have been started. Analyses canceled or terminated by errors 
before the termination stage starts are not counted as completed.
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Days until roughing-pump 
service is due

Yearly maintenance is recommended. The number of days until 
the anniversary of the last pump maintenance are shown. The 
displayed value is updated at least once per day and when the 
maintenance time is reset. When the displayed value is 30 or 
less, the value is displayed in red. Red negative numbers display 
if maintenance is past due.

Manifold outgas rate Provides the qualitative indication of the outgas rate in the 
dosing manifold. LED images constitute a bidirectional bar 
graph of the outgas rate. 

The gauge is updated after each outgas rate measurement.  

Gauge Description (continued)

The three green LEDs are lit if 
the outgas rate is below 30% of 
the outgas rate limit.

On On On

OnOn
At 30%, the left LED turns 
off. 
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Manifold outgas rate 
(continued)

  

Manifold temperature

Displays the statistics of the manifold temperature reading. The 
mean, the value at two standard deviations, the minimum, and 
the maximum display.

Gauge Description (continued)

At 60%, the center 
green LED turns off. 

OnOn

At 90%, three green LED 
lights turn off and the 
yellow LED is turned on. 

On

At 110% and above, 
only the red LED is 
lit and attention is 
required. 

On
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Show Status

Unit [n] > Show Status

Use to show the current status for each port.

If there are multiple units attached to the computer. Select Show Status on each unit menu and have 
the status for all units displayed at one time.

Nitrogen Po Displays statistics of the saturation pressures measured with 
nitrogen gas at liquid nitrogen temperatures. The mean, two-
sigma, minimum, and maximum values display.

The gauge is updated when a Po is logged with nitrogen as the 
adsorptive and a bath temperature of 77±2 K.

Gauge Description (continued)

The yellow Post Analysis 
Free Space displays 
when applicable and if 
Free Space After 
Analysis is selected.
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Show Instrument Log

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors or messages. This information is logged for 
a 7-day period for analyses and a 30-day period for messages and calibrations.    

Field or Button Description 

Analysis 

Calibration 

Message

Select which logs to display. 

Include Message 
Number

Use to generate a log report containing all the instances of one message 
number making it easier to look at the history of a particular quantity.

Add Log Entry button Use to enter information to appear in the sample log report that cannot be 
recorded automatically through the application. Click the button again to 
enter multiple log entries.
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Report button Click to display the Instrument Log Report Settings window to specify 
report output options.

• Start Date - click to display a calendar to select the start date for the 
report.

• Destination group box:

Preview - sends the report to the screen. Click Print on the report 
screen to send the file to the printer.

Print - sends the report to the default printer.

Copies - select the number of copies to print. This field is only enabled 
when Print is selected.

File - saves the report as a file. 

Click the Browse icon to the right of the text field to select the 
directory where the new report file will be stored. Enter the new file 
name in the File name text box.

File Type - use to save the new file with a .TXT, .XLS or .REP file 
extension. This field is only enabled when File is selected.

–  .REP (Report system) - saves the report in a format that can be 
opened with any MicroActive program.

–  .TXT (ASCII text) - saves the report as a common machine 
language file.

–  .XLS (Spreadsheet file) - saves the report in a format that can be 
opened within a spreadsheet program.

Field or Button Description (continued)
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Degas

Unit > Degas

If a SmartPrep is not connected to the analyzer, the menu options in this section are 
disabled. Refer to Analysis Conditions Files, page 3-16 for in situ degassing.
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Show SmartPrep Status

Unit > Degas > Show SmartPrep Statu

The SmartPrep Status window allows you to monitor the degas operations and stop gas flow 
after samples are degassed.  

Field or Button Description 

Skip button Use to skip the degassing of the selected sample.

Cancel button Use to cancel the degassing of the selected sample.

Set Temperature 
button

Use to set the temperature of the selected port.

Stop Gas Flow button Stops the gas flow to the selected port.
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Start SmartPrep Degas

Unit > Degas > Start SmartPrep Degas

The six SmartPrep heating stations are represented by row numbers on the Automatic Degas 
window.   

Field or Button Description 

Browse button Use to locate a sample file to degas.

Clear button Clears the entry of the selected sample.

Start button Starts the degas process for all samples.

Cancel button Cancels the degassing process for all samples.
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SmartPrep Configuration

Unit [n] > Degas > SmartPrep Configuration

Displays the SmartPrep configuration and software versions.
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Open TranSeal

Unit > Open TranSeal

Outlines the process of safely opening one or more TranSeals on sample ports.     

Damage may occur to the instrument if the samples are not under vacuum and the 
Samples are under vacuum option is selected.

Field or Button Description 

Sample ports to open checkboxes Select the ports to open during analysis.

Samples are NOT under 
vacuum option

Select if samples are not under vacuum and specify the amount 
of backfill and adsorptive to be used prior to opening TranSeals.

Samples ARE under vacuum 
option

Select if the samples are under vacuum. This option evacuates 
sample ports prior to opening TranSeals. Do not select this 
option if the samples are not under vacuum as instrument 
damage may occur.

Start Opens the TranSeals. The selected sample port will be either 
backfilled or evacuated as specified. The user will be prompted 
to open the TranSeals. For each selected port, an Event Log is 
recorded in the Instrument Log with the port pressure before an 
after opening the TranSeal.

Cancel Cancels the process.
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Unit Configuration

Unit [n] > Unit Configuration

Use to display hardware/software configurations, calibrations, and gas selections of the connected 
analyzer.   

Field or Button Description 

Configuration 
group box

Displays the IP address used by the analysis program and the serial number 
of the selected analyzer.

• Change IP - click to display the Unit IP Setup window. The IP address 
and Subnet mask assigned during installation display. Do not edit these 
fields unless instructed by a Micromeritics service representative.

• Board ID - click to read the board ID. The parameters on this window 
cannot be edited.

Software Versions 
group box

Displays the software versions of the MIC BIOS, controller, and analysis 
program.

Gas Selections 
group box

In the text boxes, enter the mnemonics for the analysis gases attached to 
inlet valves.

Options Displays options installed on the instrument.

If the auxiliary gas inlet 
manifold is present, a 
second column displays.
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Diagnostics

Refer to DIAGNOSTICS, page 7-1.

Calibrations button Displays calibration information for instrument components.

Field or Button Description (continued)
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Calibration

Unit [n] > Calibration

Use to perform system calibrations. Disabled calibration options can be accessed only with the assis-
tance of an authorized Micromeritics service representative.

Information on the following items are not available in this manual. They are enabled when in Service 
Test Mode only.

• Pressure Scale
• Vacuum Gauge
• Manifold Volume
• Port Volumes
• Elevator
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Pressure Offset

Unit [n] > Calibration > Pressure Offset

This procedure evacuates the system and zeros the selected pressure transducers. In order to perform 
this procedure, sample tubes must be attached to each port.

Field or Button Description 

1000 mmHg Transducers
checkboxes

Select the manifold and/or ports.

10 mmHg Transducers
checkboxes

Select the manifold and/or ports. Enabled only for the manifold 
and ports with 10 mmHg transducers present.

0.1 mmHg Transducers 
checkboxes

Select the ports. Enabled only for ports with 0.1 mmHg 
transducers present.

Start button

Cancel button

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Match Transducers

Unit [n] > Calibration > Match Transducers

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match them to the 
manifold transducer near full scale pressure. In order to perform this procedure, sample tubes must be 
attached to each port.   

Reset Pressure Calibration

Unit [n] > Calibration > Reset Pressure Calibration

This procedure resets the pressure calibration to the factory default settings. 

Click Yes to reset the pressure calibration.

Field or Button Description 

1000 mmHg Transducers
checkboxes

Select the ports.

10 mmHg Transducers
checkboxes

Select the ports. Enabled only for ports with 10 mmHg 
transducers present.

Start button

Cancel button

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Servo Valve

Unit [n] > Calibration > Servo Valve

Use to calibrate the servo valve to the manifold pressure transducer. The servo valve should always be 
recalibrated after a pressure calibration has been performed. The pressure transducer should be cali-
brated before starting this calibration procedure. Refer to Servo Valve, page 8-24.

Field or Button Description 

Start button

Cancel button

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.
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Temperature

Unit [n] > Calibration > Temperature

The allowable low calibration range is from 0.0 °C to 40.0 °C. The allowable high calibration range 
will be from 41.0 °C to 400.0 °C.

Changing the calibration information will affect the performance of the instrument. 
Only qualified personnel should do this.
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Save to File

Unit [n] > Calibration > Save to File

Use to save the current calibration settings to a backup file which can later be reloaded using Unit [n] 
> Calibration > Load from File menu option.

Field or Button Description 

File name text box The default file naming convention for calibration files can be 
used or the filename can be changed. The default file name is 
interpreted as:

0217 - 2012-04-25.CAL

File name extension

Instrument serial number

Date calibration file was saved
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Load from File

Unit [n] > Calibration > Load from File

Use to load a previously saved calibration file. 

It is recommended that the current calibration settings be saved using Unit [n] > Calibration > Save to 
File prior to loading another calibration file. When loading a previously saved calibration file, a 
backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each time 
a new one is created.

Service Test

Unit [n] > Service Test

Use for service tests performed only with the assistance of a trained Micromeritics service representa-
tive. These tests provide the service representative with troubleshooting tools and readouts.

This option is enabled only when the analysis program is operating in Service Test mode. Refer to
Service Test Mode, page 6-4.


Changing the calibration may affect the instrument’s performance.
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5.  REPORTS MENU

Introduction

This chapter contains information specific to the Reports menu options used to customize and run 
reports. This chapter provides details of Reports menu options, commonly used functions and buttons, 
field-by-field descriptions, and sample reports. 

Reports can be generated for data: 

• collected on a sample that has completed analysis
• collected on a sample currently being analyzed
• manually entered

Common Fields and Buttons - Reports Menu Options

The following fields and buttons are common to many of the report files. References are made to these 
fields and buttons throughout this chapter.

Field or Button Description 

Autoscale checkbox When enabled on report parameters screens, allows the x- and y-axes to be 
scaled automatically. Autoscale means that the x- and y- ranges will be set 
so that all the data is shown. If Autoscale is not selected, the entered range 
is used.

Axis Range On report parameters screens, the From / To fields are enabled when 
Autoscale options are not selected. Enter the starting and ending values for 
the x- and/or y-axes.

Browse button Click to locate another file.

Cancel button Closes the window and cancels any unsaved changes.
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Destination 
group box

• Preview - sends the file to the screen. Click Print on the report screen to 
send the file to the printer.

• Print - sends the file to the default printer.

• Copies - select the number of copies to print. This field is only enabled 
when Print is selected.

Destination 
group box
(continued)

• File Type - use to save the new file with a .TXT, .XLS or .REP file 
extension. This field is only enabled when File is selected.

–  .REP (Report system) - saves the report in a format that can be 
opened with any MicroActive program.

–  .TXT (ASCII text) - saves the report as a common machine 
language file.

–  .XLS (Spreadsheet file) - saves the report in a format that can be 
opened within a spreadsheet program.

File name text box Select a file from either the Name column or from the library. The file name 
displays in the File name text box. Click Open or double-click the file 
name to open the file. Multiple files can be selected by holding down the 
Ctrl key on the keyboard while selecting multiple files.

From / To text boxes Enter the From and To range for autoscaling the x- and/or y-axes.

Name column Displays a list of files in the selected directory.

OK button Click to save and close the active window.

Open button Select a file from either the Name column or from the library. Click Open 
to open the file.

Report button Click to generate the report.

Save button Saves the active file.

Field or Button Description (continued)
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Start Report

Reports > Start Report (or use the F8 keyboard shortcut)

Use to generate a report on a sample analysis.

Close Reports

Reports > Close Reports (or use the F9 keyboard shortcut)

Use to close all open report windows. This option is unavailable if reports are being generated.
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Open Report

Reports > Open Report > [file}

Use to open a saved report.
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SPC Report Options

Reports > SPC Report Options

Use to generate reports with various SPC (Statistical Process Control) options. All selected variables 
must be computed for each sample file used in an SPC report; therefore, it is more efficient to select 
only the necessary variables.

The selected items appear as options on the Reports > Regression Report screen as selections in the 
dropdown boxes and are used in graph selection in Reports > Control Chart.

If additional report options are required, click the More button.
Dec 2012 5-5 



SPC Report Options 3Flex
The selected items also appear as options on the Reports > Control Chart screen. (Click the Graph [n] 
button, then click the Statistic dropdown arrow.)
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Regression Report

Reports > Regression Report

Use to generate an SPC (Statistical Process Control) Regression report to determine the interdepen-
dency between two variables. Up to three dependent variables (y-axis) may be plotted against a single 
independent variable (x-axis). The degree of correlation between the variables is also reported.   

Field or Button Description 

Show report title text box Select and enter a report title to appear on the report header.

Show graphic 
text box

Use to show a graphic on the report header. Click the Browse button to 
locate the graphic.

• Height / Width - enter the height and width of the selected graphic. 
These values determine the graphic appearance on the generated 
report.

X- and Y-Axis 
Variable 
dropdown lists

Use to designate the x- and y-axes variables. The variables in the 
dropdown lists are those selected in the Reports > SPC Report Options 
window. Use these options to plot the regression of up to three y-axis 
variables against the x-axis variable.

Axis Range 
text boxes

Enter the beginning and ending values for the x- and y-axis ranges. 
These fields are disabled if Autoscale is selected.

Autoscale checkboxes When enabled, allows the x- and y-axes to be scaled automatically.
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Tabular report checkbox Use to generate a tabular report of the included samples. A tabular 
report contains the numeric values contributed by each sample.

Recalculate archived 
SPC results checkbox

Use to have archived SPC values recalculated ensuring any changes 
made to the SPC Report Options are included in the new report. 
Selecting this option lengthens the time required to generate the report.

Label data checkbox Use to label the points on the plot to correspond with the values in the 
sample files.

Samples button Click to select sample files for report generation. Multiple files can be 
selected by holding down the Ctrl key on the keyboard while selecting 
the files.

• Available Files - contains files located in the directory specified in 
the Look In text box.

• Selected Files - files added from the Available Files list box.

• Add / Remove buttons - select a file in the Available Files list box 
and click Add to move the file to the Selected Files list box. Or 
select a file in the Selected Files list box and click Remove to move 
the file back to the Available Files list box. Or double-click the file 
name to move the file from one list box to the other.

Report button Click to view the report for the items selected.

Save as Default button Click to save selected report options as default report settings.

Field or Button Description (continued)
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Browse button

Cancel button

Destination group box

From / To text boxes

OK button

Refer to Common Fields and Buttons - Reports Menu Options, 
page 5-1.

Field or Button Description (continued)
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Control Chart

Reports > Control Chart

Use to generate an SPC (Statistical Process Control) control chart report which plots the changes in a 
statistic.  

Field or Button Description 

Show report title text 
box

Select and enter a report title to appear on the report header.

Show graphic 
text box

Use to show a graphic on the report header. Click the Browse button to 
locate the graphic in either .BMP or .EMF format.

• Height / Width - enter the height and width of the selected graphic. 
These values determine the graphic appearance on the generated report.
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X Axis Order by 
group box

Select the order in which x-axis statistics are placed. 

• Time - sorts by the time the files were analyzed.

• File name - sorts in alphanumeric order.

• Date - sorts by the date the files were analyzed.

• Minutes - sorts by the minutes elapsed from the first file placed on the 
list, which is the earliest-analyzed file.

• Days - sorts by the number of days elapsed from the first file placed on 
the list, which is the earliest-analyzed file.

Graph [n] buttons Click to define the y-axis of each graph. 

• Y-Axis group box - 

Statistic dropdown list - displays the SPC variables selected at Reports 
> SPC Report Options window. The selected variable will be plotted 
against time. This selection also becomes the y-axis label.

Autoscale checkbox - allows the y-axis to be scaled automatically. To 
specify a range, deselect this option and enter a range in the From and 
To fields.

• Center Line group box - displays placement options for the center line 
in the graph. Choose Entered to specify placement of the line.

• Limit Lines group box - displays limiting lines options. Lines can be 
placed at some multiple of the standard deviation or at specified 
positions (Entered). When Entered is selected, enter the High limit 
and Low limit fields with appropriate values.

Field or Button Description (continued)
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Tabular report 
checkbox

Samples button

Save as Default button

Refer to Regression Report, page 5-7.

Browse button

Destination group box

Cancel button

Report button

Refer to
Common Fields and Buttons - Reports Menu Options, page 5-1.

Field or Button Description (continued)
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Heat of Adsorption Report

Reports > Heat of Adsorption

Use to select sample files, define quantities and generate a Heat of Adsorption report. The isosteric 
heat of adsorption is an important parameter for characterizing the surface heterogeneity and for pro-
viding information about the adsorbent and the adsorption capacity. Multiple adsorption isotherms are 
obtained on the same sample using the same adsorptive but at different temperatures to obtain the heat 
of adsorption. 

 

Field or Button Description 

Table Contains files added by using the Add Samples button and provides the 
quantity adsorbed.

Add Samples button Click to add a sample file to the table. 

1. Click the Add Samples button.

2. Double-click the file in the Name column or select the file name and 
click Open.

Remove Sample 
button

Click to remove the selected sample from the list.
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Clear Samples 
button

Click to remove all entries from the table.

Edit Quantities 
button

Use to specify the range of surface coverage to include in the report.

• Insert Range button - click to specify the starting and ending quantities 
adsorbed and number of points to insert.

• Insert button - insert a row above the selected row.
• Delete button - deletes the selected row.
• Clear button - clears the entire table of all entries except one.
• Append button - inserts one row at the end of the table.
• Load Table button - click to import values from another file.
• Save Table button - save the current table as a. QNT file.
• Apply button - click to apply all table changes.
• Close button - click to close the table without saving changes.

Field or Button Description (continued)
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Report Features and Shortcuts

Tabular report
checkbox

Refer to Regression Report, page 5-7.

Isostere plot
checkbox

Select to generate a graph showing quantities of gas adsorbed versus the 
temperature.

Heat of adsorption 
plot checkbox

Select to generate the Heat of Adsorption data in a graphical format.

Open button Click to select and open a Heat of Adsorption file.

Browse button

Cancel button

OK button

Report button

Save button

Refer to Common Fields and Buttons - Reports Menu Options, page 5-
1.

Field or Button Description (continued)

Generated
Report
Tabs

Data display 
(either graphical 
or text)

Reports 
List Box

Tool Bar

Header
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Report Header

All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and a title.

• Tabular and graphical reports contain sample and instrument statistics such as analysis date / time, 
analysis conditions, etc.

• The headers contain notes of sample file changes occurring after analysis.

• Summary report headers contain the same information as tabular and graphical reports with the 
exception of notes.
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Report Tool Bar

The Report window has a tool bar and selectable tabs across the top of the report header. To view a 
specific report, select its tab or select the report in the Reports list box and click Show.

Reports can be customized and manipulated using the tool bar, shortcut menus, the zoom feature, or 
axis cross-hairs. 

Field or Button Description 

Reports list box Contains a list of all generated reports. The same reports display as tabs 
across the top of the report header unless the report has been hidden 
using the Hide button.

Show button Jumps to the selected report in the Reports list box (or select the report 
tab to show the report). If the report tab has been hidden using the Hide 
button, click Show to display the report and tab.

Delete button Deletes the selected report. Deleted reports will have to be regenerated if 
deleted in error.

Hide button Hides (or temporarily removes) the selected report from the tabbed view. 
The report name remains in the Reports list box. To redisplay the tab, 
select the report in the Reports list box and click Show.
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Print button Displays the Print window for report output.

• Name dropdown list and Properties button - select the printer and 
click the Properties button to change printer setup, etc.

• Copies group box - select the number of copies and collate option.

• Current button - selects the active report (or selected tab).

• All button - selects all reports in the Reports list box.

• Shown button - selects only the reports not hidden.

• Clear button - clears all selections.

• OK button - prints the selected report to the printer indicated.

• Cancel button - closes the Print window.

Save button Saves all reports of the active file using the sample file name with a 
.REP file extension.

Save As button Saves all selected reports to the indicated file format:

• .REP (Report system) - saves the report in a format that can be 
opened with any MicroActive program.

• .TXT (ASCII text) - saves the report as a common machine language 
file.

• .XLS (Spreadsheet file) - saves the report in a format that can be 
opened within a spreadsheet program.

Field or Button Description (continued)
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Default Style button Click to specify default report parameters for fonts and curve properties.

• Font group box - 

Font Type list box - allows font type and attributes to be edited for 
the selected item. Select an item in the list, click Edit, and select 
from various font options. Click OK when done. 

Field or Button Description (continued)
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Report Shortcut Menus

Shortcut menus are accessed by right-clicking on the report header or the report body displayed on the 
screen.

Report Header Shortcuts

Display header shortcuts by right-clicking in the report header.   

Default Style button 
(continued)

• Curve group box -

Thickness text box - enter a thickness number for the curve.

Histogram Fill dropdown list - select a histogram fill option from 
the list.

• Graph border line thickness text box - enter a thickness number for 
the graph border.

• Load button - click to load the last saved default settings.

• Save button - click to save the changes as the new default settings.

• Close button - click to close the window and save the changes for the 
current report. 

Option Description 

Edit Use to edit the report title and/or graphic to display in the report header.

Copy header as text Use to copy the report header as text. Text is copied to the clipboard and 
can then be pasted into other documents.

Field or Button Description (continued)
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Tabular Reports Shortcuts

Display tabular report shortcuts by right-clicking in the body of the tabular report. Column shortcuts 
require right-clicking on the column to be modified.  

Option Description 

Resize column Right-click on the column to be resized. Select Resize Column on the 
shortcut menu and enter the new column width in inches.

Rename column Right-click on the column to be renamed. Select Rename Column on the 
shortcut menu and enter the new column name. 

Move column Right-click on the column to be moved. Select Move Column on the 
shortcut menu and select Left or Right for the move.

Align column Right-click on the column to be aligned. Select Align Column on the 
shortcut menu and select Left, Right or Center.

Show column Displays a list of all columns. Click a column to add a checkmark and 
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut menu. 
Deselect the Use default font to enable font options. Select new font 
attributes for the report data. To return to the default fonts, select the Use 
default font checkbox.

Table header font Right-click in the report data. Select Table header font on the shortcut 
menu. Deselect the Use default font to enable font options. Select new 
font attributes for the header. To return to the default fonts, select the Use 
default font checkbox.

Edit title Use to edit the report title and/or title font attributes.
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Graph Shortcuts

Display graph report shortcuts by right-clicking in the body of the graph report.

Copy table as text Use to copy the report contents to the clipboard as tab delimited text. It can 
then be pasted into another document.

Option Description 

Autoscale all axes Returns the report to full view after using the zoom feature. 

Reset axis limits to 
initial setting

Removes the cross-hair and returns the graph back to the initial setting.

Show curve Displays a list of all curves. Click a column to add a checkmark and show 
the curve or remove the checkmark to hide the curve.

Edit curve Use to edit selected curve properties.

• Title text box - use to change the title of the selected curve.

Option Description (continued)
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Edit curve (continued) • Style dropdown list - use to select another style for the collected data 
curve.

• Curve group box - options are disabled if Histogram is selected in the 
Style dropdown list. Use to change the interpolation, point style and 
pen style for the selected curve.

Color button - click to change the curve color.

Use default thickness checkbox - select to use the default curve 
thickness. Deselect the checkbox and enter a new thickness number in 
the Thickness text box.

• Histogram group box - enabled only if Histogram is selected in the 
Style dropdown list. Use to specify the type of fill, fill color and label 
position for the selected curve. 

Label dropdown list - select where the graph point labels will display 
(left, right, center, etc.) on the SPC report.

Option Description (continued)

Graph Label
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Edit axis Use to edit the selected axis properties.

• Title group box - use to edit the selected axis label.

Title text box - use to modify the label of the selected axis.

Title font button - use to modify the font for the selected axis label. 
Deselect the Use default font to enable font options. Select the font 
attributes and click OK.

• Scale group box - use to change the graph display.

Linear / Logarithmic - select the option to scale the graph as linear or 
logarithmic.

Autoscale minimum / maximum - select the Autoscale checkbox to 
enable the option. To manually specify minimum / maximum, deselect 
the Autoscale checkbox and enter the new amount in the text box.

Invert scale checkbox - use to invert the scale.

Scale font button - use to modify the font for the scale label. Deselect 
the Use default font to enable font options. Select the font attributes 
and click OK.

Gridlines Major / Minor dropdown lists - use to change how to 
display major / minor gridlines.

Option Description (continued)
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Edit legend Use to change the legend location and font. Click Font to modify legend 
fonts. Deselect the Use default font to enable font options.

Edit title Use to change the graph title and font. Deselect the Use default font to 
enable font options. 

Copy Graph Copies the graph to the clipboard. It can then be pasted into other 
applications. 

Copy Data Copies the report data to the clipboard. It can then be pasted into other 
applications as tab-delimited columns of text.

Option Description (continued)
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Other On-Screen Features

Zoom Feature

Use the zoom feature to closer examine graph details. To use this feature:

1. Open the graph.

2. Hold down the left mouse button and drag the cursor across the graphical area to be enlarged. A 
box will display in the area to be enlarged.

3. Release the mouse button. The enlarged area fills the graph area. To return to normal view, right-
click in the graph area and select Autoscale all axes or Reset all axes to initial setting on the 
shortcut menu.

Axis Cross-Hair

The cross-hair feature displays axis coordinates. To use this feature:

1. Click the left mouse button on the graph to view the cross-hair coordinates.

2. To remove the cross-hair, right-click in the graph area and select Autoscale all axes or Reset all 
axes to initial setting from the shortcut menu.

X-axis 
position

Y-axis 
position

Point of
Coordination
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Report Examples

This section of the manual contains samples of some of the available reports. Most of the reports can 
be customized.
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Isotherm Linear Plot
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BET Surface Area Report
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BET Surface Area Plot
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t-Plot Report
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BJH Adsorption: Cumulative Pore Volume
5-32                                                    Dec 2012



3Flex Report Examples
BJH Desorption: Cumulative Pore Volume
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6.  OPTIONS MENU

Introduction

This chapter contains information specific to the Options menu selections used to configure the system 
by setting defaults for sample and parameter files.

This chapter contains information on:

• changing the default presentation format - Restricted, Basic, or Advanced.
• specifying default parameters for sample information files and report option files.
• specifying how units appear on application windows and reports.

Option Presentation

Options > Option Presentation

Use to change the default editing format of sample files - Restricted, Basic, or Advanced. Each format 
type displays sample information and options differently. For descriptions of the presentation types, 
refer to Defining Sample Information Files, page 2-6. When using Restricted format, a password is 
required to change to Advanced format.

• Show Degas Conditions - when enabled, displays a Degas Conditions tab in Advanced format.

• Check Dewar Shield - when enabled, checks to ensure the Dewar shield is in place prior to starting 
an analysis. An entry is made in the instrument log regardless of operator choice. If this option is 
selected and the Dewar shield is not in place prior to starting an analysis, a warning message 
displays. on the instrument schematic screen.
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Default Method

Options > Default Method

Use to specify default parameters for sample information files.

Manage Libraries

Options > Manage Libraries

The library allows access to sample and parameter files. The library gathers files that are stored in sev-
eral locations. Folders can be added or removed from each library.  

1. To add or remove folders from a library, go to Options > Manage Libraries. Select the library to 
modify then click the Manage button.

This feature is available only for WIndows 7 operating system. It is greyed out if 
running Vista or Windows XP.

Libraries
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2. To add a folder, click Add to browse and locate a folder. Select the folder and click the Include 
Folder button.

3. To remove a folder, select the folder to be removed from the Library locations box and click the 
Remove button.

4. Click OK when done.

Units

Options > Units

Use to specify how data should appear on the application windows and reports. This menu option is 
not available if using Restricted format.
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Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using Restricted 
format.    

Service Test Mode

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the assis-
tance of a trained Micromeritics service representative. This password is supplied by your service 
representative. After Service Test Mode has been enabled, the tests are accessible from the Unit menu 
(Unit > Service Test).

Field or Button Description 

X-Axis / Y-Axis 
options

Select major and/or minor lines to display in reports for the logarithmic and 
linear scales. To remove the gridlines, deselect these options.

Grid Line Styles 
options

Select if the major and/or minor grid lines should appear as solid or dotted 
lines.
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7.  DIAGNOSTICS

Introduction

This chapter contains information specific to running diagnostics and provides details of the diagnos-
tics options in the Unit [n] menu.

Show All Readings

The Show All Readings screen displays the calibrated and nominal readings of all sensors in the 
system. 
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Start Diagnostic Test

Unit [n] > Diagnostics > Start Diagnostic Test

Provides a method to start a diagnostic test immediately.   

Field or Button Description 

View dropdown list • Operation - use to display the current mode of operation. 

• Instrument Log - use to display recent analyses, 
calibrations, errors or messages. Refer to Show Instrument 
Log, page 6-14. 

• Instrument Schematic - use to display a schematic of the 
analyzer system. Show Instrument Schematic, page 6-12. 

Test dropdown list Select the diagnostic test to be performed.

• Degas Heat Test Rev. [n]
• Clean and Verify Gas Line # Test Rev. [n]
• Manifold Heat Test Rev. [n]
• Ports Leak Test Rev. [n]
• System Operation Verification Rev. C

Operator Enter information to identify the person running the service test.
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Comments text box Displays comments from the selected diagnostic test.

Estimated time (min.) Approximate time for test completion. 

Report after test Select to automatically generate reports to the selected 
destination when the test is complete. 

Repeat button Repeats the selected diagnostic test.

Next button Starts the next test.

Start button Starts the selected diagnostic test.

Close button Closes the window.

Field or Button Description (continued)
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Schedule Diagnostic Tests

Unit [n] > Diagnostics > Schedule Diagnostic Tests

Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A separate 
list of tests is saved for each of the possible test frequencies. Tests are categorized and flagged as 
requiring intervention or not. If tests requiring intervention are scheduled, the operator has the option 
of skipping these tests if the operator does not respond within a specified time after an initial prompt is 
displayed, before the test is started. Events are logged in the instrument log for all starting, ending, and 
skipped tests.

Test Frequency

Displays options for scheduling unattended diagnostic tests.  

It is recommended to schedule the Analysis Manifold Leak Test and the Po Port Leak Test 
to run unattended on a weekly basis. These tests check for system leaks and require no 
operator intervention.

The Po Port Leak Test should only be run if the Psat tube is attached. If a vapor source is 
attached, this test should not be run.

Field or Button Description 

Test Frequency option Select how often the test is to run unattended.
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Start Test Sequence if 
Instrument is Idle Any Time 
Between

Enter a From and To time for an unattended test to begin if the 
instrument is idle at any time during the entered time frame.

Available Tests dropdown list Select one or more tests to run unattended. Select the test and 
click the Insert button for the test to display in the Test 
Sequence box.

Test Sequence Provides the test file identification and estimated run time. A 
check mark in the Intervention Required column indicates that 
operator intervention is required. Click Delete to remove the 
selected test or Clear to clear the entire table of all entries.

To add a test to the test sequence, highlight a row in the Test 
Sequence box, select a test from the Available Tests list and 
click Insert. The new test will be inserted above the highlighted 
row.

Select a row and click Delete to remove the test from the 
sequence. Select Clear to remove all entries from the Test 
Sequence box.

Intervention Required Check this option if any test requiring operator intervention 
should be skipped if the operator does not respond within the 
specified time.

Cancel button

OK button

Refer to Common Fields and Buttons - Unit Menu Options, 
page 4-2.

Field or Button Description (continued)
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Diagnostic Test Report

Unit [n] > Diagnostics > Diagnostic Test Report

Displays previously run diagnostic service tests. Separate directories store tests run once, daily, 
weekly, and monthly. Diagnostic Test Report files have a .SVT file extension and are stored in the 
...\Service directory.

1. To open a diagnostic test report, select a service test report and click Open or double click the 
report file name.

2. On the Selected Reports window, select which reports to display and click OK.
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3. The selected reports display on separate tabs across the top of the report window.
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Save Files for Problem Diagnosis

Unit [n] > Diagnostics > Save Files for Problem Diagnosis

Use to compress pertinent diagnostic information into a single zip file. This file can be sent to a 
Micromeritics Service Representative for problem resolution. The following files are included in the 
compressed file:

• 3500.ini
• info[sn].dat
• UserInformation.txt
• Any files selected by the user

Follow these instructions to send the problem description and problem files to Micromeritics Customer 
Support.

1. Complete all fields on this screen. The Comments field is used to provide information that would 
be helpful to the Micromeritics representative. If the computer is not connected to the internet, 
complete the Comments field. If the computer is connected to the Internet, either complete the 
Comments field on this screen OR complete the Description field on the portal listed in Step 6.

2. Click Add… to include files that show the problem diagnosis.
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3. Click Save As. A file named Diagnostics-[date].zip is created. This compressed file contains 
information from this screen, the file(s) you added, and other system files.

4. Specify a location for the saved file. Save the file to:

• the desktop - if this computer has an internet connection, or
• a network drive or a portable media device - if the computer is not connected to the internet .

5. Click Save.

6. From a computer with internet connection, go to http://techsupport.micromeritics.com/portal 
to access the Micromeritics Customer Support Center.

7. Either login or register.

8. Click the Requests tab. 

9. Click the New Request button and complete all fields on the screen. 

10. To attach the zipped file, click the Attach File(s) link and select the Diagnostics-[date].zip file.

11. Click the Add request button to submit the problem request.

12. Return to the portal to track the progress of the problem solution. 

Field or Button Description 

Name

Address

Phone

Email address

Enter information for the person to be contacted by a Micromeritics 
representative. This information will remain on the screen each time 
you need to submit files for problem diagnosis but can be modified as 
necessary.

To the attention of: Enter the name of your Micromeritics representative. This information 
will remain on the screen each time you need to submit files for 
problem diagnosis but can be modified as necessary.

Comment Type in information that would be helpful to the Micromeritics 
representative. If the computer is not connected to the internet, 
complete this field. If the computer is connected to the internet, this 
information can be completed on the Customer Support portal.
Dec 2012 7-9 



Save Files for Problem Diagnosis 3Flex
Include Files • Add - Click to select additional files that you would like sent with 
this problem diagnosis. To select more than one file, hold down 
the Ctrl key on the keyboard while selecting the files, or hold 
down the Shift key to select a range of files.

• Delete - Select the file in the Include Files box and click the 
Delete button to remove the file from the list.

• Clear - Click to clear all files from the Include Files box.

Save As Click to specify the name and location of the compressed file. Make a 
note of the file name and location. This file will need to be sent to your 
Micromeritics representative for problem resolution.

OK Click to close the window and save all contact information. The 
Comment and Include Files boxes will be cleared.

Cancel Click to close the window and cancel changes.

Field or Button Description (continued)
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8.  TROUBLESHOOTING AND MAINTENANCE

Introduction

The analyzer has been designed to provide efficient and continuous service; however, certain mainte-
nance procedures should be followed to obtain the best results over the longest period of time. This 
chapter includes maintenance and calibration procedures.

Troubleshooting

Most operational problems are caused by:

• Leaks (commonly found at the sample tube O-ring at the analysis port)
• Sample weighing errors
• Use of too much analysis bath fluid in the Dewar at the start of an analysis
• Entry of incorrect system volume for analysis
• Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational problems 
not indicated on the screen and their respective causes and solutions are provided in the following 
table:

What Happened Why What To Do

Vacuum pump is noisy. Sample tube connector is loose. Tighten fitting. Replace O-ring.

Sample tube O-ring is worn or 
cracked.

Replace O-ring. Refer to 
Replacing the Sample Port 
Frit, page 8-5.

Sample tube is cracked. Replace with new sample tube.

No sample tube loaded on a 
selected port.

Install plug or empty sample 
tube.

Gas inlet valve open while 
vacuum valve open.

With manual control enabled, 
use the instrument schematic to 
close gas inlet valve.

Analysis Dewar cannot be 
raised (or lowered).

Dewar elevator is stuck. Check for possible obstruction 
to elevator movement.

Analysis valves cannot be 
operated.

Cable from computer to the 
instrument is loose.

Make sure the cable is 
connected properly
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Elevator is noisy. The elevator screw may need 
greasing.

Contact your Micromeritics 
Service Representative.

Sample is not within 
specifications.

There may be a leak into or out 
of the manifold.

Refer to Replacing the Sample 
Port Frit, page 8-5.

Gas may be contaminated. Perform a blank analysis. If 
results are good, perform a 
reference material analysis.

Replace tank.

Check for line leak which could 
cause contamination.

Flush the lines occasionally to 
help prevent contamination.

Incorrect type of gas line. Ensure the gas line is all metal. 
It is best to use the one shipped 
with the instrument. Do not use 
polymer gas lines or flexible gas 
lines that may be internally 
coated with a polymer.

What Happened Why What To Do
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Preventive Maintenance

The following table lists the preventive maintenance procedures to keep the analyzer operating at peak 
performance. Instructions for each procedure follow the table. Micromeritics also recommends that 
preventive maintenance procedures and calibration be performed by a Micromeritics Service Repre-
sentative every 12 months.

Recovering from a Power Failure

The analyzer saves entered and collected data in case of power failure. File parameters and any other 
data entered will still be present when power is restored. If an analysis was in progress when the power 
failure occurred, it will be canceled when the analyzer restarts. Any data collected during the analysis 
will still be present, but the analysis should be started again in order to produce complete results.

Lubricating the Elevator Drive Assembly

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If the 
elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service Represen-
tative for disposition. 

Maintenance Required Frequency

Check and clean Dewar Weekly

Replace port gasket Every 3 to 6 months depending on the 
types of analyses you run

Replace sample tube O-ring As required or every 3 to 6 months

Clean the outside of the analyzer As required or every 6 months

Test analyzer for leaks As required or every 12 months

Replace diaphragm in vacuum pump Every 12 months

Clean or replace power supply air filters Every 30 days (more often in environments 
with increased levels of dust)
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Cleaning the Analyzer

The exterior casing of the analyzer may be cleaned using a clean cloth, dampened with isopropyl alco-
hol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive 
cleaner.

Cleaning the Analysis Dewar

Ice and suspended frost particles may accumulate in the bottom of an analysis port Dewar. Particles or 
deposits exceeding 1/4 in (0.64 cm) in depth may jam between the bottom of the sample tubes and the 
bottom of the Dewar, causing the Dewar not to raise fully. Accumulations of fine particles impede liq-
uid nitrogen circulation around the bottom of the sample tubes. This causes the sample temperature to 
be slightly higher which, in turn, can cause pore volume measurement errors in those samples exhibit-
ing high isotherm slope above 0.97 relative pressure. 

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen evapo-
rates. The water must be removed, otherwise it will solidify when liquid nitrogen is added and could 
press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use. Clean the 
Dewar on a weekly basis.

1. Go to Unit [n] > Show Instrument Schematic to display the instrument schematic, then go to 
Unit [n] > Enable Manual Control.

2. Right-click on the elevator icon and select Lower to lower the elevator to its lowest position.

3. Remove the Dewar and pour the liquid nitrogen from the Dewar into an appropriate cryogenic 
container.

4. Rinse the Dewar with warm water to melt any ice accumulation which may remain in the Dewar, 
then dry thoroughly.

Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in 
damage to the unit.

When handling Dewars, be sure to observe the Dewar precautions outlined in 
Filling and Installing the Analysis Dewar, page 2-41.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to 
burst.
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Replacing the Sample Port Frit

A frit is located in the connecting nut attached to each analysis port. If the frit becomes contaminated, 
the contaminant may adsorb or desorb during analysis, affecting the results. A contaminated frit on the 
analysis port may be indicated as a leak or a free space reading much lower than normal. 

1. Go to Unit [n] > Show Instrument Schematic, then Unit [n] > Enable Manual Control.

2. Right-click on the valve of the appropriate port. If the valve is open, click Close to close the 
valve.

3. Use a wrench to remove the connecting nut from the sample port while using a second wrench to 
hold the port fitting stationary. Remove and discard the used frit.  

Use a 20 µm frit. The instrument will not operate properly if an incorrect size is used.

To avoid degassing problems, the frit should be clean and should not be touched with 
bare hands.
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4. Place a new frit into the connecting nut. 

5. Attach the connecting nut to the sample port fitting and finger tighten. Use a wrench to tighten the 
nut 1/8 to 1/4 turn past finger tight while using a second wrench to hold the port fitting stationary.

Frit

Connecting 
nut

Sample 
Tube Fitting
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Replacing the Psat Fitting Gasket

A gasket is attached to the Psat fitting. Refer to Installing the Vapor Source Container using a Shelf 
Support, page 2-46.

Replacing the Sample Tube O-ring

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring 
becomes worn or cracked, it does not provide a good seal and will need to be replaced. 

1. Carefully remove the Dewar from the elevator. Take care not to bump the sample tube bulbs with 
the Dewar during this process. Place the Dewar aside.

Each time the Psat tube or Vapor Source container is replaced, a new gasket is 
required. Do not touch the sealing surfaces of the port fitting or gasket with bare 
hands.

To avoid degassing problems, the gasket should be clean and should not be touched 
with bare hands.

Before removing (or installing) a sample tube, ensure that the port valve is closed. 
Observe the instrument schematic to verify valve status. 
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2. Holding the sample tube firmly with one hand, loosen the sample tube connector nut by turning 
counterclockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to grasp the 
sample tube with both hands.

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is fully 
seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting (the 
ferrule and O-ring will move along with the connector nut). Then, turning clockwise, hand-
tighten the connector nut to the sample connector. 

If the O-ring remains inside the sample port, use a pair of tweezers or needle-nose 
pliers to remove it.

O-ring

Ferrule

Connector nut
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Replacing the Psat Tube Ferrules

1. Ensure the Psat tube is filled at atmospheric pressure with gas before loosening the Psat nut. 

2. To remove the lower Psat nut, use a 7/16 in (11 mm) wrench to loosen the Psat nut by turning the 
nut counterclockwise. 

3. Remove the Psat tube from the Psat elbow.

4. Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from inside the 
nut. Orient the ferrules as shown with the cone pointed out of the nut.

5. Insert the Psat nut onto the Psat tube, followed by a nylon ferrule, then a teflon ferrule.

6. Insert the Psat tube into the Psat elbow.

Over an extended period of time, pivoting the Psat tube may cause wear on the nylon 
and teflon ferrules housed in the Psat tube nuts. If the recommended weekly scheduled 
Po Port Leak Test detects a leak by reporting Failed on the Evacuated or Pressured report, 
the first time a leak is detected, tighten the Psat nuts 1/2 turn and rerun the test. If the 
leak is still present, replace the nylon and teflon ferrules.

It is recommended that the VCR connector not be removed from the port fitting for this 
process.

Two ferrule sets are located in the upper and lower Psat nuts. Both sets should be 
replaced. Additional ferrule sets were included in the instrument’s accessory kit.

Lower Psat nut
Teflon ferrule

Nylon ferrule
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7. Hand tighten the Psat nut by turning the nut clockwise. Then use an appropriate size wrench to 
tighten the nut an additional 3/4 turn while holding the elbow so it does not move.

8. To remove the upper Psat nut, use a 7/16 in (11 mm) wrench to loosen the Psat nut by turning the 
nut counterclockwise.

9. Remove the Psat tube from the VCR connector.

10. Remove the nut from the Psat tube and remove the set of teflon and nylon ferrules from inside the 
nut.

11. Reinsert the Psat nut onto the VCR connector, followed by a nylon ferrule, then a teflon ferrule. 
Orient the ferrules as shown with the cone pointed out of the nut.

12. Insert the Psat elbow into the upper Psat nut.

VCR connector

Upper Psat nut

Lower Psat nut

Nylon ferrule

Teflon ferrule

Upper Psat nut

VCR connector
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13. Hand tighten the upper Psat nut by turning the nut clockwise. Then use a 7/16 in (11 mm) wrench 
to tighten the nut an additional 3/4 turn while holding the elbow so it does not move.

Cleaning the Power Supply Air Filter

Two power supply air filters are located on the lower rear panel of the instrument and should be 
cleaned or replaced every 30 days (more often in environments with increased levels of dust).

1. Remove the 4 screws securing the air filter cover. 

2. Carefully remove the cover and air filter. Use an air compressor to remove the dust or the rinse 
with tap water and dry thoroughly. Use caution when removing the cover to avoid breakage.

3. Replace the filter and cover. Secure the cover with 4 screws.

Performing a Reference Analysis

Refer to Reference Analysis, page 4-7.
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Performing a Leak Test

A service representative may request that a leak test be performed to determine if there is a system leak 
and may also require a copy of the report generated by this test.

The following information is displayed during the test:

• Prompts on preparing the instrument for the test
• Approximate time period of the test
• Prompts in which an operator response is required

1. To start diagnostic testing, go to Unit [n] > Diagnostics > Start Diagnostic Test.

2. Click the dropdown arrow in the Test field and select Ports Leak Test Rev. [n]. 

3. Resize the window so that the Report after test section displays. Select the Report after test 
checkbox and Preview and the destination.

4. Click Start.
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5. Click Next. Data will be inserted into the window as they are collected.

6. Use the Report dropdown list to select a report to run.

7. Use the Item 1 and Item 2 dropdown lists to change the report details that display in the top and 
bottom boxes.

Suspend Play Skip Report Live Graph 
Settings
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8. When the test is complete, the report will be displayed.

9. To save the report, click Save to save the report or click Save As to specify a library location and 
change the default file name.

10. E-mail the file to the service representative requesting the report.
8-14                                                    Dec 2012



3Flex Connecting Gases
Connecting Gases

Guidelines for Connecting Gases to the Analyzer

Guidelines when installing regulators and gas lines:

• Place gas bottles close to the analyzer. Using gas line extenders on gas bottles located in remote 
areas may degrade gas quality and reduce pressure.

• Use a retaining strap (or other appropriate tether) to secure the gas bottle.

• Carefully route the gas lines from the bottle to the analyzer avoiding overlapping or entangling gas 
lines.

• Label the gas line at the instrument inlet for proper identification and maintenance.

• Ensure the gas bottle is closed before connecting to the analyzer.

The following instructions describe a typical installation. Some configurations require additional com-
ponents, for example, regulator expansion kits, when one gas source will be used for several operations 
or when the gas bottle cannot be located close to the analyzer.

Disconnecting the Depleted Bottle

1. Close the gas bottle shut-off valve then open the regulator shut-off valve.

Gas bottle 
shut-off valve

Regulator 
shut-off 
valve

This procedure is also shown in the Tutorials accessible from the Help menu.

In order to use oxygen, the analyzer must be equipped with an oxygen-compatible 

vacuum pump that uses Fomblin® (or a suitable equivalent) pump oil or a dry pump. 
Failure to use the proper vacuum system could result in hazardous conditions 
including fire and personal injury.
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2. Both gauges should read at or near zero. If not, open the regulator gas shut-off valve to release 
gas. It is not necessary to disconnect the gas line from the regulator or the instrument.

3. Use an appropriate wrench to loosen the nut at the regulator/gas bottle connection then remove 
the regulator from the bottle.

4. Replace the protective cap on the depleted bottle. Disconnect the retaining strap and remove the 
bottle from its current location.

Connecting a Replacement Gas Bottle

Move the replacement bottle close to the instrument and tether it into place. It is not necessary to dis-
connect the gas line from the regulator or the instrument.  

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement bottle.

When connecting hazardous gases, ensure there is proper ventilation and always 
follow the safety procedures established for your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample 
tube. The analyzer uses pressure relief valves to vent this pressure into the instrument 
cabinet and return the instrument to a safe condition. When using toxic or flammable 
gases, additional venting of the cabinet may be required.

Regulator gas shut-
off valve
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2. Attach the gas regulator to the gas bottle connector. Hand-tighten the nut then use an appropriate 
wrench to tighten an additional 3/4 turn.

3. Check for leaks at the high-pressure side of the regulator and in the connector.

a.) Turn the regulator control knob fully counterclockwise.

b.) Slowly open the gas bottle shut-off valve then close it.

c.) Observe the pressure on the high-pressure gauge. 

• If the pressure is stable, proceed with the next step. 
• If the pressure decreases, tighten the regulator connector nut until it becomes stable. 

4. Purge the air from the lines.

Overtightening the fitting may cause a leak.

Regulator 
control knob

HIgh-pressure Gauge

Regulator 
connector nut

Gas bottle 
shut-off valve

Regulator 
shut-off valve

Gas bottle 
shut-off valve
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a.) Turn the regulator clockwise until the low pressure gauge shows a few pounds of pressure.

b.) Turn the regulator shut-off valve counterclockwise to open.

c.) Open the gas bottle shut-off valve to flow gas.

d.) Close the regulator shut-off valve to stop flow.

e.) Close the gas bottle valve.

5. Set the instrument pressure.

a.) Turn the regulator control knob clockwise until the low-pressure gauge reads 15 psig 
(103 kPag).

b.) Open the regulator shut-off valve.

c.) Open the gas bottle shut-off valve and flow gas for 10 to 30 seconds.

d.) Close the gas bottle shut-off valve.

6. If the gas line to the instrument inlet was previously disconnected, reconnect it now.

7. Verify the line for the newly connected gas is clean.

8. If the previously disconnected gas has been reconnected, resume operation.
If a different gas has been connected, the change must be specified in the software. Refer to 
Specifying Gas Ports, page 8-22.

Regulator 
control knob

Low-pressure gauge

Regulator 
shut-off valve

Gas bottle 
shut-off valve
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Cleaning and Verifying the Gas Line 

Always clean the gas lines and verify there are no leaks at the connections after a gas bottle is con-
nected. This test examines the gas line from the instrument to the gas bottle, then from the instrument 
to the regulator shut-off valve. A report is generated at the completion of the test verifying that it has 
passed or failed. Causes and corrective action for a failure are provided.

Before beginning, confirm that the state for valves and the low-pressure gauge are as follows:

1. To start diagnostic testing, go to Unit [n] > Diagnostics > Start Diagnostic Test. 

2. Click the down arrow to the right of the Test field and select Clean and Verify Analysis Gas 
Line [n] Test Rev [n]. The length of time a test will run is also indicated on the screen. The 
Sequence field indicates the name of the file created as a result of this test. 

3. Resize the screen, if necessary to display the Report after test and select Preview as the 
destination. Click Start.

Regulator control knob
OPEN

Gas bottle shut-off valve 
CLOSED

Regulator shut-off valve   
OPEN

Low-pressure gauge
14 - 15 psig
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4. From the View dropdown list, select either Operation, Instrument Log, or Instrument 
Schematic. Refer to Sample Analysis, page 4-3.

5. A following series of prompts display on the screen requiring operator response. 

a.) This is the gas line clean and leak check test for inlet port [n]. Inlet ports being tested must be 
connected to a gas bottle according to the user manual. A Nupro ’isolation’ valve should be 
installed on the line between the instrument and the regulator.

b.) The test starts with a manual leak check (requires Snoop or equivalent, and IPA), then the line 
and regulator are evacuated for 20 minutes for cleaning. Next, the leak rate of the gas line is 
determined.

c.) With the regulator set to 15 psig, open the bottle, regulator shutoff valve, and isolation valve. 
Check each joint for bubbles with Snoop or equivalent. If a joint is leaking, attempt 
tightening (without overtightening) or replace ferrules.

d.) When there are no leaking joints, use IPA to remove water from each joint then wipe dry.

e.) Close the gas bottle valve; leave the regulator shutoff and isolation valves open.

f.) User will be needed in 30 minutes to close the isolation valve. Click OK to begin automated 
testing.

6. A popup window indicates the test is complete. Click OK. The reports display on the screen.
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7. Click each tab and look for a reading of Passed. A Passed reading indicates all valves are in 
proper state for operation. If any test shows a Failed reading, refer to the following table for the 
location of the gas leak.

If the Fail if above field indicates Failed, one or more valves is not in the proper position. Set the 
valves as shown below and ensure the appropriate pressure is displayed on the low-pressure gauge.

If running the test again, close the gas bottle valve before starting the test.

8. Click Close to close the test report. Click Close again to close the test.

Tab Test If Failed status, then...

Gas Line to Inlet 
Port [n] Test 1

Gas Line to Gas Bottle Test This test will show a reading of Failed if any 
of the other tabs has a Failed reading. 
Correct the failed connection and rerun the 
test.

Gas Line to Inlet 
Port [n] Test 2

Gas Line to Isolation Valve 
Test

Check for a leak between the gas line and the 
isolation valve. Correct the problem and 
rerun the test.

Gas Line to Inlet 
Port [n] Test 3

Isolation Valve To Bottle 
Leak Rate

Check for a leak between the isolation valve 
and the gas bottle. Correct the problem and 
rerun the test.

Regulator control knob
OPEN

Gas bottle shut-off valve 
OPEN

Regulator shut-off valve   
OPEN

Low-pressure gauge
14 - 15 psig
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Specifying Gas Ports

The analyzer has gas inlets for up to six analysis gases. The gases connected to the inlets must be spec-
ified in the analysis program. If the gases are changed on one of the inlets, make the same change on 
the Unit Configuration window. The analysis program must be kept informed of any changes in 
gases.

1. Go to Unit [n] > Unit Configuration.

2. In the Gas Selections group box, enter the mnemonics for the gases attached to the gas inlets.

3. Click OK, then click Close.
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Calibrating the System

A calibration file was created specifically for your analyzer and included with your accessories. It is 
not necessary to recalibrate the system unless you suspect it is out of calibration. Certain calibrations 
are not allowed unless performed under the direction of a Micromeritics service representative. Those 
calibrations are greyed out on the Calibration menu.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

The following calibrations can be performed without the assistance of a service representative:

• Zero pressure
• Match transducers
• Servo valve

Zero Pressure

Use this option to evacuate the system and zero the transducers. 

1. Install a small plug on each applicable port.

2. Go to Unit [n] > Calibration > Pressure Offset.

3. Ensure that all applicable transducers are selected, then click Start. The window closes when the 
operation is complete.
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Match Transducers

Use this option to zero and match the selected transducers to the main manifold transducer.

A small plug must be installed on each selected port before clicking Start.

Servo Valve

1. Go to Unit [n] > Calibration > Servo Valve. 

2. Click Start. The window closes when the calibration is complete.

Ensure the pressure transducer has been calibrated before performing this procedure. 
Go to Unit [n] > Unit Configuration and view the calibration information. Contact your 
service representative if calibration dates are not listed.
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9.  ORDERING INFORMATION

The analysis system components and accessories can be ordered using one of the following methods: 

• Call our Customer Service Department at (770) 662-3636
• Email orders to orders@micromeritics.com
• Contact your local sales representative

Please use the following information to place an order.

Part Number Item and Description 

Air Compressors

011-62701-11 Air Compressor 115 Vac 0.71 CFM for operation of pneumatic valves

011-62701-23 Air Compressor 230 Vac 0.71 CFM for operation of pneumatic valves

350-34040-00 Pneumatic Filter Assembly for air source

Analyzer Optional Equipment

060-00035-00 FlowPrep 060, degasses up to six samples at up to 400 ºC with flowing gas. A 
gas source and regulator is required.

061-00035-00 VacPrep 061, degasses up to six samples at up to 400 ºC; uses flowing gas or 
vacuum. Evacuation requires a vacuum pump and flowing gas requires a gas 
source and regulator. 

065-00035-00 SmartPrep 065, Windows interface provides programmable ramp and soak rate 
for degassing up to six samples with flowing gas. A gas source and regulator is 
required.

350-33015-00 Vapor Adsorption option - includes stainless steel reservoir, isolation valve, and 
heating mantle.  Provides the ability to perform three vapor analyses 
simultaneously.

350-33602-00 Port Upgrade Kit for Micropore option - adds 10 torr and 0.1 torr transducer on 
each port to be upgraded to micropore capability. This option is service installed.

Cables

003-63801-01 Cable, Ethernet straight-thru for connecting instrument to control module 
(computer).
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Dewar and Accessories

240-25901-00 Dip stick for checking liquid nitrogen level in Dewar

350-25825-00 Dewar, Glass, 3.2 liters

350-31700-00 Dewar lid, for 9 mm sample tubes

350-31701-00 Dewar lid, for 12 mm sample tubes

Gas Bottle Accessories

004-25549-00 Reducer, 1/8 in. tube × 1/4 in. tube

004-33601-00 Expansion Kit; adds an additional outlet to the gas regulator 

004-33602-00 Pressure Relief Kit; prevents excessive gas pressure in the event of regulator 
failure (not to be used with toxic gases)

004-62230-32 Gas Regulator, CGA 320, 30 psig (CO2)

004-62230-58 Gas Regulator, CGA 580 fitting, 30 psig (He, N2, Kr, Ar)

290-25846-00 Gas Inlet Line, 1/8 in. × 6 ft., copper

290-25846-01 Gas Inlet Line, 1/8 in. × 16 ft., copper

Heating Mantle

350-26001-00 Vapor Heating Mantle

350-53700-00 Degas Mantle top for 350-26000-00 (Glass-Col mantle)

350-53701-00 Degas Mantle with top

350-53701-01 Degas Mantle top for 350-53701-00

Part Number Item and Description (continued)
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Isothermal Jacket

350-25812-02 Isothermal Jacket, 9 mm ID

350-25812-03 Isothermal Jacket, 12 mm ID

Operating Supplies

350-33609-00 Extended operating supplies, 9 mm. Includes sample tubes, filler rods, O-rings, 
reference materials and other accessories.

350-33610-00 Extended operating supplies, 12 mm. Includes sample tubes, filler rods, O-rings, 
reference materials and other accessories.

Reference Material

004-16821-00 Reference Material, Silica alumina, ~ 215 m2/g,10 g

004-16844-00 Reference Material, Y Zeolite

Sample Tubes and Accessories

004-25013-02 O-Ring, -013 70 Duro Viton, Brown

004-25040-05 Gasket, 1/4 in., SS, Retainer Assembly

004-25040-06 Gasket, 1/2 in., SS, Retainer Assembly

004-27070-00 Frit, 20 m, 1/4 in.

004-32004-00 Rubber stopper for sample tubes (fits various sample tube sizes)

004-54104-01 16 in. Brush, for cleaning 12 mm sample tubes

004-54104-02 16 in. Brush, for cleaning 9 mm or 12 mm sample tubes

004-54618-00 Tool, for removing the sample port O-ring

240-14855-00 Rack, sample tube holder

240-25853-00 Funnel, sample tube

300-32800-00 Support, sample weighing 

Part Number Item and Description (continued)
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350-25843-01 Ferrule, for 9 mm sample tube

350-25843-00 Ferrule, for 12 mm sample tube

350-25864-00 Check Seal assembly for 12 mm sample tube

350-33603-00 Sample Tube Kit, 12 mm; includes 6 O-rings, 6 stoppers, 3 isothermal jackets, 4 
ferrules, 1 Dewar lid, 6 sample tubes, 3 hanging filler rods, 1 sample tube brush

350-33604-00 Sample Tube Kit, 9 mm; includes 6 O-rings, 6 stoppers, 3 isothermal jackets, 4 
ferrules, 1 Dewar lid, 6 sample tubes, 3 hanging filler rods

350-33607-00 Check Seal Kit, 12 mm, includes 3 openers, 3 Check Seals, and 1 extractor tool

350-61002-02 Sample Tube, 9 mm, flat bottom

350-33608-00 TranSeal Kit, 12 mm

350-61002-03 Sample Tube, 12 mm, flat bottom 

350-61003-00 Hanging Filler Rod for 9 mm sample tube

350-61003-01 Hanging Filler Rod for 12 mm sample tube

Software and Manuals

350-20800-00 3Flex - current version software

350-33001-00 3Flex - operator’s manual and current version software

350-42800-00 3Flex - operator’s manual

Vacuum Pump and Accessories

004-25509-00 Clamp, NW 10/16

004-25626-04 Flex Tube, 3/4 in. OD × 48 in., NW 16

004-25630-00 Centering Ring, NW 16

004-62023-01 Service kit for dry diaphragm vacuum forepump

Part Number Item and Description (continued)
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A.  FORMS

This appendix contains the following form:

• Sample Data Worksheet

Copy and use this form as needed.
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Sample Data Worksheet

Use this worksheet to record the values necessary to calculate the sample mass.

Sample Tube Identification:_________________________________

Degas notes: _______________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

Sample Mass (g)

NOTE: Record all values in grams.

Before Degas After Degas After Analysis

A. Mass for empty sample tube set: ____________

B. Sample tube set plus sample mass: ____________ ____________ _____________

C. Sample mass (B - A): ____________ ____________ _____________

Degas Information

Degas apparatus: ____________________________________________

Temperature (ºC): ____________________________________________

Time (hours): ____________________________________________

Actual time started: ____________________________________________

Actual time finished: ____________________________________________
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B.  ERROR MESSAGES

Program error messages are listed numerically. If the Action response indicates to contact a Micromer-
itics service representative, record the error message and make backup copies of any files involved in 
the operation.

2400 Series

2401- FATAL ERROR: [error message]

2430- Error accessing file [file name], error code = [n]. 

The 1000-series error messages, used primarily for software testing, are not included 
in this appendix. These errors should not occur during normal operation. If a 1000-
series message appears, contact a Micromeritics service representative after making 
backup copies of any files involved in the operation.

Cause: An internal processing and/or hardware error has occurred during 
communication with the analyzer.

Action: Contact your Micromeritics service representative.

Cause A: Media may be damaged.

Action A: Clean the media drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Contact your Micromeritics service representative.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your Micromeritics service representative.

Cause D: The file name specified contains one or more invalid characters.

Action D: Enter a valid file name. Refer to the operating systems manual.
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2431- Error writing file [file name], error code = [n].

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File [file name] — Subset # [n] wrote wrong amount of data. Expected [n] bytes.

2436- Path specification [path name] is invalid.

2437- File/Overlay file [file name] does not exist.

Cause: Insufficient hard disk space to perform the operation.

Action: Copy files not used regularly from the hard disk to an external media, 
delete them from the hard disk and try the operation again

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: Several analyzer files (sample information, analysis conditions, 
adsorptive properties or report options) have been added to this 
directory by some function other than the analyzer program.

Action: Select Yes to update the directory information with data from each 
new file. This operation may take a minute. 

Select No to locate the file manually. This option may be feasible if a 
large number of files have been copied into the directory and the 
name of the file is known.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: An invalid path name and/or extension was entered.

Action: Type a valid path name (including the proper extension) and press 
Enter.

Cause: The entered file specification does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.
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2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

2448- File directory [path name] is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2451- Deleted entries have been found in this directory. Refreshing the directory 
information.

Cause: An unexpected error occurred when trying to access a data file.

Action: Contact your Micromeritics service representative.

Cause: A working directory specified in the .INI file is invalid or has been 
moved or deleted.

Action: The installation directory will be substituted. The next time a file is 
opened, use the Directories list to move to the correct directory.

Cause: An invalid file name was entered.

Action: See the description of file naming conventions in a Windows manual 
and re-enter the name.

Cause: An automatic analysis (an analysis in which sample files are created 
using the defaults) was processing while editing the defaults.

Action: Finish the edit session of the defaults and close the window then 
restart the automatic analysis.

Cause: Informational message only indicating the system is looking for 
directory entries that cannot be found.

Action: Wait a few moments for the system to finish refreshing and retry the 
operation again.
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2456- Insufficient file handles available. Application cannot continue.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit? [Yes, No]

2460- Fatal Communications error on [Unit n - S/N: nnnn] 

Cause: More than 50 files are open at the same time.

Action: Refer to an operating system manual and set the limit for open files to 
50 or greater.

Cause: An attempt was made to exit the application while the instrument was 
performing a critical operation. This operation must be completed 
before the application can be stopped.

Action: Wait a short time and attempt to stop the application again.

Cause: An attempt was made to exit the application while an analysis was in 
progress. While this is possible, the data collected when the 
application is inactive will not be permanently recorded until the 
application is re-started. A power failure to the instrument could 
cause some data to be lost.

Action: If not concerned with the potential for loss of data should a power 
failure occur, click Yes to continue; otherwise click No.

Cause: There was a fatal error in communication between the application and 
the software in the instrument. All displays for that instrument will be 
closed.

Action: Ensure that the analyzer is connected to the computer on the 
communications port configured in the Setup program. Stop and 
restart the analyzer software. Contact your Micromeritics service 
representative.
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2461- No instruments are in operation. This application will unconditionally 
terminate.

2477- Unit [n] - S/N: [n] did not properly initialize.

2478- Error copying sequential data segment.

2479- Unit [n]; Serial [n] The instrument is busy performing an operation of which 
this application is unaware. Do you want to cancel? [Yes, No]

Cause: At least one instrument must be active for the application to operate. 
The initialization of all of the instruments configured with the Setup 
program has failed. The application stops.

Action A: Usually this message is preceded by another message giving the 
reason for the instrument’s failure to initialize. Refer to the 
instructions for that message. 

Action B: Ensure that the instrument is attached to the computer on the 
communications port configured with the Setup program. Verify that 
the instrument has the power switch in the ON position and that the 
light on the front panel is illuminated. If the application continues to 
fail in its attempts to initialize the instrument, contact your 
Micromeritics service representative.

Cause: The software was unable to initialize this instrument. This is usually 
caused by one of the conditions listed in the error messages above.

Action: Correct the problem as described above then restart the application.

Cause: An internal processing and/or hardware error occurred while 
accessing a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors, for 
example, consider using a utility, for example, ScanDisk. Contact 
your Micromeritics service representative.

Cause: During initialization of the application the status of the analyzer was 
found to be in a different state than expected.

Action: Click Yes to cancel the operation in process allowing the analyzer to 
reset and continue with initialization. Click No to cancel the 
initialization process.

If this error message continues, verify that files in the application 
directory structure are not being changed or removed.
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2480- File [name] cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file [file name].

2482- File cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on [file name]. It is open for editing and con-
tains errors.

2484- The edit session for [file name] must be saved before the analysis. Save 
changes and continue with the analysis? [Yes, No]

2485- The service test file has an invalid status and cannot be used for this analysis.

Cause: An attempt was made to start an analysis using a file that is open for 
editing.

Action: Finish editing the file, save and close it then start the analysis. 

Cause: An unexplained error prevented access to this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: An attempt was made to open a file currently being used.

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: An attempt was made to use a sample file containing errors that is 
currently open.

Action: Go to the window containing the file, correct the errors and save it.

Cause: An attempt was made to start an analysis using a file that contains 
unsaved changes and is open for editing.

Action: Select Yes to save the changes and proceed with the analysis. Select 
No to cancel the analysis and continue editing the Sample 
Information file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace 
All to copy parameters from the file originally selected.
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2486- Could not construct [name] report type. Program will terminate.
.2487- Could not start report generator. Error code [number]. Program will 

terminate.

2488- File [file name] cannot be opened for editing. It is already in use.

2489- File [file name] cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing dia-
log box.

2492- This field’s entry is invalid.

Cause A: Full rights to the application’s folders and files is required.

Action A: Contact a system administrator to have full rights granted.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your Micromeritics service representative.

Cause: The specified file is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The specified file in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Run the analyzer setup program, select Change analyzer setup and 
create the control file used by the analyzer.

Cause: The highlighted fields contain invalid entries. The dialog box cannot 
be closed until all errors are corrected.

Action: Check the entries, correct the errors and close the window.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.
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2493- An entry is required for this field.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between [value] and [value].

2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: This field requires a valid entry to proceed.

Action: Enter or select an appropriate value.

Cause: The entered value in the highlighted field is outside the valid range of 
values.

Action: Check the entry and enter or select an appropriate value.

Cause: An invalid number entered in the highlighted field.

Action: Check the entry and enter or select a valid number.

Cause: An invalid character was entered in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status, for example, from automatically 
collected to manually entered could not be done.

Action: Contact your Micromeritics service representative. Record the name 
of the sample file in which the problem occurred.

Cause: An attempt was made to enter a sequence number that did not contain 
at least three digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2505- Error logger cannot be initialized. Error code [n]. Program will exit.

2506- Sample file [file name] has a 'No Analysis' status and cannot be used for this 
operation

2507- The sample has an invalid status and cannot be used for degassing.

2513- Unable to read the calibration file [file name].

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Default Method and enter another sequence 
number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your 
Micromeritics service representative.

Cause: An internal processing error has occurred.

Action: Contact your Micromeritics service representative.

Cause: The selected sample file does not have collected data and cannot be 
used for operations, for example, reporting.

Action: Enter the name of a file with a status of Complete, Analyzing or 
Entered or select a sample file from the list box.

Cause: A sample file has been selected which does not have a No Analysis or 
Prepared status.

Action: Select a different file with a status of No Analysis or Prepared.

Cause: An invalid calibration file was selected or one that cannot be read.

Action: Ensure the media containing the calibration file has no problems.
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2514- Unable to write the calibration file [file name].

2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2520- No data points available for reporting.

2521- Unable to program controller.

Cause: An attempt to save calibration data has failed due to possible media 
problems.

Action A: Ensure the destination location has no problems.

Action B: Choose an alternate media to save the calibration data.

Cause: The process of performing a calibration operation was started.

Action: Calibration operations should only be done by or under the direction 
of qualified service personnel.

Cause: A calibration operation was performed and a backup copy is 
recommended.

Action: Perform a calibration Save operation.

Cause: The calibration has not been accepted.

Action: If the calibration operation was successful, press Accept.

Cause: The selected sample file does not have collected data and cannot be 
used for reporting.

Action: Select a different sample file.

Cause: A hardware malfunction has occurred.

Action: Contact your Micromeritics service representative.
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2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2548- System status [n]

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: The application has discovered a different version of software 
operating in the analyzer. 

Action: If there are no analyzers other than the one connected to the computer, 
select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet 
slot at the analyzer connection and the computer connection.

Contact your Micromeritics service representative.
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2549- Error accessing online manual file [code #].

2550- Attempts to acquire the instrument’s status timed out.

2551- Unable to establish the TCP connection with the instrument.

2552- Configured serial number does not match instrument.

2553- Dialog ID [file name] can not be created!.

2556- File [file name] cannot be opened. It is currently being setup for an analysis
2556- Directory database [n] error [n]

Cause: The operator’s manual file could not be located.

Action A: Reinstall the application.

Action B: Copy the contents of the manual folder from the setup CD to the 
application directory.

Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet 
slot at the analyzer connection and the computer connection.

Contact your Micromeritics service representative.

Cause: TCP connection could not be established

Action: Check the cable connection. Ensure the addresses match those 
selected in the Control Panel for TCP/IP connections (network 
properties).

Cause: An instrument was substituted without properly changing the 
instrument serial number.

Action: Use the installation program to add or move devices as necessary.

Cause: A required dialog could not be found by the software.

Action: Re-install the software.

Cause: The sample file is currently being analyzed and is undergoing a 
critical operation.

Action: Open the sample file after the critical operation has completed.
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2557- Cannot access web page.

2558- The instrument is busy. The requested operation cannot be executed.

2576- The instrument is [sn] is not calibrated.

Cause: The Micromeritics web page for DFT models cannot be accessed. 
This could be caused by an ISP problem of high internet traffic.

Action: Try the operation later.

Cause: The instrument is analyzing and cannot be interrupted.

Action: Try the operation later.

Cause: The analyzer application is in the process of initializing the 
instrument and is unable to locate the calibration files.

Action A: Click OK. Select Unit [n] > Calibration > Load from File and select 
a file containing calibration data.

Action B: Click OK. Close the application and use the Setup program to 
reinstall calibration files.
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4000 Series

4002- Thermal Transpiration correction had no effect.

4003- Error Converting Pressures.
4004- Error Computing Volume Adsorbed.

4005- Pressures were not smoothed. Not enough pressures below 0.10 P/Po

4011- Analysis gas in sample file does not match any gas in the unit.

4012- Psat gas in sample file does not match any gas in the unit.

Cause: The Thermal transpiration correction option was selected on the 
Report Options window; however, the correction did not change any 
pressure by more than one percent. 

Action: Deselect this option to disable this message. This correction is only 
meaningful for very low pressures.

Cause: An internal processing and/or hardware error occurred during report 
generation.

Action: Contact your Micromeritics service representative.

Cause: The Smooth pressures below 0.10 P/Po option was selected on the 
Report Options window. There must be at least 10 pressures within 
this range for smoothing to occur.

Action: Deselect this option to disable this message.

Cause: The analysis gas specified in the sample information file does not 
match the analysis gas entered in the Unit Configuration.

Action A: If the wrong adsorptive was selected in the sample information file, 
change the adsorptive in the file.

Action B: If necessary, attach the appropriate gas bottle then enter the gas in the 
Unit Configuration. 

Cause: If using Measure psat of a gas in Po and T options in Analysis 
Conditions, the selected gas is not one of the selected gases in Unit 
Configuration.

Action A: If the incorrect psat was selected, change the psat gas.

Action B: If the gas was recently connected to the instrument, update the Unit 
Configuration.
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4014-  File [name] is not a valid file for conversion.

4015- Error creating export file for sample [file name].

4016- Sample [sample file name] has no data for export.

4017- Damage to the instrument will result if the sample has not been manually evac-
uated. Have you evacuated the sample?

4020- Disabling this option may damage the instrument. Are you sure that the sample 
should not be backfilled?

4021- The entered Po value (Po and Temperature Options of the Analysis Conditions) 

Cause: The file selected for conversion is not a valid file.

Action: Select only files that have been created by the proper program.

Cause: A file error occurred during creation of an export output file.

Action: The output file name may be invalid. Ensure that the target directory 
exists and is not full or write protected. The target disk drive may be 
damaged or inoperative. Verify that other files may be created on the 
same drive. Contact your Micromeritics service representative. 

Cause: The file selected for export has a status of No Analysis. No export file 
will be created.

Action: Select a file which contains analysis data.

Cause: Backfill sample at start of analysis was not selected on the Sample 
Backfill Options window. The sample tube is normally at atmospheric 
pressure when an analysis is started and it must be backfilled before 
the analysis begins to prevent sample material from being drawn into 
the manifold.

Action: If the sample tube has been manually evacuated, select Yes. If not, 
select No and then either perform a manual evacuation or go to the 
Sample Backfill Options window and select Backfill sample at start 
of analysis.

Cause: Backfill sample at start of analysis was not selected on the Sample 
Backfill Options window. The sample tube is normally at atmospheric 
pressure when an analysis is started; it must be backfilled before the 
analysis begins to prevent sample material from being drawn into the 
manifold.

Action: To manually evacuate the sample prior to the start of the analysis, 
select Yes. Otherwise, select No and go to the Sample Backfill 
Options window and select Backfill sample at start of analysis.
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is outside the range of the pressures listed in the Psat vs Temperature Table 
(Adsorptive Properties).

4022- The entered bath temperature value (Po and Temperature Options of the Anal-
ysis Conditions) is outside the range of the temperatures listed in the Psat vs 
Temperature Table (Adsorptive Properties).

4023- The file [file name] cannot be prepared for analysis. It is open for editing and 
contains errors.

Cause: The entered Po value is not within the range of pressures selected for 
analysis.

Action A: Enter a new Po value.

Action B: Add more pressures and corresponding temperatures to the Analysis 
Conditions pressure table to include the presently selected Po value.

Cause: The entered bath temperature is outside of the range of temperatures 
specified in the Adsorptive Properties.

Action A: Change the entered temperature.

Action B: Change the adsorptive.

Action C: Add more temperatures and corresponding pressures to Adsorptive 
Properties.

Cause: An attempt was made to start an analysis using a file that contains 
errors and is open for editing.

Action: Finish editing this file, save and close it then start the analysis. 
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4024- Backfill gas in sample file does not match any gas in the unit.

4026- Cannot calculate Dubinin-Astkahov: bad least squares data.

4027- Fewer than two sample files have data suitable for heat of adsorption reports.

4028- Dubinin calculations cannot be performed because the affinity coefficient of 
the analysis gas is zero.

4029- At least two fitted data points are needed for Alpha-S calculations.

4030- Preparations failed in primary data.

Cause: The backfill gas specified in the sample information file does not 
match the analysis gas entered in the Unit Configuration.

Action A: If the wrong backfill gas was selected in the sample information file, 
change the backfill gas in the file.

Action B: If necessary, attach the appropriate gas bottle, then enter the gas in the 
Unit Configuration.

Cause: Less than two selected data points are within the fitted pressure range.

Action: Edit the selection of data points on the Dubinin interactive editor or 
on the Dubinin pressures window. 

Cause: Less than two of the selected sample files for heat of adsorption 
reports contain appropriate data.

Action: Edit the Quantity Adsorbed table or select other sample files.

Cause: Dubinin values could not be calculated because the affinity 
coefficient of the analysis gas is zero.

Action: Access the Dubinin Report Adsorptive options in the sample file and 
enter an appropriate value for the analysis gas.

Cause: Fewer than two data points fall within the selected Alpha-s range.

Action: Edit the calculation assignments or the fitted Alpha-s range or use a 
different reference curve.

Cause: Appropriate data were not available to generate the report.

Action: This message was preceded by a different error message. Refer to the 
cause/action of the preceding message.
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4031- Not enough points with a relative pressure in the range [n,n]

4033- Not enough points to generate Dubinin Tabular Report.

4034- Fewer than 2 points available for Dubinin calculations.

4035- Cannot calculate optimized Astakhov exponent: Not enough points with a rel-
ative pressure in the range [(pressure), (pressure)].

4036- Fewer than 2 points available for Horvath-Kawazoe calculations.

Cause: Fewer than two data points selected for the Dubinin report fall within 
the selected relative pressure range.

Action: Edit the calculation assignments or the fitted relative pressure range.

Cause: There are fewer than two valid data points available for the Dubinin 
tabular reports.

Action: At least two micropore pressures must be selected for inclusion in the 
Dubinin report. Edit the selection of data points on the Dubinin 
interactive editor or on the Dubinin pressures window.

Cause: There are fewer than two valid data points available for Dubinin 
reports in one of the sample files selected for overlaying.

Action: At least two micropore pressures must be selected for inclusion in the 
Dubinin report. Edit the selection of data points on the Dubinin 
interactive editor or on the Dubinin pressures window.

Cause: There are fewer than two valid data points in the relative pressure 
range specified. Astakhov reports will not be produced.

Action: At least two pressures must be selected for inclusion in the Astakhov 
report. Edit the selection of data points on the Astakhov interactive 
editor or on the Astakhov pressures window.

Cause: At least two data points must be selected for inclusion in the Horvath-
Kawazoe analysis. No report will be produced.

Action: Edit the selection of points on the Horvath-Kawazoe interactive 
editor or on the Horvath-Kawazoe window.
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4037- Computations failed while processing the primary data set. No reports will be 
produced.

4038- Fewer than 2 points available for the Langmuir Qm computation. Cheng/Yang 
correction will not be applied.

4039- The isotherm does not meet the constraints of the Cheng/Yang assumption. 
Cheng/Yang correction will not be applied.

Cause: The preparation of data for reporting could not be successfully 
completed. No Horvath-Kawazoe reports will be produced. This 
message will always be preceded with another one containing 
additional information.

Action: Refer to the number of the error message which preceded this one for 
an explanation.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation 
requires the value of the monolayer volume as calculated from the 
Langmuir equation. The isotherm must include at least two points 
above 0.02 relative pressure for the Langmuir equation to be applied.

Action: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options window to prevent this message from appearing on 
future reports.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation 
requires the value of the monolayer volume as calculated from the 
Langmuir equation. The isotherm does not correlate to the Langmuir 
assumption with a coefficient of 0.98 or more. The correction is not 
applicable to this isotherm or to the range of the data points selected.

Action A: The analysis will be performed without the Cheng/Yang correction. 
Deselect Apply Cheng/Yang correction on the Horvath-Kawazoe 
Report Options window to prevent this message from appearing on 
future reports.

Action B: Generate the Langmuir report for the same data points selected for the 
Horvath-Kawazoe report. If the Langmuir correlation coefficient can 
be brought above 0.98 by removing some points at high relative 
pressure, remove them and reproduce the Horvath-Kawazoe reports.
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4040- The value of Qm computed from the Langmuir equation is too low. The pore 
size will not be computed for all data points.

4041- Cheng/Yang correction is inappropriate for some P/Po.

4042- 0.0 cannot be a starting or ending pressure for a geometric progression from 
low pressure.

4043- 1.0 cannot be a starting or ending pressure for a geometric progression toward 
saturation.

Cause: The Cheng/Yang correction to the Horvath-Kawazoe equation 
requires the value of the monolayer volume as calculated from the 
Langmuir equation. The computed value is less than the volume 
adsorbed at the largest relative pressure included in the analysis. The 
correction is not applicable to this isotherm or to the range of the data 
points selected.

Action: The analysis will be performed and the Cheng/Yang correction will 
be applied to all points with a volume adsorbed less than the value of 
Vm. The pore size will not be calculated for data points with an 
invalid volume adsorbed. Deselect Apply Cheng/Yang correction on 
the Horvath-Kawazoe Report Options window to clear this message.

Cause: The Cheng/Yang correction is usually inappropriate for any P/Po 
above the isotherm knee. In some instances, the computed pore sizes 
may decrease above the knee. While it is possible to include these 
relative pressures (usually above 0.1 P/Po) in the analysis, the 
computed pore sizes for these pressures are usually meaningless.

Action: Change the data points selected for the Horvath-Kawazoe report to 
include only relative pressures at or below the knee of the isotherm or 
change the Horvath-Kawazoe report options so that the Cheng/Yang 
correction is not applied.

Cause: An attempt was made to generate a pressure table from a 
geometrically progressing range.

Action: Change the 0.0 entered value.

Cause: An attempt was made to generate a pressure table from a 
geometrically progressing range.

Action: Change the 1.0 entered value.
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4044- Points in the Langmuir report pressure table lie outside the collected data.

4045- Points in the report pressure table lie outside the collected data.

4046- [file name] could not be opened for reading.

4047- Warning: An error occurred while reading [file name].

4048- Warning: An error occurred while restoring the heat of adsorption report editor.

4049- The sample [file name] does not have enough data. A minimum of two adsorp-
tion points is required.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data 
and more than one is below.

Action: Change the report pressure table to be more consistent with the 
collected data.

Cause: Calculation assignments are not being used and more than one of the 
report pressure table points is above the range of the collected data 
and more than one is below.

Action: Change the report pressure table to be more consistent with the 
collected data.

Cause: A thickness curve file could not be opened.

Action: If the problem persists, restart the computer and optionally perform a 
media integrity check (using ScanDisk).

Cause: An error happened during a read operation of a thickness curve file.

Action: If the problem persists, restart the computer and optionally perform a 
media integrity check (using ScanDisk).

Cause: The state of the heat of adsorption report editor could not be restored. 
Default settings will be used.

Action: No action.

Cause: A sample file has been included in the Heat of Adsorption report that 
does not have enough data.

Action: Remove the file from the selected file list.
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4050-  None of the requested quantities adsorbed is within the range of the collected 
data of more than one sample file.

4051- The sample [file name] does not have any data in the range of the requested 
quantities adsorbed.

4052- Fewer than two points are selected for this report.

4053- At least two data points must be selected for t-Plot calculations.

4054- Fewer than two data points are inside the fitted thickness range.

4055- A positive BET surface area was not calculated.

Cause: The Heat of Adsorption report failed because the specified quantities 
are not within the range of the collected data.

Action: Edit the quantities adsorbed so that they are within the range of the 
collected data or select other sample files. 

Cause: The sample’s data cannot be interpolated to any of the quantities 
adsorbed.

Action: Edit the quantities adsorbed so that they are within the range of the 
collected data. 

Cause: At least two points are required for the BET calculations.

Action: Edit the calculation assignments for the BET report.

Cause: At least two points are required for the t-Plot calculations.

Action: Edit the calculation assignments for the t-Plot report.

Cause: At least two points must be within the fitted thickness range for the t-
Plot calculations.

Action A: Edit the calculation assignments for the t-Plot report.

Action B: Edit the fitted thickness range in the t-Plot report editor.

Cause: Fewer than two points were assigned to the requested surface area 
calculation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.
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4056- A positive Langmuir surface area was not calculated. Please check your Lang-
muir report.

4057- At least two data points are needed for Freundlich calculations.

4058- At least two data points are needed for Temkin calculations.

4059- Fewer than 2 points available for MP-Method calculations.

4060- Sample [file name] contains no data points.

4061- The t-curve must contain at least 2 points.

Cause: Fewer than two points were assigned to the requested surface area 
calculation in the collected data table.

Action A: Assign more points to the surface area calculation.

Action B: Select a different surface area in the t-Plot report editor.

Cause: Less than two data points have been selected for the Freundlich 
report; at least two are required.

Action: Edit the selection of points on the Freundlich interactive editor or on 
the Freundlich pressures window.

Cause: Less than two data points have been selected for the Temkin report; at 
least two are required.

Action: Edit the selection of points on the Temkin interactive editor or on the 
Temkin pressures window.

Cause: At least two points are required for the MP-Method calculations.

Action: Edit the calculation assignments for the MP-Method report.

Cause: An attempt was made to save a sample without collected data as a t-
curve or alpha-S curve.

Action: Repeat the Save As t-curve or Save As alpha-S operation after 
opening a sample that has collected data.

Cause: At least two points are required in a thickness curve definition.

Action: Edit the thickness curve.
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4062- Error during report preparation.

4063- The data requested on this report are not available. No subreports selected.

4067- No data points are within the range of pressures in the reference isotherm.

4068- No points were selected for the f-Ratio report.

4070- Unable to load deconvolution model [name].

4071- The selected pressures points do not form a valid set for deconvolution.

Cause: An internal processing error has occurred.

Action: Contact your Micromeritics service representative.

Cause: There is no information in the sample log to report.

Action: A sample file was selected which no instrument operations has been 
used. Select a sample file with a status of Prepared, Preparing, 
Analyzing or Complete to obtain a valid sample log report.

Cause: There are no collected data points within the range of pressures in the 
reference isotherm.

Action: Select data points in the range of the reference isotherm or select a 
more appropriate reference isotherm.

Cause: The f-Ratio report does not have any points selected.

Action: Edit the selection of data points on the f-Ratio window

Cause: For some reason, the list of available models was corrupted, 
therefore, the model selected could not be loaded for the 
deconvolution.

Action: Exit the program and reinstall the software, then try again.

Cause: The data points selected for analysis do not contain enough 
information to allow a DFT data reduction.

Action: At least two points with strictly increasing pressures and volumes 
adsorbed are required for a DFT Plus data reduction. Edit the 
selection of data points on the DFT interactive editor or on the DFT 
pressures window.
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4072- The range of pressures selected is too small to deconvolute using this model.

4073- The analysis gas [name] does not match the model gas [name].

4074- The analysis temperature [nn] does not match the model temperature [nn].

4075- The models cannot be located in the models folder. Reinstall the software.

4077- Cannot get surface area for: [file name]

4078- Slope and Y-Intercept cannot be determined from the selected points.

Cause: A null result was found using the selected model.

Action: At least two points with strictly increasing pressures and volumes 
adsorbed are required for a DFT Plus data reduction. Edit the 
selection of data points on the DFT interactive editor or on the DFT 
pressures window.

Cause: The model assumes a specific gas and the sample file uses a different 
one.

Action: Select a model that assumes the same gas.

Cause: The temperature for the selected model did not match the analysis 
temperature.

Action: Select a different model.

Cause: The models could not be located. They may have been inadvertently 
deleted or moved.

Action: Reinstall the software.

Cause: The Isotherm report for the named overlay file has Per gram selected 
for the Volume Adsorbed and the Isotherm report for the primary file 
has a surface area option selected for the Volume Adsorbed.

Action A: Edit the Isotherm report for the named overlay file and select a 
surface area option for Volume Adsorbed.

Action B: Click Overlays on the Report options window of the primary file and 
remove the named overlay file from the list.

Cause: Less than two data points have been selected for the Langmuir report, 
at least two are required.

Action: Edit the selection of data points on the Langmuir interactive editor or 
on the Langmuir pressures window.
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4112- Hard-sphere diameter and molecular weight have been updated from the fluid 
property information.

4400- The computer does not have the communications port specified for the Smart-
Prep(s). Cannot initialize.

4401- The communications port specified for the SmartPrep(s) is already in use. Can-
not initialize.

4402- The communications port specified for the SmartPrep cannot be accessed. 
Cannot initialize.

4403- Cannot communicate with SmartPrep Unit [n] - S/N: [nn].

4404- The application version of the SmartPrep Unit [n] - S/N: [nn] is invalid.

Cause: A fluid property information (FPI) file was loaded. Entry fields for 
hard-sphere diameter and molecular weight were updated with the 
values in the FPI file

Action: This message is informational; no action is required.

Cause: The communications port associated with this unit was not valid.

Action: Run the setup program and set up the unit on a valid port.

Cause: The communications port associated with this instrument is in use by 
some other program in the system.

Action: Close the other program to release the port. Restart the analysis 
application.

Cause: The communications port associated with this unit was not valid.

Action: Run the setup program and set up the unit on a valid port.

Cause: The controller software running on the designated instrument is 
invalid.

Action: Use the SmartPrep setup program to download the proper controller 
software to the instrument, or if unavailable, contact a Micromeritics 
service representative.
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4405- Fatal communications error with SmartPrep Unit [n] - S/N: [nn].

Cause: There was a fatal error in the serial communications between the 
application and the SmartPrep Instrument Controller. All displays for 
that SmartPrep will be closed.

Action: Ensure that the SmartPrep is properly chained to the computer on the 
communications port configured in the Setup program. Stop and re-
start the application. Contact your Micromeritics service 
representative.
Dec 2012 B-27 



Appendix B 3Flex
6000 Series

6000- An error occurred while loading the application control information. Data entry 
cannot be performed. [Code Number]

6003- Unable to read the calibration file [number].

6004- Unable to write the calibration file [number].

6008- At least one sample must be selected to proceed.

6010- This sample requires a different adsorptive and cannot be analyzed at the same 
time as the other samples.

Cause: An error occurred accessing the control information disk file required 
by this application.

Action: The disk drive may have failed or be corrupt. Run diagnostics on the 
disk drive.

Cause: An attempt to load a previously saved calibration file was 
unsuccessful.

Action: Ensure the file exists and the file name is entered correctly. Then try 
again.

Cause: An attempt to save the calibration to a separate file was unsuccessful.

Action: Ensure that the disk is not full or write-protected, then try again.

Cause: An attempt was made to start an analysis without selecting any 
sample files.

Action: Select at least one file, then start the analysis.

Cause: A sample file for analysis was selected that requires a different 
adsorptive gas than the sample files selected for the other ports.

Action: Select only sample files to be analyzed with the same adsorptive and 
perform the analysis. Then perform the analysis with the other 
adsorptive.
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6011- The adsorptive required by this analysis is not available on this instrument.

6012- Cannot read the analysis conditions parameter file.
6013- Cannot read the adsorptive properties parameter file.
6014- Cannot read the report options parameter file.

6015- Cannot read the sample tube properties parameter file.

6016- Dosing manifold from valve [number] failed.

6017- Leak test failed on port [number].

Cause: An attempt was made to start an analysis with an adsorptive that is 
not connected to the instrument or has not been designated in the 
software. 

Action A: Ensure that the adsorptive is connected to the instrument. Then select 
Unit [n] > Unit configuration to tell the application that the gas is 
connected.

Action B: Select only sample files for which the analysis gas is available.

Cause: The parameter file is either corrupt or has been deleted.

Action A: If this is a file created in your lab, recreate the file.

Action B: If this is a default file created during application installation, re-install 
the software.

Cause: The selected sample tube file on the QuickStart screen cannot be read.

Action: Select a different file.

Cause A: The maximum time was exceeded before the target pressure point 
was reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to at least 10 psig (0.7 bar), then resume 
the analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle then resume the analysis.

Cause: With the sample port valve closed, the sample pressure increased by 
0.15 mmHg before the leak test duration was completed.

Action: Check sample tube fitting and ensure that it is securely attached to the 
port then restart the analysis.
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6018- Volume dosed exceeded 1000 cm3 STP. Analysis is canceled.

6019- Elevator failed to reach upper/lower limit switch.

6020- Warning, servo valve performance is out of specification.

6021- Servo calibration failed.

6022- This file already selected for the analysis.

Cause: There is a problem with the analyzer’s calibration.

Action: Use the Setup program to reinstall the calibration files. Contact your 
Micromeritics service representative.

Cause A: There is an obstruction in the elevator path. 

Action A: Clear all obstructions and restart the analysis.

Cause B: Ice is present in the bottom or the neck of the Dewar preventing the 
elevator from rising completely.

Action B: Check the Dewar, remove ice and restart the analysis.

Action B: If results for Actions A and B failed, contact a Micromeritics service 
representative.

Cause: The servo valve tried to dose to a pressure but was unable to reach it 
within specification. The analysis will continue.

Action: At the next appropriate time, calibrate the servo valve to bring it back 
within specification. Refer to Servo Valve, page 4-32.

Cause A: The maximum time was exceeded before the target pressure point 
was reached. The nitrogen regulator may be set too low or turned off.

Action A: Set the analysis gas regulator to at least 10 psig (0.7 bar), then resume 
the analysis.

Cause B: The analysis gas bottle is empty.

Action B: Connect a new analysis gas bottle, then resume the analysis.

Cause: An attempt was made to choose a file for the analysis on this port 
which has been selected for another port.

Action: Choose a different file.
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6024- Evacuation failed.

6025- Target pressure [PRn] [PR-U] exceeded maximum manifold pressure of [PRn] 
[PR-U]. Analysis is canceled.

6026- Psat gas is not condensing.

6027- There is no nitrogen attached to the unit.

Cause: While attempting to zero the pressure transducers, the instrument was 
unable to evacuate to a pressure of less than 1 mmHg. This may be 
due to a leak or a bad calibration.

Action A: Check the sample tube fitting and ensure that it is securely attached to 
the port.

Action B: Use the Setup program to reinstall the calibration files.

Cause: An absolute pressure greater than (pressure) units was attained that 
exceeded the specified maximum manifold pressure. 

Action: The analysis was canceled. All previously collected data were stored. 
Change the maximum manifold pressure value in the Adsorptive 
Properties file.

Cause A: The working Dewar does not contain enough bath liquid.

Action A: Refill the Dewar and try the operation again.

Cause B: The Psat gas is contaminated.

Action B: Replace the Psat gas supply.

Cause C: The Psat tubing from the regulator to the instrument is contaminated.

Action C: Pump out the tubing.

Cause: A calibration requiring nitrogen was attempted but the software does 
not recognize that nitrogen is attached.

Action: Ensure that a nitrogen gas bottle is installed at one of the analysis 
ports, then Select Unit > Unit configuration and enter N2 for the 
appropriate valve.
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6028- The backfill gas in sample file does not match any gas in the unit.
6029- The Po in the sample file does not match any gas in the unit.

6030- Dosing method choice is invalid. The Krypton analysis requires that Adsorptive 
Properties “Dosing Method” is set to “From Psat tube.”

6031- Dosing method choice is invalid. The analysis requires that Adsorptive Prop-
erties “Dosing Method” is set to “Normal.”

6032- Template file [file name] for the selected analysis type does not exist. Select 
another analysis type.

Cause: An attempt was made to start an analysis with a gas that is not 
connected to the instrument or has not been designated in the 
software. 

Action A: Ensure the gas is connected to the instrument. Then select Unit [n] > 
Unit configuration to tell the application that the gas is connected.

Cause: A file was selected for a krypton analysis that has Normal selected 
for the Dosing Method. Normal is for standard analyses only.

Action: Open the sample file and change the Dosing Method to From Psat 
tube or select a different file for the analysis.

Cause: A file was selected for a standard analysis that has From Psat tube 
selected for the Dosing Method. From Psat tube is for krypton 
analyses only.

Action: Open the sample file and change the Dosing Method to Normal or 
select a different file for the analysis.

Cause: A program piece required to run the PCP analysis is missing. Applies 
when in Service Test Mode.

Action: Re-install the software.
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6033-  Krypton gas is not condensing in the Psat tube ([PR1] [PR-U]).

6034- Zeroing of a transducer failed. Analysis Canceled.

6035-  Purification of krypton in the Psat tube failed.

Cause A: The krypton gas may be contaminated.

Action A: Evacuate the krypton gas inlet line.

Action A: Manually verify the saturation pressure of the krypton gas:

1. Evacuate the psat tube.
2. Backfill with krypton gas to 20 mmHg.
3. Raise the Dewar.

These steps should condense the krypton gas to a pressure below 
3 mmHg.

Cause B: The Dewar does not contain enough cryogen.

Action B: Refill the Dewar.

Cause: The transducer did not respond correctly.

Action: Contact your Micromeritics service representative.

Cause A: Krypton pressures in the psat tube did not stabilize after the 
purification steps.

Action A: Evacuate the krypton gas inlet line.

Action A: Manually verify the saturation pressure of the krypton gas:

1. Evacuate the psat tube.
2. Backfill with krypton gas to 20 mmHg.
3. Raise the Dewar.

These steps should condense the krypton gas to a pressure below 
3 mmHg.

Cause: B: The Dewar does not contain enough cryogen.

Action B: Refill the Dewar.
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6040- Failed to reach pressure dosing through servo. Calibration canceled.

6041- Servo Calibration failed.
6042- Master pressure transducer calibration failed. Offset is out of range.
6043- Port 1 pressure transducer calibration failed. Offset is out of range.
6044- Port 2 pressure transducer calibration failed. Offset is out of range.
6045- Port 3 pressure transducer calibration failed. Offset is out of range.
6046- Po pressure transducer calibration failed. Offset is out of range.
6047- 10 torr pressure transducer calibration failed. Offset is out of range.
6048- Master pressure transducer calibration failed. Scale is out of range.
6049- Port 1 pressure transducer calibration failed. Scale is out of range.
6050- Port 2 pressure transducer calibration failed. Scale is out of range.
6051- Port 3 pressure transducer calibration failed. Scale is out of range.
6052- Po pressure transducer calibration failed. Scale is out of range.
6053- 10 torr pressure transducer failed. Scale is out of range.

6557- File [file name] already selected for the analysis

6558- Gas [n] in sample file [file name] does not match any gas in the unit.

Cause A: There was insufficient gas pressure to calibrate for matching 
transducers. The gas is not connected or the tank is almost empty.

Action A: Ensure the gas is connected properly and assigned correctly in the 
Unit Configuration window. Replace the tank if necessary.

Cause B: The gas valve is not working properly.

Action B: Contact your Micromeritics service representative.

Cause: There is a problem with the analyzer’s calibration.

Action: Use the Setup program to reinstall the calibration files. Contact your 
Micromeritics service representative.

Cause: The same sample file is already assigned to a different port for this 
analysis.

Action: Select a different sample file.

Cause: The analysis gas specified in the sample information file does not 
match the analysis gas entered in the Unit Configuration.

Action A: If the wrong adsorptive was selected in the sample information file, 
change the adsorptive in the file.
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10000 Series

10050- Pirani offset calibration is invalid

10070- Cold cathode offset calibration is invalid.

10080- Cold cathode scale calibration is invalid.

10100- Vacuum gauge (Pirani) error detected.

10110- Vacuum gauge (cold cathode) error detected.

10120- Vacuum gauge communications error.

10180- [XDCR] Transducer offset calibration rejected (current: [PR4] [PR-U], new: 
[PR4], nominal: [PR4], max: [PR4]).

Cause: There is a problem with the Pirani offset calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the cold cathode offset calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the cold cathode scale calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the vacuum gauge (Pirani).

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the vacuum gauge (cold cathode).

Action: Contact your Micromeritics service representative.

Cause: There is problem with communication between the instrument and 
the vacuum gauge.

Action: Contact your Micromeritics service representative.

Cause: The transducer offset calibration was rejected.

Action: Contact your Micromeritics service representative.
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10190- Transducer scale calibration rejected (current: [PR4] [PR-U], new: [PR4], nom-
inal: [PR4], min: [PR4], max: [PR4]). 

10200- Transducer underrange detected.

10210- Transducer overrange detected.

10240- Temperature offset calibration rejected.

10250- Temperature scale calibration rejected.

10270- Invalid servo calibration error.

10280- Servo DAC timeout detected.

10300- Turbo pump failure detected.

Cause: The transducer scale calibration was rejected. 

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the transducer underrange.

Action: Contact your Micromeritics service representative.

Cause: A manifold pressure over 1000 mmHg was detected.

Action: Observe caution when operating the analyzer manually. If the 
problem persists contact a Micromeritics service representative.

Cause: There is a problem with the temperature offset calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the temperature scale calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the servo calibration.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the servo DAC timing out.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the turbo pump.

Action: Contact your Micromeritics service representative.
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10310- Turbo pump temperature error detected.

10320- Turbo pump communications error detected.

10360- Time limit exceeded while waiting for the elevator to rise into position (elapsed: 
[0] s, max allowed: [0] s, status: [HEX], alarm code: [HEX], inputs: [HEX], posi-
tion: [0]).

10370- Time limit exceeded while waiting for the elevator to lower into position 
(elapsed: [0] s, max allowed: [0] s, status: [HEX], alarm code: [HEX], inputs: 
[HEX], position: [0]).

10380- Elevator error detected (code: [HEX]).

10390- Homing of the elevator failed (position: [0], home sensor: [0]).

Cause: There is a problem with the turbo pump temperature.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the turbo pump communication.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the elevator.

Action: Contact your Micromeritics service representative.

Cause A: There is a problem with the elevator.

Action A: Check the Dewar and remove ice if necessary. Then restart the 
analysis. Contact your Micromeritics service representative if 
necessary.

Cause B: The Psat tube is interfering with elevator movement.

Action B: Ensure the Psat tube is close to the sample tube and the Dewar lid is 
over both the sample and Psat tubes. Then restart the analysis. 
Contact your Micromeritics service representative if necessary.

Cause: There is a problem with the elevator.

Action: Contact your Micromeritics service representative.

Cause: There is a problem with the elevator.

Action: Contact your Micromeritics service representative.
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10410- Elevator communications error detected.

10420- [PORT] over-pressure detected (pressure: [PR4] [PR-U], max allowed: [PR4]).

10480- Operation cancelled by operator.

10490- Operation cancelled by instrument.

10500- Operation skipped by operator.

Cause: There is a problem with the elevator.

Action: Contact your Micromeritics service representative.

Cause A: A pressure greater than 1000 mmHg was detected in the instrument. 
The instrument has automatically canceled any operations in progress 
and taken action to relieve the pressure. 

Action A: If the instrument was being operated manually, review recent activity 
to identify the cause of the overpressure and avoid a repetition. If 
problem repeats, contact your Micromeritics service representative.

Cause B: If the error occurred when the Dewar was lowered, excessive 
adsorption of condensation of gas may have occurred during analysis 
and returned to gas phase too rapidly when the Dewar was lowered. 

Action B: Revise the analysis conditions or sample quantity to prevent 
recurrence. If problem repeats, contact your Micromeritics service 
representative.

Cause C: If the error occurred during dosing from a gas inlet, the gas inlet 
pressure might be excessive. 

Action C: Adjust the gas inlet pressure to recommended range. If problem 
repeats, contact your Micromeritics service representative.

Cause: The operator canceled the operation.

Action: None.

Cause: The instrument canceled the operation.

Action: An accompanying message will display explaining why the operation 
was canceled. Correct the indicated problem and restart the operation. 

Cause: The operator skipped the operation.

Action: None.
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10510- Operation suspended by operator.

10520- Operation suspended by instrument.

10530- Operation resumed by operator.

10560- Instrument communications error detected.

10710- Manifold temperature error detected (manifold: [DegC1] [DegC-U], port: 
[DegC1] [DegC-U], heater: [DegC1] [DegC-U], heater target: [DegC1] [DegC-U], 
power: [2]).

Cause: The operator suspended the operation.

Action: None. If you are on the analysis window, click the Play button to 
resume the operation.

Cause: The instrument suspended the operation.

Action: An accompanying message will display explaining why the operation 
was suspended. Correct the indicated problem. If you are on the 
analysis window, click the Play button to resume the operation.

Cause: The operator resumed the operation.

Action: None.

Cause: There was a fatal error in communication between the application and 
the software in the instrument. All displays for that instrument will be 
closed.

Action: Ensure that the analyzer is connected to the computer on the 
communications port configured in the Setup program. Stop and 
restart the analyzer software. Contact your Micromeritics service 
representative.

Cause: An error was detected during manifold temperature control.

Action: Ensure the cover to the upper cabinet of the instrument is securely 
fastened. If the source of the problem has been identified and 
corrected, close the application program, cycle power to the 
instrument off for a few seconds and then turn the power ON. Restart 
the application program. If the problem repeats or is not resolved, 
contact your Micromeritics service representative.
Dec 2012 B-39 



Appendix B 3Flex
10720- Manifold heater breaker open (manifold: [DegC1] [DegC-U], port: [DegC1] 
[DegC-U], heater: [DegC1] [DegC-U], heater target: [DegC1] [DegC-U], power: 
[2]).

10730- Mantle temperature error detected (type: [0], actual: [DegC1] [DegC-U], max 
allowed: [DegC1] [DegC-U], target: [DegC1] [DegC-U], power: [2]).

10740- Mantle breaker open (type: [0], actual: [DegC1] [DegC-U], target: [DegC1] 
[DegC-U], power: [2]).

10750- Time limit exceeded during evacuation (target: [PR4] [PR-U], pressure: [PR4] 
[PR-U], elapsed: [0] s).

The maximum time for evacuating the sample was exceeded. Possible 
causes are a leak in the sample tube fitting, a crack in the sample tube, 
or a poorly degassed sample.

Check the sample tube and the sample tube fitting; ensure that the tube 
is securely attached to the port. Verify that the sample is properly 
degassed; then restart the analysis.

10760- Time limit exceeded while dosing (gas: [GAS], valve: [0], target: [PR4] [PR-U], 
pressure: [PR4] [PR-U], elapsed: [0] s).

Set the gas regulator to 10 psig (0.7 bar). Then restart the analysis.

The gas bottle is empty.

Connect a new gas bottle. Then restart the analysis.

Cause: The circuit breaker to the manifold heater is open.

Action: Contact your Micromeritics service representative.

Cause: An error was detected with the mantle temperature.

Action: Contact your Micromeritics service representative.

Cause: The circuit breaker to the mantle is open.

Action: Contact your Micromeritics service representative.

Cause:

Action:

Cause A: The specified pressure was not attained. The gas regulator may be set 
too low or turned off.

Action A:

Cause B:

Action B:
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10770- Attempts to dose failed on sample port [0]. (qty required: [Q4] [Q-U], qty dosed: 
[Q4] [Q-U], sample pressure: [PR6] [PR-U], gas: [GAS]).

10780- Leak test failed (sample port: [0], interval: [0] s, leak rate: [PR4] [PR-U]/min, 
max allowed: [PR4] [PR-U]/min).

With the sample port valve closed, the sample pressure increased by 
0.15 mmHg before the leak test duration was completed.

10790- Quantity dosed on sample port [0] ([Q2] [Q-U]) has exceeded the maximum of 
[Q2] [Q-U] (qty dosed this point: [Q2] [Q-U], pressure: [PR4] [PR-U], [P0Sym]: 
[PR4] [PR-U], gas: [GAS]).

10801- P0-over-sample failed on sample port [0] (pressure: [PR4] [PR-U], last pres-
sure: [PR4] [PR-U], [P0Sym]: [PR4] [PR-U], rel pressure: [4], qty ads: [Q2] [Q-U], 
doses: [0]).

Cause: There was a problem dosing the sample to target pressure. The 
instrument was unable to dose the required quantity of gas after 
several attempts.

Action: Check that the outlet stage of the gas regulator is within specification. 
Review the analysis parameters.

Cause:

Action: Check sample tube fitting and ensure that it is securely attached to the 
port. Then restart the analysis.

Cause: An excessive quantity of gas has been dosed into the sample port due 
to an excessive quantity of a sample with high pore volume, 
condensation of gas due to a lower than expected saturation pressure, 
or a leak.

Action: Review the analysis conditions, the sample quantity, and the sample 
tube connection to identify and correct the problem before repeating 
the analysis.

Cause: Attempts to condense the adsorptive gas in the sample tube have 
failed due to an excessive quantity of a sample with high pore 
volume, adsorptive gas contamination, a higher than expected 
saturation pressure, or a leak.

Action: Review the analysis conditions, the sample quantity, the gas supply, 
and the sample tube connection to identify and correct the problem 
before repeating the analysis.
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10830- Warm free-space measurement failed on sample port [0] (qty in free-space: [Q2] 
[Q-U], qty in port: [Q2] [Q-U], pressure: [PR4] [PR-U], port vol: [V4] [V-U], port 
temp: [DegC1] [DegC-U]).

10840- Cold free-space measurement failed on sample port [0] (qty in free-space: [Q2] 
[Q-U], qty in port: [Q2] [Q-U], pressure: [PR4] [PR-U], port vol: [V4] [V-U], port 
temp: [DegC1] [DegC-U], warm free-space: [V4] [V-U]).

10850- Maximum target pressure exceeded in sample port [0] (target pressure: [PR4] 
[PR-U], [P0SYM]: [PR4] [PR-U], max instrument manifold pressure: [PR4] [PR-
U], gas: [GAS], max gas manifold pressure: [PR4] [PR-U], max transducer pres-
sure: [PR4] [PR-U]).

10860- Psat gas [GAS] is not condensing. (pressure: [PR4] [PR-U]  maximum manifold 
pressure: [PR4] [PR-U]).

10870- Adsorptive [GAS] is not condensing. (pressure: [PR4] [PR-U]  maximum mani-
fold pressure: [PR4] [PR-U]).

Cause: There is a problem with the warm free-space measurement on the 
sample port.

Action: Verify that no problem exists with the sample tube or gas connection.

Cause: There is a problem with the cold free-space measurement on the 
sample port.

Action: Verify there is no problem with the sample tube or analysis bath.

Cause: A target pressure was requested that exceeds the maximum allowed. 
The maximum pressure may be based on saturation pressure of the 
gas at the temperature of the gas source, the manifold, the sample, or 
ambient temperature. 

Action: Review the maximum allowable pressures in the error message and 
the analysis conditions to identify and correct the problem before 
repeating the analysis.

Cause: The Psat gas is not condensing.

Action: Review the analysis parameters, gas connections, and analysis bath.

Cause: The adsorptive gas is not condensing.

Action: Review the analysis parameters, gas connections, and analysis bath.
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10880- Zeroing of the transducers failed.

10890- Purification of the adsorptive [GAS] failed at [PR4] [PR-U] (charge pressure: 
[PR4] [PR-U], minimum allowed: [PR4] [PR-U]).

10902- Sample pressure on sample port [0] ([PR4] [PR-U]) is below the minimum 
desorption pressure ([PR4] [PR-U]).

10950- Power supply voltage error detected (type: [0], voltage: [2] volts, nominal: [1] 
volts).

11002- Manifold heater temperature error (measurements: [0], mean: [3], std dev: [3], 
min: [3], max: [3], since: [DATE]).

Cause: The transducers failed to zero out.

Action: Contact your Micromeritics service representative.

Cause: The adsorptive gas failed to purify at the specified pressure.

Action: Check the gas connection.

Cause: A target pressure for desorption was requested that is below the 
minimum desorption pressure allowed.

Action: Review the analysis conditions to remove the disallowed pressure.

Cause: There is a problem with the power supply voltage.

Action: Contact your Micromeritics service representative.

Cause: An error was detected with the manifold heater temperature.

Action: Check the top cover of the instrument. Ensure it is installed and 
sealed properly.
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C.  CALCULATIONS

This appendix contains the calculations used in the analysis program. 

Saturation Pressure

Saturation pressure (Po) is selected on the Po and Temperature Options window. It may be entered 
or measured in the Po tube. The uses the following methods to get Po: 

1. Po is measured in the Po tube for each isotherm point.

2. The saturation pressure is measured in the sample tube after all adsorption data points have been 
collected.  This pressure is used as Po for all data points.

3. Po is measured for all points as with #1.  After all adsorption points have been taken Po is 
measured in the sample tube.  The measured Po points are shifted so that the Po measured in the 
Po tube matches the Po measured in the sample tube.  That is, Po(i) = Po(i) + Pos - Pon where Pon 
is the Po measured in the Po tube when Po in the sample tube (Pos) was measured.

4. Determine Po from pressure measured over the dosing source. Note that the Adsorptive 
Properties must specify dosing from Psat tube, Sample port 3, or Vapor source.

5. The saturation pressure of a gas is measured in the Po tube for each data point.  The bath 
temperature is found by looking up the temperature for the measured saturation pressure in the 
fluid properties.  Po of the analysis gas is found from the bath temperature as in #6.  If dosing is 
done from the Psat tube, Po is determined once at the beginning of the analysis and used for all 
data points.  Otherwise, Po is measured for each data point.

6. Po is found by looking up the saturation pressure for the entered bath temperature in the fluid 
property information.

Lookup of saturation pressure in the fluid properties is done by interpolating the Psat data using 

the Clausius-Clapeyron equation, .  The constants a and b are determined from 

the pressures and temperatures that bound the bath temperature.  Temperature lookup is done by 

solving for T,    , where a and b are determined from the pressures that bound the 

given saturation pressure.

7. If entered, Po = user-entered value.

P ln a
T
--- b+=

T a
P  b–ln

------------------------=
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Relative Pressure Calculations

If Po is measured in the Po tube, the current pressure is measured in the Po tube when each point is 
taken, and used to calculate relative pressure for that point:

Equation of State

The ideal gas law relates pressure, volume, temperature, and quantity of gas

where

P = pressure
R = a constant that depends on the units of n

For n in cm3, STP 

For n in moles, R = 8.3145 J mol-1 K-1

T = temperature
V = volume
z = compressibility factor for the gas at the given pressure and temperature

The real gas equation of state

Prel
P

Po
-------=

R
PSTD

TSTD
------------=

n PV
RTz P T 
-------------------------=
C-2                                                    Dec 2012



3Flex Appendix C
Quantity Adsorbed Calculations

For the ith dose, the quantity dosed is

The pressure, volume, and temperature are those of the dosing manifold before and after expanding 
into the sample tube.

The quantity of gas in the free space is

with the real gas equation of state. Here, Ps is the sample pressure.

where:

Tamb = approximate room temperature (298 K)
Tbath = analysis bath temperature (K) 

Vfc = volume of free space, cold (cm3 at standard temperature)

Vfw = volume of free space, warm (cm3 at standard temperature)

The specific quantity adsorbed is

where m is the sample mass.

n i dosed i ndosed i 1– n P1 Vm T1   n P2 Vm T2  –+=

nads i ndosed i nfs i–=

nfs i
Ps i

TSTD
------------ 

Vfc

z Ps i Tbath 
-------------------------------

Vfw

z Ps i Tamb 
-------------------------------+ 

 =

Qads i
nads i

m
-------------=
Dec 2012 C-3 



Appendix C 3Flex
Free Space

Measured

Measured free-space volumes are calculated using the following equations:

where:

P1 = system manifold pressure before dosing helium onto sample
P2 = system manifold pressure after dosing helium onto sample
P3 = sample pressure after raising Dewar and equilibrating with helium
Tamb = approximate room temperature (298 K)
Tbath = analysis bath temperature (K) 
Tman = system manifold temperature before dosing helium onto sample (K)
TSTD = standard temperature (273.15 K)
Vbath = portion of cold free space at analysis bath temperature

Vfc = volume of free space, cold (cm3 at standard temperature)

Vfw = volume of free space, warm (cm3 at standard temperature)

Vman = manifold volume (cm3)

Vfw

Vman

Tman
------------

P1

P2
------ 1– 
 TSTD=

Vfc Vfw

P2

P3
------ 
 =

Vbath

Vfc Vfw–

1
Tbath

Tamb
------------–

----------------------=
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Calculated

The calculated free space is determined by subtracting the gas capacity of the volume occupied by the 
sample from the measured free space of the empty tube.

where

Tamb = approximate room temperature (298 K)
Tbath = analysis bath temperature (K) 
TSTD = standard temperature (273.15 K)
Vcb = cold free space of the empty tube
Vfc = calculated cold free space
Vfw = calculated warm free space
Vs = sample mass/density
Vwb = warm free space of the empty tube

Vfw Vwb Vs  
TSTD

Tamb
------------ 

 –=

Vfc Vcb Vs  
TSTD

Tbath
------------ 

 –=
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Equilibration

Equilibration is reached when the pressure change per equilibration time interval (first derivative) is 
less than 0.01% of the average pressure during the interval. Both the first derivative and average pres-
sure are calculated using the Savitzky-Golay1 convolution method for polynomial functions. The 
following equations are those used to compute weighted average and first derivative, respectively, for 
the 6th point of an 11-point window.

pressure change per equilibration time interval

where the numerical constants are from the Savitzky-Golay convolution arrays, and

Pavg = average pressure
Pchg = change in pressure
Ppcp,i = percent change per interval

Pi = ith pressure reading taken at equilibrium intervals

   

Pavg
36 P11 P1+ – 9 P10 P2+  44 P9 P3+  69 P8 P4+  84 P7 P5+  89 P6 + + + + +

429
------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

Pchg

5 P11 P1–  4 P10 P2–  3 P9 P3–  2 P8 P4–  P7 P5– + + + +

110
---------------------------------------------------------------------------------------------------------------------------------------------------------------=

Ppcp i 100% 
Pchg

Pavg
----------=

If a non-zero value that is too small is entered for the maximum equilibration time, the 
points are collected before equilibration is reached. 

 If Pavg is greater than 0.995 times the current Po, equilibration will not take place until 
the Minimum equilibration delay for P/Po 0.995  has expired, in addition to the standard 
equilibration criteria.
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Thermal Transpiration Correction 

During data reduction, thermal transpiration correction is applied to the data if the user selected Apply 
thermal transpiration correction from the Report Options window. Starting with the first collected 
pressure, the following calculations are performed until the pressure ratio (PC/P) is greater than or 
equal to 0.99. 

where:

 = Weber’s coefficient, 0.033
 = Weber’s coefficient, 0.245
F,Y, = intermediate values for subsequent calculations
G = Weber’s coefficient, 2.5
H = Weber’s coefficient, 2 
MD = thermal transpiration hard sphere diameter of gas (Å), from the Adsorptive 

Properties window 
P = equilibrated collected pressure measured by gauge at temp Tamb

SD = inside diameter of sample tube (mm), from the Report Options window 

T = average temperature 

Tamb = room temperature (298 K) 
Tbath = analysis bath temperature (K), from the Po and Temperature Options 

window 

Y
P SD MD

2
2.33 T

------------------------------------ 
  10

3
=

 1 G Y+
1 H Y+

-----------------------=

F 1

Y
2 Y + +

---------------------------------=

P 1 F 1
Tbath

Tamb
------------





–




–
 
 
 

=

Tbath T+
2

--------------------
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BET Surface Area

For each point designated for surface area calculations, the BET2 transformation is calculated as:

A least-squares fit is performed on the (Prel, B) designated pairs where Prel is the independent variable 
and B is the dependent variable. The following are calculated:

a.) Slope (S g/cm3 STP)

b.) Y-intercept (Yint g/cm3 STP)

c.) Error of the slope (Serr g/cm3 STP)

d.) Error of the y-intercept (YIerr g/cm3 STP)

e.) Correlation coefficient 

Using the results of the above calculations, the following can be calculated 

BET Surface Area (m2/g):

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties window 

BET C value:

Quality of the Monolayer (cm3/g STP):

1

Nads

Po

P
------ 1– 
 

--------------------------------

SAbet
CSA NA

22414 cm
3

 STP  10
18

 nm
2

m
2

-----------------------
 
 
 

S Yint+ 

-------------------------------------------------------------------------------------------------=

C
S Yint+

Yint
------------------=

Qm
1

CYint
------------- 1

S Yint+
------------------= =
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Error of the BET Surface Area (m2/g):

Langmuir Surface Area

For each point designated for surface area calculations, the Langmuir3 transformation is calculated as:

where L is in units of g/cm3 STP.

A least-squares fit is performed on the (Prel, L) designated pairs where Prel is the independent variable 
and L is the dependent variable. The following are calculated:

a.) Slope (S g/cm3 STP)

b.) Y-intercept (Yint g/cm3 STP)

c.) Error of the slope (Serr g/cm3 STP)

d.) Error of the y-intercept (YIerr g/cm3 STP)

e.) Correlation coefficient 

Using the results of the above calculations, the following can be calculated:

Langmuir Surface Area (m2/g):

where

CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 
Adsorptive Properties window   

BETerr

SAbet Serr 
2

YIerr 
2

+ 
0.5

Yint S+
-----------------------------------------------------------=

L
Prel

Nads
----------=

SALan

CSA NA

22414 cm
3

 STP  10
18

 nm
2

m
2

-----------------------
 
 
 

S

-----------------------------------------------------------------------------=
Dec 2012 C-9 



Appendix C 3Flex
Quantity of the Monolayer (cm3/g STP):

Langmuir b Value:

 

Error of the Langmuir Surface Area (m2/g):

Freundlich Isotherm

The Freundlich isotherm has the form

where 

C = temperature-dependent constant
m = temperature-dependent constant
P = equilibrated collected pressure measured by gauge at temp Tamb

Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer

The pressure is absolute; typically, m > 1. In terms of quantity adsorbed,

Taking the log of both sides yields

Qm
1
S
---=

b Yint Vm=

LANerr

SALanSerr

S
-----------------------=

Q
Qm
-------- CP

1
m
----

=

Q QmCP

1
m
----

=

Qlog  Qm C
1
m
----  Plog+log=
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Temkin Isotherm

The Temkin isotherm has the form

where

A = a0 exp , where 0 and A0 are adjustable constants

P = equilibrium pressure measured by gauge at temp Tamb

q0 = the differential heat of adsorption at zero surface coverage
Q = quantity of gas adsorbed
Qm = quantity of gas in a monolayer

R = molar gas constant 

T = bath temperature (K)

In terms of quantity adsorbed

Thus, the plot of the natural log of absolute pressure vs. quantity adsorbed yields a straight line with 

slope  and intercept .

Q
Qm
--------

RT
q0
--------- A0P ln=

q0–

RT
--------

 
 
 

8.31441 10
3– kJ
molK
--------------

Q
RTQS

q0
-------------- A0  

P
P0
------ 
 ln+ln=

RTQm

q0
--------------- A

RTQm

q0a
---------------ln
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t-Plot

A least-squares analysis fit is performed on the (ti, Nads,i) data pairs where ti is the independent variable 
and Nads,i is the dependent variable. Only the values of ti between tmin and tmax, the minimum and max-
imum thickness, are used. The following are calculated:

a.) Slope (S cm3/g-Å STP)

b.) Y-intercept (Yint cm3/g STP)

c.) Error of the slope (Serr cm3/g-Å STP)

d.) Error of the Y-intercept (YIerr cm3/g STP)

e.) Correlation coefficient 

Using the results of the above calculations, the following can be calculated:

External Surface Area (m2/g):

where

104 = unit conversions
F = surface area correction factor, user-entered on the t-Plot Report Options 

window 
Vmol = liquid molar volume, from the fluid property information

Micropore Surface Area (m2/g):

where SAtotal is the BET surface area if the user enabled the BET report exclusively, or Langmuir sur-
face area if the user enabled the Langmuir report exclusively. If neither report has been selected, SAtotal 
is the BET surface area value calculated using a set of default parameters.

Micropore Volume (cm3 liquid/g):

SVmol

F 22414cm
3STP

--------------------------------------------- 10
4

SAp SAtotal SAext+=

YintVmol

22414cm
3 STP

------------------------------------
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Alpha-S Method

The alpha-S curve is calculated from the reference isotherm by dividing each quantity adsorbed by the 
quantity adsorbed at 0.4 relative pressure.

where Q0.4 is found by linear interpolation. 

A least-squares analysis fit is performed on the (αi,Qads,i) data pairs where αi is the independent vari-
able and Qads,i is the dependent variable. The following are calculated: 

a.) Slope (S cm³/g STP) 

b.) Y-intercept (Q0 cm³/g STP) 

c.) Error of the slope (cm³/g STP) 

d.) Error of the Y-intercept (cm³/g STP) 

e.) Correlation coefficient 

Surface area  is calculated as:

Pore size is calculated as:

where Vmol is liquid molar volume from the fluid property information.

ai
Qi

Q0.4
----------=

A
Aref S

Q0.4
-------------=

Q0Vmol

22414cm
3

STP
-------------------------------------
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f-Ratio Method

The f-ratio is the quantity adsorbed divided by the quantity adsorbed in a reference isotherm at the 
same pressure. 

The reference quantity adsorbed is found by spline interpolation of the reference isotherm. 

BJH Pore Volume and Area Distribution

For adsorption data, the relative pressure and quantity adsorbed data point pairs collected during an 
analysis must be arranged in reverse order from which the points were collected during analysis. All 
calculations are performed based on a desorption model, regardless of whether adsorption or desorp-
tion data are being used.

The data used in these calculations must be in order of strictly decreasing numerical value. Points 
which do not meet this criterion are omitted. The remaining data set is composed of relative pressure 
(P), quantity adsorbed (Q) pairs from (P1, Q1) to (P, Qn) where (Pn = 0, Qn = 0) is assumed as a final 
point. Each data pair represents an interval boundary (or desorption step boundary) for intervals i=1 to 
i=n-1 where n = total number of (P, Q) pairs.

Generally, the desorption branch of an isotherm is used to relate the amount of adsorbate lost in a 
desorption step to the average size of pores emptied in the step. A pore loses its condensed liquid 
adsorbate, known as the core of the pore, at a particular relative pressure related to the core radius by 
the Kelvin7 equation. After the core has evaporated, a layer of adsorbate remains on the wall of the 
pore. The thickness of this layer is calculated for a particular relative pressure from the thickness equa-
tion. This layer becomes thinner with successive decreases in pressure, so that the measured quantity 
of gas desorbed in a step is composed of a quantity equivalent to the liquid cores evaporated in that 
step plus the quantity desorbed from the pore walls of pores whose cores have been evaporated in that 
and previous steps. Barrett, Joyner, and Halenda8 developed the method (known as the BJH method) 
which incorporates these ideas. The algorithm used is an implementation of the BJH method.

fi
Qi

Qref Pi
-----------------=
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Explanation of Terms

A pore filled with condensed liquid nitrogen has three zones:

a.) The core - evaporates all at once when the critical pressure for that radius is reached; the 
relationship between the core radius and the critical pressure is defined by the Kelvin 
equation.

b.) The adsorbed layer - composed of adsorbed gas that is stripped off a bit at a time with each 
pressure step; the relationship between the thickness of the layer and the relative pressure is 
defined by the thickness equation.

c.) The walls of the cylindrical pore - the diameter of the empty pore is required to determine 
the pore volume and pore area. End area is neglected.

Pore

Insignificant 
compared to 
core length

Wall
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Calculations

The quantities adsorbed (Qa) are converted to the liquid equivalent volumes (Vl, cm3/g):

where Vmol is the liquid molar volume from the fluid property information.

The relative pressure (Pi) is assumed to be close to unity so that substantially all the pores in the sam-
ple are filled.

The corresponding Kelvin core radius is calculated. Only pores smaller than this size will be included:

where

A = adsorbate property factor (from the BJH Adsorptive Options window)
F = fraction of pores open at both ends (from the BJH Adsorption Report 

Options window or the BJH Desorption Report Options window); assumed 
to be zero for desorption

Rc = Kelvin radius (Å) of core

This radius will be adjusted for the thickness of the adsorbed layer during subsequent calculation steps.

The following calculations (a-c) are made for each relative pressure interval based on the increment of 
volume desorbed during that interval:

where

i = interval number, that is i=1 for the first interval from P1 to P2, and so on
j = each previous interval during which new pores were found
k = the total number of intervals in which new pores have been found. It is also 

the number of lines reported on the BJH table for collected data

Vli
QiVmol

22414cm
3

STP
-------------------------------------=

Rci
A–

1 F+  Pi ln
---------------------------------=
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a.) The thickness of the adsorbed layer at the end of the interval is calculated using the equation 
located in Thickness Curve Calculations, page C-44.

For the last pressure interval from the lowest Pri to zero relative pressure, reference the calcu-
lations from the equations in Thickness Curve Calculations, page C-44.

For the first pressure interval, there are no previously opened pores so the volume of liquid 
desorbed from walls of previously opened pores is zero (Vd1 = 0), and the remainder of Step 
(a) is skipped.

The change in thickness of the wall layer due to desorption from previously opened pores is 
calculated as:

The annular cross-sectional area of the wall layer desorbed is calculated for all previously 
opened pores:

The total volume of gas desorbed from walls of previously opened pores is calculated:

for all previously opened pores

where LPj = length of previously opened pores as calculated in Step b(2).

Tw Tw1 Twi 1+–=

CSAj  Rcj Tw+ 2
Rcj

2
–  10

16–
 cm

2

Å
2

----------
 
 
 

=

Vdi LPj 

j
 CSAaj =
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b.) The physical processes occurring for this pressure interval are determined as:

(1.) If Vdi is greater than the current increment of volume desorbed (Vli - Vli+1), desorption 
from walls only is occurring. Total surface of walls exposed thus far (cm2/g) is calcu-
lated as:

 for all previously opened pores

where

Davg,j =  weighted average pore diameter calculated in Step b(2).

A new layer thickness (Tw) that will not overcompensate for the actual volume 
desorbed in this interval is calculated:

Since no cores are evaporated in this pressure interval, no new pores are revealed. 
Thus no ending Kelvin radius and average pore diameter are calculated for this inter-
val. Note that this means the report may have fewer tabulated intervals on the 
collected data report than experimental pressure intervals.

(2.) If Vdi is less than the volume increment desorbed during this interval , 
the remaining volume is due to new pores with core evaporation taking place in this 
interval. K, the number of intervals with new pores exposed, is increased by 1. (For the 
interval from the lowest Pr1 to zero relative pressure, no new pore volume is calculated 
and the rest of Step b is skipped.)

The volume desorbed from newly opened pores in this interval is calculated as:

The Kelvin radius for the end of the interval is calculated as:

SAw  LPj  Davg j,  10
8–
 cm

Å
-------------------- 
 

j
=

Tw
Vli Vli 1+–  10

8
 

Å
cm
------- 

 

SAwi
--------------------------------------------------------=

Vli Vll 1+– 

Vci VIi VIi 1+–  Vdi–=

Rck 1+
A–

1 F+  Pi 1+ ln
----------------------------------------=
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All new pores opened in this interval are represented by one pore having a length-
weighted average pore diameter and a corresponding length sufficient to account for 
the required volume of adsorbate. The weighted average pore diameter is calculated 
as:

Davg,k is the diameter of a pore which would have a surface area that is the average of 
the areas for pores radius Rck and Rck+1, if its length was the mean of the lengths at 
those radii. 

The relative pressure corresponding to Davg,k is calculated as:

The thickness of the adsorbed layer at this pressure is calculated as:

The decrease in thickness of the wall layer by desorption from the walls of new pores 
during the lower portion of the pressure interval is calculated as:

The cross-sectional area of the newly opened pores is calculated as:

The length of the newly opened pores is calculated as:

Davg k
2 Rck Rck 1++  Rck  Rck 1+ 

Rck 
2

Rck 1+  
2

+
---------------------------------------------------------------------------=

Pavg k  
1– 2A–

1 F+  Davg k 
---------------------------------------ln=

Twavg k HP1
HP2
Pavg k ln

-------------------------
HP3

=

Td Twavg k Twi 1+–=

CSAck
Davg k

2
---------------- Td+

2 10
16–

 cm
2

Å
2

-------------------------
 
 
 

=

LPk
Vci

CSAck
----------------=
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Pore diameters and radii are adjusted for the change in thickness of the adsorbed wall 
layer during this interval. If new pores were opened during this interval, the average 
diameter is adjusted by the change in layer thickness during the second portion of the 
desorption interval as:

The layer thickness change during the whole interval is added to diameters of previ-
ously opened pores as:

(not including) Davg,k)

The layer thickness change desorbed during this interval also is added to the radii cor-
responding to the ends of the pressure intervals as:

for all except Rck+1.

Steps a to c are repeated for each pressure interval.

After the above calculations have been performed, the diameters corresponding to the 
ends of the intervals are calculated as:

for all Rcj including Rck+1.

The remaining calculations are based on Dpi, Davg,i, and LPi. These calculations are 
only done for Davg,i values that fall between the Minimum BJH diameter and the Max-
imum BJH diameter specified by the operator on the BJH Adsorption Report 
Options window or the BJH Desorption Report Options window.

(1.) Incremental Pore Volume (Vpi, cm3/g):

(2.) Cumulative Pore Volume (Vpcum,i, cm3/g):

Davg k new  Davg k old  2 Td +=

Davg k new  Davg k old  2 Tdw +=

Rcj new Rcj old Tw+=

Dpj 2 Rcj =

Vpi  Lpi 
Davg i

2
---------------

2 10
16

cm
2

Å
2

---------------------=

VPcum i Vpj for J 1 
j
=
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(3.) Incremental Surface Area (SAi, m2/g):

(4.) Cumulative Surface Area (SAcum,i, m2/g):

(5.) dV/dD pore volume (dV/dDi, cm3/g-A):

(6.) dV/dlog(D) pore volume (dV/dlog(D)i, cm3g):

(7.) dA/dD pore area (dA/dDi, m2/g-A):

(8.) dA/dlog(D) pore area [dA/dlog(D)i, m2/g]:

SAi  LPi   
10

2–
m

cm
--------------- 

  Davg i   
10

10–
m

Å
------------------ 

 =

SAcum 10 SAj for J 1=

dV
dDi
---------

VPi

Dpi Dpi 1+–
-------------------------------=

dDv
d Dilog
-----------------

VPi

Dpi

Dpi 1+
---------------- 
 log

------------------------------=

dA
dDi
---------

SAi

Dpi Dpi 1+–
-------------------------------=

dA
d Dilog
-----------------

SAi

Dpi

Dpi 1+
---------------- 
 log

------------------------------=
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For fixed pore size tables (if selected), the following calculations are performed:

(1.) Average Fixed Pore Size (DFavg,j, A):

calculated for all intervals in the fixed pore size table.

For the intervals with  between the Minimum BJH diameter and the Maximum BJH 
diameter.

(2.) Cumulative Pore volume (VpFcum,i, cm3/g):

where INTERP(x) is the value interpolated from the function X = Dpj+i and 
Y = VPcum,i, using an AKIMA semi-spline interpolation.

(3.) Incremental Pore Volume (VpFi, cm3/g):

where VpFcum,0 = 0.

(4.) Cumulative Surface Area (SAFcum,i, m2/g):

where INTERP(x) is the value interpolated from the function X = Dpj+i and 
Y = SAcum,j.

(5.) Incremental Surface Area (SAFi, m2/g):

where SAFcum,0 = 0.

DFavg j

DpFj
DpFj 1+

+

2
------------------------------------=

VpFcum i INTERP DpFi 1+ =

VpFi VpFcum i VpFcumi 1–
–=

SAFcum i INTERP DpFi 1+ =

SAFi SAFcum i SAFcumi 1–
–=
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(6.) dV/dD pore volume (dV/dDpFi, cm3/g-A):

where INTERP(x) is the value interpolated from the function X = Davg,j and 
Y = dV/dDj.

(7.) dV/dlog(D) pore volume [dV/dlog(DpFi), cm3/g]:

where INTERP(x) is the value interpolated from the function X = Davg,j and 
Y = dV/dlog(D)j.

(8.) dA/dD pore area (dA/dDpFi, m2/g-A):

where INTERP(x) is the value interpolated from the function X = Davg,j and 
Y = dA/dDj.

(9.) dA/dlog(D) pore area [dA/dlog(DpFi), m2/g]:

where INTERP(x) is the value interpolated from the function X = Davg,j and 
Y = dA/dlog(D)j.

dV
dDpFi
---------------- INTERP DpFi 1+ =

dV
d D pFi log
------------------------------ INTERP DpFi 1+ =

dA
dDpFi
---------------- INTERP DpFi 1+ =

dA
d Dlog pFi 
------------------------------ INTERP DpFi 1+ =
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Compendium of Variables

Td = thickness of layer desorbed from walls of newly opened pores (Å)
Tw = thickness of adsorbed layer desorbed during interval (Å)
A = adsorbate property factor; from the BJH Adsorptive Options window 
CSA = analysis gas molecular cross-sectional area (nm2), user-entered on the 

Adsorptive Properties window 
CSAa = annular cross-sectional area of the desorbed layer (cm2)
CSAc = cross-sectional area of opening of newly opened pores (cm2)
Davg = average pore diameter (Å)
Dp = pore (or core) diameter (Å)
F = fraction of pores open at both ends; from the BJH Adsorption Report 

Options window or the BJH Desorption Report Options window 
LP = length of pore (cm/g)
P = relative pressure
Q = quantity adsorbed expressed as a volume (cm3/g STP)
Rc = Kelvin radius (Å) of core
SAw = total surface area of walls exposed (cm2/g)
Tw = thickness of remaining adsorbed wall (Å)
Vc = volume desorbed from cores of newly opened pores (cm3/g)
Vd = volume of gas desorbed from walls of previously opened pores (cm3/g)
Vl = liquid equivalent volume of volume adsorbed (cm3/g)
Vmol = liquid molar volume, from the fluid property information
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Dollimore-Heal Adsorption

The calculations for the Dollimore-Heal reports are the same as those for BJH, except for the calcula-
tion of average pore diameter and pore length. 

Pore Diameter

Pore diameter is determined from the Kelvin radius and thickness equation:

The average pore diameter is the arithmetic mean of the diameters that bound the interval. 

Pore Length 

Di 2rk Pi  t Pi +=

Di

Di Di 1++

2
------------------------- 
 =

li

Ap i 10+

Di

----------------------
8

=

Ap i
4 10

8
Vp 
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--------------------------------=

Vp C D Qi 1– Qi – t 10
8 Ap cum 2 t li cum ––=

C
Di

2 r k t Pi + t Pi 1+  –
------------------------------------------------------------- 
 

2

=

t
Di

2 rk–
-------------=

rk
rk i rk i 1++ 

2
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where

ΔVp = Change in pore volume 
Ap,i =  Pore surface area 
Ap,i,cum, li,cum =  Summations over the lengths and areas calculated so far 
Cv = Volume correction factor 
D =  Density conversion factor

= Average Kelvin radius

= Average thickness

Horvath-Kawazoe

A relative pressure lower limit is determined such that L-d0 never equals zero. All pressure points less 
than this limit are discarded. For each collected relative pressure point, values of L are chosen in an 
iterative manner, and the relative pressure (P/Po) determined by solving one of the following 
equations:

• Slit Pore Geometry (original Horvath-Kawazoe)
• Cylinder Pore Geometry (Saito/Foley)
• Sphere Pore Geometry (Cheng/Yang) 

Slit Pore Geometry (original HK)

When you use the original Horvath-Kawazoe9 method, the following equation is solved for each value 
of P. The value of L is determined when the solved-for relative pressure is within 0.1% of the collected 
absolute pressure.

where

1032 = the number of cm4 that are equal to Å4

 = gas solid nuclear separation at zero interaction energy (Å), 

d0 =

where:

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical Proper-
ties window

Ds = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 
Properties window

r k

t

P
Po
-------ln

K
RT
------- IP 10

32
 

4
L 2d0–

------------------------ 4

3L d0–
3

-------------------- 10

9L d0–
9

--------------------– 4

3d0 
3

----------– 10

9d0
 9

----------+=

ZS ZA+

2
-------------------

DA Ds+

2
--------------------
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IP = interaction parameter (erg-cm4) from the Horvath-Kawazoe Report Options 
window 

K = Avogadro Constant (NA)
L = pore width (nucleus to nucleus) (Å)
P = equilibrium pressure
Po = saturation pressure 
R = gas constant (8.31441 × 107 erg/mol K)
T = analysis bath temperature (K), from an entered or calculated value on the Po 

and Temperature Options window 
where:

ZS = sample equilibrium diameter at zero interaction energy (Å) from the 
Horvath-Kawazoe Physical Properties window

ZA = zero interaction energy diameter from the Horvath-Kawazoe Physical 
Properties window

Cylinder Pore Geometry (Saito/Foley)

When you use the Saito-Foley10 method, the following equation is solved for each value of P. The 
value of L is determined when the solved-for relative pressure is within 0.1% of the collected absolute 
pressure.

where

1032 = the number of cm4 that are equal to Å4

k =

k =

d0 =

where:

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical Proper-
ties window

DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 
Properties window

IP = interaction parameter (10-43 erg-cm4) from the Horvath-Kawazoe Report 
Options window 

K = Avogadro Constant (NA)
L = pore width (nucleus to nucleus) (Å)

P
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------- 
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3
4
---K
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------- IP 1032 

d0 4
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------------ 1
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---- 
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P = equilibrium pressure
Po = saturation pressure
R = gas constant (8.31441 × 107 erg/mol K)

rp = radius of the cylindrical pore, 

T = analysis bath temperature (K), from an entered or calculated value on the Po 
and Temperature Options window 

Sphere Pore Geometry (Cheng/Yang)

When you use the Cheng/Yang11 method, the following equation is solved for each value of P. The 
value of L is determined when the solved-for relative pressure is within 0.1% of the collected absolute 
pressure.

where

1032 = the number of cm4 that are equal to Å4

*12 = , where  

*22 = , where  

d0 =

where:

DA = molecular diameter (Å) from the Horvath-Kawazoe Physical Properties 
window

DS = diameter of sample atom (Å) from the Horvath-Kawazoe Physical 
Properties window

L = pore width (nucleus to nucleus) (Å)
N1 = 4 L2 NS, where NS = number of sample atoms/cm2 at monolayer

N2 = 4 (L - d0)2 NA, where NS = number of gas molecules/cm2 

P = equilibrium pressure
Po = saturation pressure
R = gas constant (8.31441 × 107 erg/mol K)
T = analysis bath temperature (K), from an entered or calculated value on the Po 

and Temperature Options window 

L
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T1 =

T2 =

T3 =

T4 =

where    

Cheng/Yang Correction

This factor corrects for the nonlinearity of the isotherm. It adds an additional term to the equations for 
the different geometrics:

where

G(L) = one of the Horvath-Kawazoe equations given above
 = degree of void filling;  is estimated by first computing the monolayer capac-

ity (Qm) with the Langmuir equation over the range of data points from 
relative pressure 0.02 to 0.2 or the maximum relative pressure included in the 
Horvath-Kawazoe analysis.  is computed as the quantity adsorbed over Qm.
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Interaction Parameter

The interaction parameter (IP) results from the following calculations:

The Kirkwood-Muller dispersion coefficients

where

A = polarizability of gas molecule (cm3)

S = polarizability of sample atoms (cm3)

mc2 = kinetic energy of electron (0.8183 × 10-6 erg)
A = diamagnetic susceptibility of gas molecule (cm3)

where:

NA = number of gas molecules/cm2 at monolayer from the Horvath-Kawa-
zoe Physical Properties window 

NS = number of sample atoms/cm2 from the Horvath-Kawazoe Physical 
Properties window 

S = diamagnetic susceptibility of sample atom (cm3)

Refer to Interaction Parameter Components, page C-32 for recommended values.

AS
6mc

2
aSaA

S

S
------

A

A
-------+

--------------------------=

AA
3mc

2AA

2
---------------------------=

IP NAAA  NSAS +=
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Additional Calculations

Based on the previous calculations, the following can be calculated:

Adjusted Pore Width (Å):
         (Shell to Shell)

Cumulative Pore Volume (cm3/g):

 

where 

Vmol = liquid molar volume from the fluid property information 

dV/dD Pore Volume (cm3/g-Å): 

 

Median Pore Width (Å):

 where

Dl = pore width (Li) that corresponds to Vl 
Dg = pore width (Li) that corresponds to Vg

Vcum,n = total cumulative pore volume (Vcum,i) for points designated for Horvath-
Kawazoe calculations

Vg = cumulative pore volume (Vcum,i) for first point greater than Vhalf

Vhalf = 50% of total cumulative pore volume 
Vl = cumulative pore volume (Vcum,i) for first point less than Vhalf

ALi Li Ds–=

Vcum i
QiVmol

22414cm
3
STP

-------------------------------------=

dV
dDi
---------

Vcum i Vcum i 1––

ALi ALi 1––
-----------------------------------------=

Vhalf
Vcum n

2
----------------=

Dmed 10 Dl log Vhalf  Vl log–log 
Dg  Dl log–log

Vg  Vl log–log
--------------------------------------------+=
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Interaction Parameter Components

Table C-1. Interaction Parameters

Gas Bath 
Temperature

(K)

Sample Type

Interaction 
Parameter 
Calculated 

Value*

Argon  87.3 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)

Zeolite

2.61

5.89

3.19

Carbon 
Dioxide

298.15 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)

Zeolite

4.20

9.20

5.08

273.15 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)

Zeolite

4.34

9.35

5.22

194.65 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)

Zeolite

4.72

9.72

5.60

Nitrogen  77.15 Carbon (Ross/Olivier value)

Carbon (Horvath/Kawazoe value)

Zeolite

2.84

6.53

3.49

* The interaction parameter is entered in the Horvath-Kawazoe Report Options window in the 
following field:

Interaction parameter: (calculated value) × 10-43 erg-cm4
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The following values were used to calculate the values in Table C-1.

DA values are from van der Waal’s constant.
NA values are from liquid densities.
 and  values are derived from data found in Ross and Olivier12.

The physical parameters referenced in Saito/Foley are:

Carbon-Graphite Zeolite

DS = 3.40 DS = 3.04

NS = 3.845 × 1015 NS = 3.75 × 1015

S = 1.05 × 10-29  (Ross/Olivier) S = 1.94 × 10-29

13.5 × 10-29  (Horvath/Kawazoe, implicit) S = 0.85 × 10-24

S = 1.02 × 10-24

Nitrogen Argon

DA = 3.00 DA = 2.95

A = 6.71 × 1014 A = 7.608 × 1014

A = 3.6 × 10-29 A = 3.22 × 10-29

A = 1.76 × 10-24 A = 1.63 × 10-24

Carbon Dioxide

DA = 3.23

NA = 4.567 × 1014 (25 ºC)

5.45 × 1014 (0 ºC)

7.697 × 1014 (-78 ºC)

A = 5.0 × 10-29

A = 2.7 × 10-24

Aluminophosphate Aluminosilicate

DS = 2.60 DS = 2.76

NS = 1.48 × 1015 Ns = 1.31 × 1015

S = 1.3 × 10-29 S = 1.3 × 10-29

S = 2.5 × 10-24 S = 2.5 × 10-24
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DFT (Density Functional Theory)

The adsorption isotherm is known to convey a great deal of information about the energetic heteroge-
neity and geometric topology of the sample under study. The data of physical adsorption have been 
used for many years as the basis for methods to characterize the surface area and porosity of adsor-
bents. Real solid surfaces rarely approach ideal uniformity of structure. It is accepted that in general, 
the surface of even a nonporous material presents areas of greater or lesser attraction for adsorbed 
molecules. 

This energetic heterogeneity greatly affects the shape of the adsorption isotherm with the result that 
simple theories such as the Langmuir and BET formulas can, at best, give only approximate estimates 
of surface area. Porous solids virtually are never characterized by a single pore dimension, but instead 
exhibit a more or less wide distribution of sizes. The observed adsorption isotherm for a typical mate-
rial is therefore the convolution of an adsorption process with the distribution of one or more 
properties which affect that process. This was first stated mathematically by Ross and Olivier12 for the 
case of surface energy distribution and has become known as the integral equation of adsorption.

The Integral Equation of Adsorption

In a general form for a single component adsorptive, the integral equation of adsorption can be written 
as:

(1)

where

Q(p) = the total quantity adsorbed per unit weight at pressure p,
a,b,c,... = a set of distributed properties,
f(a,b,c,...) = the distribution function of the properties, and
q(p,a,b,c,...)= the kernel function describing the adsorption isotherm on unit surface of 

material with fixed properties a,b,c,...

Equation (1), a Fredholm integral of the first kind, is a member of a class of problems known as ill-
posed, in that there are an infinite number of functional combinations inside the integral that will pro-
vide solutions. Even when the kernel function is known, experimental error in the data can make 
solving for even a single distribution function a difficult task. Solving for multiple distribution func-
tions requires more data than provided by a single adsorption isotherm.

Q p  a d b d cq p a b c    f a b c  d=
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Application to Surface Energy Distribution

Under certain conditions, an energetically heterogeneous surface may be characterized by a distribu-
tion of adsorptive energies. The conditions are that the sample is not microporous, i.e., that adsorption 
is taking place on essentially a free surface with no pore filling processes at least to about 0.2 relative 
pressure. Secondly, that each energetically distinct patch contributes independently to the total adsorp-
tion isotherm in proportion to the fraction of the total surface that it represents. This condition is 
satisfied if the patches are relatively large compared to an adsorptive molecule, or if the energy gradi-
ent along the surface is not steep. In mathematical terms, this concept is expressed by the integral 
equation of adsorption in the following form:

(2)

where

Q(p) = the experimental quantity adsorbed per gram at pressure p,
q(p,) = the quantity adsorbed per unit area at the same pressure, p, on an ideal free 

surface of energy ε, and 
f() = the total area of surface of energy ε in the sample.

The exact form of the energy-dependent term depends on the form of the model isotherms expressed in 
the kernel function and is provided in the model description.

Application to Pore Size Distribution

Similarly, a sample of porous material may be characterized by its distribution of pore sizes. It is 
assumed in this case that each pore acts independently. Each pore size present then contributes to the 
total adsorption isotherm in proportion to the fraction of the total area of the sample that it represents. 
Mathematically, this relation is expressed by 

(3)

where

Q(p) = the experimental quantity adsorbed at pressure p,
q(p,H) = the quantity adsorbed per unit area at the same pressure, p, in an ideal pore of 

size H, and 
f(H) = the total area of pores of size H in the sample.

Numerical values for the kernel functions in the form of model isotherms can be derived from modern 
statistical mechanics such as density functional theory or molecular simulations, or can be calculated 
from one of various classical theories based on the Kelvin equation. Several types are found in the 
models library.

Q p   q p   f  d=

Q p  H q p H  f H d=
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Performing the Deconvolution

The integrations in equations (2) and (3) are carried out over all surface energies or pore sizes in the 
model. The functions q(p,) and q(p,H), which we call the kernel functions, are contained in numeric 
form as model isotherms. Because, in general, there is no analytic solution for equation (1), the prob-
lem is best solved in a discrete form; the integral equation for any distributed property Z becomes a 
summation:

(4)

Given a set of model isotherms, q(p,Z), from a model chosen from the models library and an experi-
mental isotherm, Q(p), contained in a sample information file, the software determines the set of 
positive values f(Z) that most nearly, in a least squares sense, solves equation (4). The distributed prop-
erty, surface energy or pore size, is then displayed on the Report Options window as a selection of 
tables or graphs. 

Regularization

DFT allows a selectable regularization (also referred to as smoothing) constraint to be applied during 
the deconvolution process to avoid over-fitting in the case of noisy data or ill-fitting models. The 
method used is based on co-minimization of the second derivative of the distribution. The relative 
weight given to this term is determined by the value of the regularization parameter, which is set on the 
DFT Pore Size or Surface Energy window and also is shown in the header of reports. The value of 
the regularization parameter varies from zero (for no second derivative constraint) to ten (indicating a 
weight equal to minimizing the residuals), or even larger. When the distribution and residuals obtained 
change little with the value of the regularization parameter, it indicates that the chosen model provides 
a good representation of the data. Conversely, a large sensitivity to the regularization parameter might 
indicate inadequate data or a poor choice of model to represent the data.

Q p  q p Zi  f Zi 
i
=
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Dubinin-Radushkevich

The Dubinin-Radushkevich13 equation is:

 

where:

 = the affinity coefficient of analysis gas relative to Po gas (for this application  
is taken to be 1)

B = a constant
Po = saturation vapor pressure of gas at temperature T
P = equilibrium pressure
Q = quantity adsorbed at equilibrium pressure (cm3/g STP)
Q0 = the micropore capacity (cm3/g STP)
T = analysis bath temperature (K), from the Po and Temperature Options win-

dow

For each point designated for Dubinin-Radushkevich calculations, the following calculations are done:

The intercept, log(Vo) can be found by performing a least-squares fit on the (LP,LV) designated pairs 
where LP is the independent variable and LV is the dependent variable. Assuming the adsorption of gas 
is restricted to a monolayer, Vo is the monolayer capacity. Based on this assumption, the following are 
calculated: 

a.) Slope (S cm3/g STP)

b.) Y-intercept (YI cm3/g STP)

c.) Error of the slope (Serr cm3/g STP)

d.) Error of the y-intercept (YIerr cm3/g STP)

e.) Correlation coefficient 

Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Q log Q0  BT
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Error of Monolayer Capacity (cm3/g STP):

Micropore surface area (m2/g):

where

 = molecular cross sectional area of gas (nm2) from the Adsorptive Properties 
window

Dubinin-Astakhov

The Dubinin-Astakhov equation is:

 

where

 = the affinity coefficient of the analysis gas relative to the Po gas, from the 
Dubinin Adsorptive Options window 

E0 = characteristic energy (kj/mol)
N = Astakhov exponent, may be optimized or user entered from the Dubinin 

Report Options window 
P = equilibrium pressure
Po = saturation vapor pressure of gas at temperature T
Q = quantity adsorbed at equilibrium pressure (cm3/g STP)
Q0 = the micropore capacity (cm3/g STP)
R = the gas constant (0.0083144 kj/mol)
T = analysis bath temperature (K) 
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For each point designated for Dubinin-Astakhov calculations, the following calculations are done:

A least-squares fit is performed on the (LP,LV) designated pairs where LP is the independent variable 
and LV is the dependent variable. If the user selected Yes for the Optimize Astakhov Exponent 
prompt, a systematic search for the optimum value of N is conducted by recalculating the linear regres-
sion and selecting the value of N that gives the smallest standard error of the y-intercept. The exponent 
N is optimized to within 10-4. If the optimum value for N is not found in this range, an exponent of 2 is 
used. The following are calculated:     

a.) Slope (S cm3/g STP)

b.) Y-intercept (YI cm3/g STP)

c.) Error of the slope (Serr cm3/g STP)

d.) Error of the y-intercept (YIerr cm3/g STP)

e.) Correlation coefficient 

f.) Optimized Astakhov exponent (N)

Using the results of the above calculations, the following can be calculated:

Monolayer Capacity (cm3/g STP):

Micropore Volume (cm3/g):

where

Vmol = liquid molar volume conversion factor from the fluid property information 

LV Q log=

LP Po
P

-------log
N
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Q0 10
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Limiting Micropore Volume (cm3/g):

where 

Vmol = liquid molar volume from the fluid property information

Error of Limiting Micropore Volume (cm3/g):

Characteristic Energy (KJ/mol):

Modal Equivalent Pore Diameter (Å):

where 

 = affinity coefficient of the analysis gas relative to the Po gas from the Dubinin 
Adsorptive Options window

Maximum Differential Pore Volume (cm3/g-Å):

This value is also known as frequency of the mode12.

Mean Equivalent Pore Width (Å):
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Micropore surface area (m2/g):

 is calculated by a polynomial approximation over the domain 0  ×  1:

where

b1 = -0.57719 1652
b2 =  0.98820 5891
b3 = -0.89705 6937
b4 =  0.91820 6857
b5 = -0.75670 4078
b6 =  0.48219 9394
b7 = -0.19352 7818
b8 =  0.03586 8343

and where

Equivalent Pore Diameter (Å):

dV/dD Pore Volume (cm3/g-Å):
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MP-Method

With the (ti,Qi) data pairs, the Akima semi-spline interpolation method is used to interpolate quantity 
adsorbed values based on thickness values that are evenly spaced 0.2 angstrom apart starting at the first 
outlier point. Outliers are defined as those points that have the maximum instantaneous slope within an 
iteratively shrinking subset of all points. The remaining pore surface area calculation result is the slope 
of the line defined by two consecutive interpolated points. The slopes of each pair of consecutive 
points from the origin to the last point must be monotonically decreasing and non-negative. With the 
interpolated points set the following can be calculated:

Average pore hydraulic radius (Å):

 

Remaining pore surface area for the ith point (m2/g):

where 

104 = unit conversions
Vmol = liquid molar volume from the fluid property information

Incremental pore surface area occluded for the ith point (m2/g):

 

Cumulative pore surface area occluded for the ith point (m2/g):

 

Ri
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dA/dR pore surface area for the ith point (m2/g-Å):

 

Incremental pore volume occluded for the ith point (cm3/g):

 

Cumulative pore volume occluded for the ith point (cm3/g):

 

dV/dR pore volume for the ith point (cm3/g-Å):
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Thickness Curve Calculations

For each point designated, the following parameters are used in thickness curve calculations:

C1 = parameter #1
C2 = parameter #2
C3 = parameter #3

p/p0 = relative pressure for the ith point 
ti = thickness for ith point 

Reference

Interpolated from table.

Kruk-Jaroniec-Sayari

Halsey

 (Halsey5)    

Harkins and Jura

(Harkins and Jura6)
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SPC Report Variables

Regression Chart Variables

The line of best fit for the Regression Chart is calculated by the usual Least Squares method. (Refer to 
BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE Publications/
McGraw Hill, p. 16.) If there is only a single point or all N points have the same x-value, there can be 
no line of best fit in the standard form.

Slope = 

The coefficient of Correlation for this line is also calculated in the usual way. (Refer to Mathematical 
Handbook for Scientists and Engineers, by Granino A. Korn and Theresa M. Korn, Copyright 1961, 
1968 McGraw Hill, Sec. 18.4.)

Correlation Coefficient = 

X
 xi

N
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Y
 yi
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---------=

 xi X–  yi Y– 

 xi X– 
2

-------------------------------------------
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2
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--------------------------=
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--------------------------=
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N
-------------------------------------------=

Cov x y 
xy
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Control Chart Variables

Mean = 

StdDev = 

CoefVar = 

PlusNSig = 

MinusNSig = 

Summary Report

The following calculations and the results of previous calculations (as noted) are used to generate the 
summary report:

a.) Single-point Surface Area (m2/g)

where 

P = pressure closest to 0.3 of the relative pressure points designated for surface area 
calculations. 

Q = quantity adsorbed corresponding to P

b.) Multi-point Surface Area. Refer to BET Surface Area, page C-8.

c.) Langmuir Surface Area. Refer to Langmuir Surface Area, page C-9.

d.) t-Plot Micropore Surface Area. Refer to t-Plot, page C-12.
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e.) t-Plot External Surface Area. Refer to t-Plot, page C-12.

f.) BJH Cumulative Adsorption

g.) BJH Cumulative Desorption

h.) Adsorption Total Pore Volume

i.) Desorption Total Pore Volume

j.) t-Plot Micropore Pore Volume. Refer to t-Plot, page C-12.

k.) Freundlich. Refer to Freundlich Isotherm, page C-10.

l.) Temkin. Refer to Temkin Isotherm, page C-11

m.) Alpha-S. Refer to Alpha-S Method, page C-13.

n.) DFT Pore Size and DFT Surface Energy. Refer to DFT (Density Functional Theory), page 
C-34.

o.) Nanoparticle Size

where 

ρ = sample density

A = BET surface area

d = side length (for cubic particles or diameter (for spherical particles)

p.) Dubinin-Astakhov Micropore Surface Area. Refer to Dubinin-Astakhov, page C-38.

d 6 10
4

A
-----------------=
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q.) Dubinin-Astakhov Micropore Volume. Refer to Dubinin-Astakhov, page C-38.

r.) Dubinin-Radushkevich Micropore Surface Area. Refer to Dubinin-Radushkevich, page C-
37.

s.) Dubinin-Radushkevich Monolayer Capacity. Refer to Dubinin-Radushkevich, page C-37.

t.) MP-Method Cumulative Surface Area of Pores

Stotal = Scum,i, (see MP-method Calculations) for the last collected data point used in the MP-
method Calculations, and the range of hydraulic pore radii over which the cumulative surface 
area was computed. 

u.) MP-Method Cumulative Pore Volume of Pores

Vtotal = Vcum,i, (see MP-method calculations) for the last collected data point used in the MP-
method calculations, and the range of hydraulic pore radii over which the cumulative pore 
volume was computed. 

v.) Average Pore Hydraulic Radius (Å)

w.) Horvath-Kawazoe. Refer to Horvath-Kawazoe, page C-26.

r
Vtotal

Stotal
------------ 10

4=
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D.  FREE SPACE CORRECTION

Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of gas 
dosed into the sample tube is calculated from the difference in pressures in the manifold before and 
after the dose is delivered. The quantity of gas adsorbed by the sample is calculated by subtracting the 
quantity of gas remaining in the free space of the sample tube after equilibrium is established from the 
quantity of gas originally dosed into the sample tube. Free space must be determined accurately to 
obtain a precise value for quantity adsorbed. 

Static-volumetric systems consist basically of a gas manifold joined to a sample tube by an isolation 
valve. The manifold section has connections for an absolute pressure transducer, a temperature gauge, 
and a vacuum system. It also has inlets for the adsorptive gas and helium. A Dewar flask containing a 
cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it can be raised to immerse 
most of the sample tube. Two temperature zones exist within the sample tube when immersed in the 
cryogenic bath: a warm zone (the volume above the liquid level and near ambient temperature) and a 
cold zone (the volume below the liquid level at cryogenic temperature). Not only must the total free 
space volume be determined, but it also is necessary to determine the quantity of gas residing within 
the “cold” zone since a nonideality correction must be applied to only that quantity of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using n = 
PV/RT because temperature is not constant over the total volume, but instead is distributed as two tem-
perature zones with a steep temperature gradient between them. A convenient method for resolving 
this problem is to derive two factors which, for the existing temperature profile, can be multiplied by 
the prevailing pressure to reveal the molar volume of gas contained in the cold zone and the total quan-
tity residing in the free volume of the immersed sample holder (the cold free space).

The system provides the following methods for free space determination: 

• Measure
• Calculate
• Enter

Measure

Generally, this method, although requiring a little more time (approximately 10 minutes), is the most 
preferred one for determining free space. It is simple, automatic, requires very little information, and 
essentially is error-proof. With this method, the instrument first evacuates the manifold and sample 
tube (containing sample), then isolates the sample tube by closing the valve. Then the manifold is 
charged with helium, the pressure measured, and the valve opened allowing the helium to expand into 
the sample tube at ambient temperature. Again the pressure is measured.

The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure drops; 
when pressure has equilibrated, the value is recorded. Warm and cold free spaces are calculated from 
(1) system volume, (2) system, ambient, and bath temperatures, and (3) measured pressures. From 
these, the value of the portion of cold free space at cryogenic temperature which requires correction for 
nonideality can be determined. 

This method may be undesirable if:
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• Helium is unavailable; free space determination requires the use of helium
• Analysis speed is a major factor; a helium free space measurement of 10 to 15 minutes is required 
• Your sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs helium

Calculate

This method is the most rapid and efficient way of compensating for free space. You must ensure the 
following is accomplished:

• Perform a blank analysis on the sample tube
• Load the blank analysis file data into the sample tube file 
• Enter the analysis bath temperature (found on the Po and Temperature dialog)
• Enter the sample mass and density (found on the Sample Information dialog)

Enter

This method allows you to enter predetermined values for the warm and cold free spaces. The values to 
enter may be obtained in one of two ways:

• A pre-analysis free space calibration of the sample tube containing sample

• The total free space of an empty sample tube is measured and the displacement of the sample 
calculated from its mass and density and subtracted from the total free space

In either procedure, ensure that the level (or, in cases where the Isothermal Jacket is used, the effective 
level) of the cryogen bath on the sample tube is the same when the analysis is performed as it was 
when gathering data for free space calculations.   
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E.  MAINTAINING HIGH PURITY GASES

The system was designed to accurately measure the surface area of all types of materials. It is impor-
tant that the gases (especially krypton) used for these measurements be of highest purity, especially 
when analyzing low surface area samples. Three ways to ensure high purity gases are to always 
maintain:

• thoroughly purged gas pressure regulators
• non-permeable gas lines
• leak-free connections

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area mate-
rial yields decreasing specific surface areas with decreasing quantities of sample. The analyzer uses 
very small amounts of helium; therefore any residual air in the regulator can distort results of subse-
quent analyses for quite some time. 

Micromeritics offers the following suggestions to assist you in maintaining high purity gases (particu-
larly helium).

• Use metal gas lines only
• Remove trapped air from the regulator and gas lines

Using Metal Gas Lines

You should always use metal gas lines which have been carefully cleaned of any oils and greases used 
in the manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable, 
nonmetallic gas lines are used with helium, contaminants accumulate at a much faster rate. This causes 
errors in analysis results and can also contaminate a clean sample.

Removing Trapped Air

When connecting the regulator to the gas bottle, air is unavoidably trapped on the high- and low-pres-
sure sides of the regulator, as well as in the gas lines. You should remove as much of this air as is 
possible before opening the gas bottle valve. If this air is allowed to remain in the regulator, it will mix 
with the helium and cause inaccurate results in subsequent analyses. Or if the valve is open for any 
length of time, the air trapped on the high pressure side may diffuse back into the gas bottle and con-
taminate its entire contents.

There are two methods for removing trapped air from the regulator lines: the Purge Method and the 
Evacuation Method. 
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Purge Method

This is the preferred method for removing trapped air.

1. Go to Unit > Enable Manual Control (if the instrument schematic is not displayed, select Show 
Instrument Schematic).

2. Close all valves by right clicking on each valve and selecting Close.

3. Open the regulator Shut-off valve.

If multiple instruments are installed, make sure to choose the correct Unit menu.
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4. Open the gas bottle valve briefly and allow the regulator to be charged with gas until the high-
pressure gauge reads just over half the tank pressure; then quickly close the valve.

5. Using the Pressure Control knob, set the output pressure (gas bottle pressure gauge) to 15 psig.

6. Loosen the fitting at the helium inlet (on the rear panel of the instrument) until the low pressure 
side drops to approximately 3 psig (0.02 MPa), then tighten the fitting.

7. Repeat steps 4, 5, and 6 three times.

8. Briefly open the gas bottle valve; then, using the Pressure Control knob, reset the regulator output 
pressure to 15 psig. 

9. After the pressure has stabilized (indicating there are no leaks), open the gas bottle valve.

Evacuation Method

1. Do one of the following:

To use this method, the gas tank must be within 10 feet of the instrument.

If... Then... 

The regulator has not been 
filled with gas and the gas 
line is attached to the 
instrument:

Close the gas bottle valve.

Open the regulator Shut-off valve. 

Pressure Control knob

High-Pressure gauge

Gas Bottle valve

Regulator 
Shut-off 
valve
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2. Go to  Unit > Enable manual control (if the instrument schematic is not displayed, select Show instrument 
schematic).

3. Close all valves; then open valves 6, 7, and 10.

4. Allow evacuation to continue for 20 minutes. This pulls a vacuum on the helium line to the gas 
bottle. The manifold pressure transducer should fall close to zero.

5. Close valves 6, 7, and 10.

The regulator is filled with 
gas:

Close the gas bottle valve.

Open the regulator Shut-off valve.

Loosen the helium inlet fitting (or nut) on the rear panel of the 
instrument.

Allow all of the gas in the regulator to expel from the line (pressure 
reading will be zero). 

Retighten the helium inlet fitting (or nut).

If multiple instruments are installed, make sure to choose the correct Unit menu.

Be sure to allow evacuation for a full 20 minutes. If evacuation time is too short, 
trapped air may remain in the lines.

If... Then... (continued)
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F.  DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the exper-
imental physical sciences, theories are often expressed in terms of a model that can be visualized and 
described mathematically. Early models of physical adsorption were quite simple, both conceptually 
and mathematically, for very practical reasons — hand computations were required. Today we can 
explore complex models that describe adsorption systems on the atomic scale of size and sub-picosec-
ond time frame. This is not because scientists are smarter, but because of available tools. The DFT 
models are created by classical approaches to adsorption as well as models based on modern statistical 
thermodynamics. 

Models Based on Statistical Thermodynamics

Included in this group are methods that model the adsorption system in terms of forces acting between 
individual molecules. 

Theoretical Background

Traditional adsorption theories attempt to describe experimental adsorption isotherms with an isotherm 
equation containing a small number of parameters. At a minimum, these parameters include the extent 
of the surface, such as the monolayer capacity (Qm), and the molar intensity of the gas-surface interac-
tion, such as the Langmuir “K” constant or the BET “C” constant. In some equations, additional 
parameters take into account the lateral interaction of adsorbed molecules with each other. Other theo-
ries, such as the Dubinin-Astakhov approach, also include parameters for the effect of adsorbent 
porosity. 

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based statisti-
cal thermodynamic theory that allows us to relate the adsorption isotherm to the microscopic 
properties of the system: the fluid-fluid and fluid-solid interaction energy parameters, the pore size, the 
pore geometry, and the temperature.

The following example is given so that you may understand how such a theory is constructed.

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an evacu-
ated space. It is kept at a fixed temperature as a known quantity of pure argon gas is admitted into the 
space surrounding the sample. The pressure within the space is recorded over time. In this situation, 
the pressure falls rapidly from its initial value and gradually approaches a steady reading, called the 
equilibrium pressure. The amount adsorbed corresponds to the quantity of gas effectively removed 
from the gas phase by the solid surface. A graph that plots amount adsorbed versus equilibrium pres-
sure is called an adsorption isotherm.

Under such conditions, the argon atoms that randomly enter the pore space feel the presence of the 
solid surface as the action of an external attractive force (the dispersion forces or Van der Waal’s 
forces) and spend more time near the surface. As a result, the space near the surface acquires a greater 
average density of argon atoms than regions farther removed. 
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If the equilibrium distribution of the gas atoms near the surface could be described as a function of 
pressure and the molecular properties of the components of the system, then a model could be con-
structed for the adsorption isotherm for the system. Modern physical chemistry provides several ways 
to calculate this distribution. All these methods are based on the fundamental thermodynamic law that 
such a system adopts a configuration of minimum free energy at equilibrium. Also needed is a descrip-
tion of the pairwise interaction energy between atoms, U(s), commonly given by a Lennard-Jones 
potential:

where

Molecular Simulation Methods

Two simulation techniques are commonly used to determine the distribution of gas molecules in a sys-
tem in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these are 
used as reference methods because their results are considered exact.

Molecular Dynamics Method

In the molecular dynamics method, the position and velocity of individual gas particles are calculated 
over time at very short intervals. This method takes into account both the forces acting between the gas 
particles themselves and those acting between the gas particles and the atoms of the simulated surface. 
As the simulated particles collide with each other and with the surface, the average concentration of 
particles in the space near the surface is calculated; this calculation yields the amount of gas adsorbed. 

This method can be thought of as a way to determine the chronological record of the movement of 
each particle in the system using time steps of 10-14 seconds. Although the mathematics are simple, 
the number of calculations required for a system of even a few hundred particles is astronomical and 
challenges even the fastest computers.

Monte Carlo Method

In the Monte Carlo method, determination of the system equilibrium distribution begins with an 
assumption (which may be only approximate) about the initial configuration of particles in the system. 
The system is “equilibrated” through a process of randomly selecting one particle and conditionally 
moving it a random distance in a random direction. 

If the move results in a configuration of lower total energy, then the move is completed and another 
particle is randomly selected to be moved. 

ε = a characteristic energy of the adsorptive,

= the diameter of the adsorptive molecule, and

s = the separation distance. 
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If the move results in a configuration of higher energy, a probability for that event is calculated, and a 
random number between zero and one is generated. If the generated number is smaller than the proba-
bility of the event, then the move is accepted; otherwise, another particle is selected and the process is 
repeated. This process continues until the average total energy of the system no longer decreases; at 
this point, average configuration data are accumulated to yield the mean density distribution of parti-
cles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic simula-
tions and can yield the same results; however, neither method provides a really practical way to 
calculate complete isotherms.

Density Functional Formulation

Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo 
simulations. When compared to reference methods based on molecular simulation, this theory pro-
vides an accurate method of describing inhomogeneous systems yet requires fewer calculations. 
Because the density functional theory provides accuracy and a reduced number of calculations, it is the 
basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated by a 
distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed temper-
ature and pressure. Under such conditions, the fluid responds to the walls and reaches an equilibrium 
distribution. In this condition (by the definition of equilibrium), the chemical potential at every point 
equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system of constant den-
sity; its chemical potential* is determined by the pressure of the system using well-known equations. 
The fluid near the walls is not of constant density; its chemical potential is composed of several posi-
tion-dependent contributions that must total at every point to the same value as the chemical potential 
of the bulk fluid.

As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy, known 
thermodynamically as the grand potential energy (GPE). Density functional theory describes the ther-
modynamic grand potential as a functional of the single-particle density distribution; therefore, 
calculating the density profile that minimizes the GPE yields the equilibrium density profile. The cal-
culation method requires the solution of a system of complex integral equations that are implicit 
functions of the density vector. Since analytic solutions are not possible, the problem must be solved 
using iterative numerical methods. Although calculation using these methods still requires supercom-
puting speed, the calculation of many isotherm pressure points for a wide range of pore sizes is a 
feasible task. The complete details of the theory and the mathematics can be found in the papers listed 
under References at the end of this appendix.

The following graphs and accompanying text illustrate the results of using density functional theory to 
predict the behavior of a model system. 

Figure D-1 shows the density profile for argon at a carbon surface as calculated by density functional 
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

*.Chemical potential may be thought of as the energy change felt by a probe particle when it is inserted into the 
system from a reference point outside the system. It can also be defined as the partial derivative of the grand 
potential energy with respect to density (or concentration).
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Figure D-1. Density Profile for Argon on Carbon at 87.3 K and a Relative Pressure of 0.5  

This figure represents a cross-section of the region near the surface. Note the layerwise distribution of 
adsorbate; the first monolayer is sharply defined and a third layer can be distinguished. The area under 
the profile curve represents the amount adsorbed per unit area at this pressure. The positions of the 
maxima are separated by a distance determined by the size of the adsorptive atom.

Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as the 
integral over the profile. Repeating this calculation over a range of pressures yields the adsorption iso-
therm for the model. If the value of H is very large, the isotherm obtained corresponds to that of an 
external, or free, surface. If H is smaller, a range of pressures is reached where two minima exist for 
the grand potential, showing the presence of two metastable phases having different density distribu-
tions but the same chemical potential. The phase with the lower GPE is the stable one. As the pressure 
is increased, a point is reached where the other phase becomes the stable one. This phase transition 
reflects condensation of adsorbate in the pore; the pressure at which it occurs is called the critical pore-
filling pressure. This pressure is analogous to the condensation pressure predicted by the Kelvin equa-
tion in the classical model of pore filling.

Figure D-2 shows how the profiles change with pressure for a model pore with H = 40 Å. The insets 
show the density profiles for the corresponding points of the isotherm.
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Figure D-2. Model Isotherm for Argon at 87.3 K in a 40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the 
distribution is a mirror image of the profile shown. 

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close to 
the surface.

• Inset a shows the profile corresponding to point a on the isotherm where the surface is about half 
covered. 

• At point b, the first layer is so full that it is more favorable for atoms to start a new layer. 

• At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In 
inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4 or 5 
molecular diameters from the surface. 

• Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center of 
the pore, indicating a phase transition.

Note that the adsorption isotherms for pores larger than the one shown in Figure D-2 is identical up to 
point c. The lower branch of the isotherm simply continues to a higher pressure for larger pores. This 
trend is illustrated in Figure D-3, where isotherms for some larger size pores are shown. It is clear that 
pore size is uniquely characterized by a corresponding critical pore-filling pressure. At large pore 
sizes, density functional theory produces results for the critical filling pressures that are in good agree-
ment with those produced by the Kelvin equation.
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Figure D-3. Model Isotherms for Some Larger Pore Widths Argon on Carbon at 87.3 K    

Figure D-4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale 
for pressure.

Figure D-4. Model Isotherms in the Micropore Size Range of Pore Width
Argon on Carbon at 87.3 K            
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr. Pores 
below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the micropore 
size range, the pore volume fills more gradually with pressure and the total shape of the isotherm is 
important in characterizing the pore size. 

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Using the methods of non-local density functional theory, two sets of isotherms have been calculated 
to serve as kernel functions for the characterization of porous solids from adsorption data. The model 
isotherms are stored in binary format files. These models assume a slit-like pore geometry. The pore 
size range from 4.0 to 4000 Å is covered in 91 classes in a geometric progression. The class intervals 
are rounded to the nearest 0.02 molecular diameters. A model for the free or external surface is 
included to account for unfilled pores. Each of the 92 model isotherms has been calculated at 181 pres-
sure points from near 1x10-6 to near 1.00 relative pressure.

These models are identical to those supplied with the original DOS version of DFT software. Some 
slight difference from the DOS results may be noted when they are applied to the same data due to 
improvements in the deconvolution algorithm and better regularization of the current software.

Non-Local Density Functional Theory with Density-Dependent Weights 

N2 - Modified Density Functional

Using the modified Tarazona prescription described by Olivier (refer to References, references 3 and 
4), model isotherms were calculated for a wide range of adsorptive energies to a relative pressure of 
0.6. The model makes no provision for pore filling in the micropore region. If the sample solid con-
tains small mesopores, the isotherm data should be truncated (using the Select Data Points dialog box) 
to a suitably low relative pressure to avoid trying to fit this region; mesopore filling reports as a large 
area of low energy in the calculated distribution of adsorptive potential. 

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e., for 
the adsorptive/adsorbent pair divided by Boltzmann’s constant. The units are therefore Kelvin.

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77 K
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N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Model isotherms were calculated using a combination of statistical mechanical calculations and exper-
imental observations for macroporous silicas and MCM-41 mesoporous silicas as well as zeolites. The 
pore-filling pressures were determined as a function of the pore size from adsorption isotherms on 
MCM-41 materials characterized by X-ray and other techniques. The variation of the pore fluid den-
sity with pressure and pore size has been accounted for by density functional theory calculations. The 
N2 model reports pore sizes ranging from 3.8 to 387 Å and the AR model from 3.8 to over 500 Å.

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local Density 
Functional Theory (NLDFT) calculations and experimental isotherms for reference samples of mont-
morillionite. The construction method for the hybrid models was analogous to that described in the 
first reference below (Jaroniec et al,1999). The additional references add additional theoretical details 
as well as examples of the application of the model to pillared clay catalysts. This model reports pore 
widths from 3.8 to 387 Å.

Geometry Cylinder
Substrate Oxide
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Reference: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A New Method for the 
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based 
Mesoporous Materials,” Proceedings of COPS-V, Heidelberg, Germany 
(1999).

Geometry Cylinder
Substrate Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77 K
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C02 - DFT Model

Model isotherms were calculated, using the non-local prescription of Tarazona, employing molecular 
parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

This model was produced in the same manner as the N2 Modified Density Functional model listed ear-
lier, except applicable to argon adsorbed at 87.3 K.

N2 - Tarazona NLDFT, Esf = 30.0K

References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A 
New Method for the Characterization of Mesoporous Silicas,” 
Proceedings of COPS-V, 1999, Studies in Surface Science, Vol 128, 
Characterization of porous Solids V , Unger, et al, Eds, Elsevier, 
Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity 
of a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional 
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 
105(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, 
“Surface Area, Pore Volume Distribution, and Acidity in Mesoporous 
Expanded Clay Catalysts from Hybrid Density Functional Theory (DFT) 
and Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in 
Developing Characterization Methods.” 6th International Symposium on 
the Characterization of Porous Solids, Studies in Surface Science and 
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity 
of Pillared Rectorite Catalysts from a Hybrid Density Functional Theory 
Method,” Microporous and Mesoporous Materials 2003, 57, 291-296.

Geometry Slit
Substrate Carbon
Category: Porosity
Method: Carbon dioxide at 273 K 

Geometry Free Surface
Substrate Any
Category: Surface energy
Method: Argon at 87 K 

Geometry Cylinder
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for a silica or 
alumina surface. 

This model file is particularly useful for sizing zeolites or zeolite containing materials that have sub-
stantial micropore volume. The reported pore size range is 3.8 to 387 Å.

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and a slit-like pore geometry. These models are slightly different from N2-DFT and Ar-DFT 
models that were calculated using NLDFT with density independent weighting functions.

The reported pore size range is from 3.5 to 1000 Å.

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Substrate Oxide
Category: Porosity
Method: Nitrogen at 77 K 

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

Geometry Slit
Substrate Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K 

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

Geometry Finite Slit
Substrate Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K 
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is 
from 3.5 to 250 Å.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Model isotherms were calculated using the same methods and assumptions that were used in the model 
above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent analyti-
cal techniques such as high-resolution transmission electron microscopy (HRTEM) and/or X-ray 
diffraction (XRD) to obtain comprehensive information about the structure of studied carbon material.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones 
potential of interaction between a gas molecule and the graphitic surface of an infinitely long cylinder.

Reference: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT 
model of gas adsorption in finite carbon pores. Application to pore 
structure analysis.,” The Journal of Physical Chemistry C, 
113(45):19382-19385, 2009.

Geometry Finite Slit
Substrate Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K 

Reference: See above reference.

Geometry Cylinder
Substrate Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K 
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This model is particularly useful for characterizing carbon single-wall nanotubes. The reported pore 
size range is from 3.5 to 1000 Å.

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones 
potential of interaction between a gas molecule and multiple concentric graphitic surfaces of infinitely 
long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore 
size range is from 3.5 to 1000 Å.

Ar - Zeolites H-Form by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones 
potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites. The 
reported pore size range is from 3.5 to 300 Å.

Reference: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 
(1987).

Geometry Cylinder
Substrate Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K 

Reference: See above reference.

Geometry Cylinder
Substrate Zeolite
Category: Porosity
Method: Argon at 77 K 
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Ar - Zeolites Me-Form by NLDFT

Model isotherms were calculated using the prescriptions of Tarazona for density dependent weighting 
functions and cylindrical pore geometry. The pore wall potential is described by the Lennard-Jones 
potential of interaction between a gas molecule and the oxide surface of an infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal 
exchanged zeolites. The reported pore size range is from 3.5 to 300 Å.

Models Based on Classical Theories

Both surface energy distribution and pore size distribution may be evaluated using classical 
approaches to model kernel functions for use with equation (1) of the DFT Theory in the calculations 
appendix. Be aware that the deconvolution method only provides a fitting mechanism; it does not over-
come any inherent shortcomings in the underlying theory. 

Surface Energy

The use of classical theories to extract adsorptive potential distribution is mostly of historical interest. 
At a minimum, the equation must contain a parameter dependent on adsorption energy and another 
dependent on monolayer capacity or surface area. This is sufficient to permit the calculation of the set 
of model isotherms that is used to create a library model. The Langmuir equation has been used in the 
past, as have the Hill-de Boer equation and the Fowler-Guggenheim equation. All of these suffer from 
the fact that they only describe monolayer adsorption, whereas the data may include contributions 
from multilayer formation.

Pore Size

It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at pres-
sures somewhat below the prevailing saturated vapor pressure of the adsorptive. When combined with 
a correlating function that relates pore size with a critical condensation pressure, this knowledge can be 
used to characterize the mesopore size distribution of the adsorbent. The correlating function most 
commonly used is the Kelvin equation. Refinements make allowance for the reduction of the physical 
pore size by the thickness of the adsorbed film existing at the critical condensation pressure. Still fur-
ther refinements adjust the film thickness for the curvature of the pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data using 
Kelvin-based theories, such as the BJH method, were for the most part developed decades ago and 
were designed for hand computation using relatively few experimental points. In general, these meth-
ods visualize the incremental decomposition of an experimental isotherm, starting at the highest 
relative pressure or pore size. At each step, the quantity of adsorptive involved is divided between pore 
emptying and film thinning processes and exactly is accounted for. This computational algorithm fre-

Geometry Cylinder
Substrate Zeolite
Category: Porosity
Method: Argon at 77 K 
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quently leads to inconsistencies when carried to small mesopore sizes. If the thickness curve used is 
too steep, it finally will predict a larger increment of adsorptive for a given pressure increment than is 
actually observed; since a negative pore volume is non-physical, the algorithm must stop. Conversely, 
if the thickness curve used underestimates film thinning, accumulated error results in the calculation of 
an overly large volume of (possibly nonexistent) small pores. 

The use of equation (1) represents an improvement over the traditional algorithm. Kernel functions 
corresponding to various classical Kelvin-based methods have been calculated for differing geometries 
and included in the list of models.

Models Included

t 3.54
5.00–
P/Po ln

---------------------- 
  1/3

=

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

N2 - Halsey Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Geometry Slit
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry Cylinder
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).
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t
13.99

0.034 P/Po log–
--------------------------------------------- 
  1/2

=

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

N2 - Harkins and Jura Thickness Curve

The calculation is the same as above except that cylindrical geometry is assumed.

Geometry Slit
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry Cylinder
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Reference: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).

J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).
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Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

N2 - Broekhoff-de Boer Model

The calculation is similar to the above except that cylindrical geometry is assumed, and the film thick-
ness depends on pore size (see reference).

Geometry Slit
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry Cylinder
Substrate Average
Category: Porosity
Method: Nitrogen at 77 K

Reference:  Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer, 
“The Surface Area in Intermediate Pores,” Proceedings of the 
International Symposium on Surface Area Determination, D.H. Everett, 
R.H. Ottwill, eds., U.K. (1969).

p/p
0  16.11–

t
2

---------------- 0.1682
0.1137t–

+=log
F-16                                                    Dec 2012



3Flex Appendix F
References

The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of 
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, 
Micromeritics Instrument Corp; presented at the International Symposium on the Effects of 
Surface Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July 
1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,” Perla 
B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier Science 
Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional 
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated by 
Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference on the 
Fundamentals of Adsorption, Pacific Grove, CA (1995).
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G.  USER-DEFINED REPORTS, PYTHON MODULE

The mic Python module allows you to access primary and overlay isotherm data and create graphical, 
tabular, and summary reports. Graphical reports consist of a single graph with one or more curves on 
one or two y-axes. Tabular reports consist of one or more tables consisting of one or more labeled col-
umns of data. Summary reports consist of summary sections, each containing a two-column table of 
label and value pairs.

TABLE 1: Example Python Script for User-defined Reports 

1. import mic Import the mic (required) and 
numpy (optional) packages.

2. import numpy as np
3. # Isotherms as list of components

4. # Isotherms as list of components
5. iso_rel = mic.isotherm('rel')

Get the isotherm data.

6. iso_abs = mic.isotherm('abs')
7. # or as components.
8. prel, qads, num_ads, warm_fs, cold_fs, mass, desc = 

mic.isotherm('rel')
9. pabs, qads, num_ads, warm_fs, cold_fs, mass, desc = 

mic.isotherm('abs')
10. # Overlays work the same way but are not guaranteed to be 

valid.

11. overlays = [] Get the overlay isotherm data.

12. for i in range( 8 ) :
13.     ov = mic.overlay(i, 'rel')
14.     overlays.append( ov if ov[0].any() else None )
15. # A graphical report with 3 curves.

16. mic.graph( 'Graphical Report 1', 'Rel. Press', 'Qads' ) Add a graphical report.

17. mic.graph.add( 'Sample isotherm', prel, qads ) Add some curves to the report.

18. mic.graph.add( 'Linear transform', prel, qads * 4.0 + 1.0 )
19. mic.graph.addyy( 'Another transform', prel, np.log( qads * 

qads ) )
20. # Another graphical report, this time with 1 curve

21. mic.graph( 'Graphical Report 2' ) Add another graphical report.

22. mic.graph.add( 'Sample isotherm', pabs, qads )
23. # A tabular report with 2 tables.

24. mic.table() Add a tabular report.

25. mic.table.addtable( "Table 1" ) Add a table to the report.
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Note that the mic module is automatically imported when the user script is run. For test purposes, a 
mic.pyc pre-compiled module will be provided.

26. mic.table.addcolumn( "Column 1", Add columns to the table. Note 
that the column values are 
strings; this allows arbitrary 
formatting.

27.                      ["1", "2.5", "%8.3f" % np.exp(5.0)] )
28. mic.table.addcolumn( "Column 2", 
29.                      ["Val A", "Val B", "Val C" % np.exp(5.0)] )
30. mic.table.addtable( "Table Two" )
31. mic.table.addcolumn( "Column A", ["Small", "Smaller"] )
32. mic.table.addcolumn( "Column B", ["Big", "Bigger"] )
33. # Another tabular report

34. mic.table( "Tabular Report Two" ) Add another table.

35. mic.table.addtable( "One" )
36. mic.table.addcolumn( "Column A", ["Small", "Smaller"] )
37. mic.table.addcolumn( "Column B", ["Big", "Bigger"] )
38. mic.table.addcolumn( "Column C", ["Embiggen", 

"Cromulent"] )
39. # A summary report

40. mic.summary( "A summary report" ) Add a summary report.

41. mic.summary.add( "Quantity Adsorbed", Add sections to the summary 
report. Note that summary 
sections are just specialized 
reports with two columns and no 
column headers.

42.                  ["First", "Last"], 
43.                  ["%8.3f" % qads[0], "%8.3f" % qads[-1] )
44. mic.summary.add( "Rel Pressure", 
45.                  ["First", "Last"], 
46.                  ["%8.3f" % prel[0], "%8.3f" % prel[-1] )

TABLE 1: Example Python Script for User-defined Reports (continued)
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TABLE 2: Function Reference for mic Python Module (User-defined Reports) 

mic.isotherm(press_type='rel')

    Get the primary isotherm data.

    Keyword arguments:
    press_type --- the pressure basis; use 'rel' for relative pressure, 'abs' for absolute (default = 'rel')

    Usage:
    p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.isotherm('rel')

    p   --- array of pressure (relative or absolute)
    qads   --- array of cumulative quantity adsorbed
    num_ads   --- number of points in the adsorption curve
    warm_fs --- warm free-space
    cold_fs --- cold free-space
    mass   --- sample mass
    desc    --- sample description

mic.overlay(overlay_number=1, press_type='rel')

    Get overlay isotherm data.

    Keyword arguments:
    overlay_number --- the overlay number (1 through 8)
    press_type   --- the pressure basis; use 'rel' for relative pressure, 'abs' for 

absolute (default = 'rel')

    Usage:
    p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1, 'rel')

    p     --- array of pressure (relative or absolute); empty-array if overlay is unavailable.
    qads    --- array of cumulative quantity adsorbed; empty-array if overlay is unavailable.
    num_ads  --- number of points in the adsorption curve; 0 if overlay is unavailable.
    warm_fs --- warm free-space; 0.0 if overlay is unavailable.
    cold_fs --- cold free-space; 0.0 if overlay is unavailable.
    mass    --- sample mass; 0.0 if overlay is unavailable.
    desc    --- sample description; empty-string if overlay is unavailable.
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mic.imported_pore_data( import_number = 1 )

    Get imported pore data.

    Keyword arguments:
import_number --- the import number (1 through 8)

    Usage:
xdat, ydat, desc = mic.imported_pore_data(1)

      xdat --- array of pore dimension boundaries (angstroms); empty-array if unavailable.
      ydat --- array of incremental pore volumes (cm^3/g); empty-array if unavailable.
      desc --- Name of data set; empty-string if unavailable.

mic.adsorptive_data( sample_number = 0 )
    
    Get adsorptive data for each sample

    Keyword arguments:
sample_number --- Identifier for the adsorptive data to retrieve (default = 0).

                        0        : the current sample file
                        1 through 8 : the corresponding overlay sample file

    Usage:
csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()

      csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data( i )

      csa    --- cross sectional area (nm^2)
      hsd        --- hard sphere diameter (angstroms)
      dcf         --- density conversion factor (dimensionless)
      mol_weight   --- molecular weight
      analysis_gas --- mnemonic for the analysis gas species (e.g., 'CO', 'H2')

TABLE 2: Function Reference for mic Python Module (User-defined Reports) (continued)
G-4                                                    Dec 2012



3Flex Appendix G
 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis', 
          yylabel='YY axis', xlinear=True, ylinear=True, yylinear=True) 

Create a new graphical report.

    Keyword arguments:
    title      --- the graphical report title (default = 'User Graph')
    xlabel    --- x-axis label (default = 'X axis')
    ylabel         --- y-axis label (default = 'Y axis')
    yylabel   --- yy-axis label (default = 'YY axis')
    xlinear     --- x-axis linear scale; if false, use log scale (default = True)
    ylinear     --- y-axis linear scale; if false, use log scale (default = True)
    yylinear    --- yy-axis linear scale; if false, use log scale (default = True)

mic.graph.add (self, name, x, y, yyaxis=False, color=None, linestyle='-', marker='a',  
              graphtype='both')

    Add a curve to the last created graphical report.
    
    Keyword arguments:

name        --- the curve name
    x             --- list of x values; must be a list of floats (or convertible) and the same length as y
    y              --- list of y values; must be a list of floats (or convertible) and the same length as x
    yyaxis     --- place this curve on the yy-axis if True otherwise place on the 

y-axis (default = False)
    color      --- RGB color as an HTML hex string (e.g., '#4169e1') or a three- element list or 

tuple (e.g., [65,105,225]); if None, color is automatically selected 
(default = None)

    linestyle   --- line style; (default = '-')
                       '-'        : solid
                       '--'       : dash
                       '.'        : dot
                       '-.'       : dash dot
                       '-..'      : dash dot dot
    marker --- marker shape; (default = 'a')
                       '' or None : no marker
                       '+'        : plus
                       'o' or '0' : circle
                       'x'        : cross
                       '^'        : up triangle
                       'v'        : down triangle
                       's'        : square
                       'd'        : diamond
                       '8'        : hourglass
                       '~'        : horizontal hourglass
                       'a'        : automatically selected

TABLE 2: Function Reference for mic Python Module (User-defined Reports) (continued)
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 graphtype --- graph type; (default = 'both')
                       'curve'  or 'c' : curve
                       'points' or 'p' : points
                       'both'   or 'b' : curve-and-points
                       'hist'   or 'h' : histogram

mic.table(title='User Table') 

    Create a new tabular report.

    Keyword arguments:
    title --- the tabular report title (default = 'User Table')

mic.table.addtable(name) 

    Add a table to the last created tabular report.

    Keyword arguments:
    name --- the table name

mic.table.addcolumn(header, values) 

    Add a column to the last created table.

    Keyword arguments:
    header --- column header; must be a string (or convertible)
    values --- column values; must be a list of strings (or convertible)

mic.summary( title='User Summary') 

    Create a new summary report.

    Keyword arguments:
    title --- the summary title

mic.summary.add(self, name, labels, values) 

    Add a summary section to the last created summary report.

    Keyword arguments:
    name   --- summary section name
    labels --- column of labels; must be a list of strings (or convertible) and the same length as

values
    values --- column of values; must be a list of strings (or convertible) and the same length as

values

TABLE 2: Function Reference for mic Python Module (User-defined Reports) (continued)
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INDEX

Numerics
3Flex on the web, 1-20

A
Absolute pressure tolerance, 3-25
Accessories, ordering, 9-1
Adsorption isotherm, F-1
Adsorptive properties file, creating, 2-19
Advanced format

defined, 2-6
sample information file, 2-7

Alpha-S Method, 3-44
Analysis

Dewar, 2-41
Dewar, checking, 8-4
performing, 2-44
preparing for, 2-14
sample, 2-44

Analysis conditions
command, 3-16
creating the file, 3-16
defining file, 2-14, 2-17

Analysis program
using, 1-13
version number, 1-20

Analyzer
cleaning, 8-4
configurations, 4-27
maintaining, 8-3
turning on/off, 1-11

Analyzing file status, 1-15
Ar Carbon Finite Pores, As=12, 2D-NLDFT model, F-11
Ar Carbon Finite Pores, As=6, 2D-NLDFT model, F-10
Ar Carbon Slit Pores by NLDFT model, F-10
AR Cylindrical Pores - Oxide Surface model, F-8
AR DFT model, F-7
AR Modified Density Functional Model, F-9
Argon Cylinder, multi-wall nanotube by NLDFT model, 

F-12
Argon Cylinder, single-wall nanotube by NLDFT model, 

F-11
Avogadro Constant, C-27
Axis coordinates, viewing, 5-26

B
Backfill, B-15, B-17, B-32

Basic format
defined, 2-6
sample information file, 2-10

BET surface area
report, 3-33
report calculations, C-8
report, relative pressure table, 3-35

BJH Adsorption/Desorption
calculations, C-14
plot options, 3-51
report, 3-47
tabular options, 3-49

Blank tube analyses, 2-20
Boltzmann’s constant, F-7
Broekhoff-de Boer thickness curve, 3-42

C
Calibration

calibrating the system, 8-23
command, 4-29
information, 4-27
load file, 4-35
match transducers, 8-24
save to file, 4-34
servo valve, 4-32, 8-24

Carbon Black STSA thickness curve, 3-42
Carbon Cylinder

multi-wall nanotube by NLDFT model, F-12
single-wall nanotube by NLDFT model, F-11

Cautions, defined, 1-3
Charge from inlet, 2-20, 3-19
Chemical potential, F-3
Cheng/Yang

calculations, C-29
Pore Geometry, C-28

Cleaning
analyzer, 8-4
Dewars, 8-4

Cleaning the Power Supply Air Filter, 8-11
Close reports command, 5-3
CO2 DFT Model, F-9
Cold free space, 3-12, 3-23
Common fields and buttons

for file menu, 3-1
for reports menu, 5-1
for unit menu, 4-2

Complete file status, 1-15
Components and connectors
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front panel, 1-7
rear panel, 1-9
sample compartment, 1-8
side panel, 1-10

Control chart report, 5-10
Conventions

Caution, 1-3
Notes, 1-3
Warning, 1-3

D
Dashboard

analyses completed/started, 4-16
manifold outgas rate, 4-17
manifold temperature, 4-18
Nitrogen po, 4-19
Roughing Pump, 4-17
Show Dashboard, 4-16

Degas
in situ, 2-18, 3-22
sample on analysis port, 2-33

Degas conditions
defining file, 2-15

Degasser
FlowPrep, 1-5
ordering units, 9-1
SmartPrep, 1-5
VacPrep, 1-6

Density Functional Theory, F-3
Dewar

checking, 8-4
cleaning, 8-4
installing, 2-41
precautions, 2-41

DFT models, F-1
See Models

DFT report
Pore Size options, 3-58
Surface Energy, F-13
Surface Energy options, 3-60

Diagnostics
gas line test, 8-19
Reference analysis, 4-7
Save files for problem diagnosis, 7-8
Schedule, 7-4
Show All Readings, 7-1
Start, 7-2
Test frequency, 7-4
Test Report, 7-6

Dollimore-Heal Adsorption/Desorption report, 3-52
Dosing Method

Charge from inlet, 2-20, 3-19
From Port 3, 2-20, 3-18

From Psat tube, 2-20, 3-18
Normal, 2-20, 3-18
Purify adsorptive, 2-20, 3-19
Vapor Source, 2-20, 3-19

Dubinin
calculations, C-37
report, 3-61
tabular report options, 3-62
transformed isotherm plot options, 3-62

Dubinin-Astakhov calculations, C-38
Dubinin-Radushkevich calculations, C-37

E
Elevator, screw, 8-2
Enable manual control command, 4-9
Entered file status, 1-15
Entering Ethernet Settings, 1-20
Equilibration, calculations, C-6
Error messages, B-1

2400 series, B-1
2500 series, B-9
4000 series, B-14
6000 series, B-28, B-35

Evacuation Temperature, 3-22
Export

sample files, 3-3
Export file, 2-57

F
File

default file name extensions, 1-15
export, 2-57
list, 2-59
status, 1-15

File menu
Analysis conditions command, 3-16
Common fields and buttons, 3-1
Degas conditions command, 3-14
Export, 3-8
New Method command, 3-8
New Sample, 3-6
Report command, 3-27

File name, default extensions, 3-7
Filler rod, cleaning, 2-26
FlowPrep Degasser, 1-5
Format

Advanced, 2-6
Basic, 2-6
Restricted, 2-6

Forms, Sample Data Worksheet, A-1
f-Ratio Method, 3-46
Free space
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calculated method, D-2
calculations, C-4
cold, 3-12, 3-23
correction, D-1
entered method, D-2
measured method, D-1
warm, 3-12, 3-23

Freundlich
calculations, C-10
report, 3-36

Front panel, 1-7
Function keys

See  Shortcut keys

G
Gas

connecting, 8-15
disconnecting depleted bottle, 8-15
Guidelines for Connecting to Analyzer, tutorial, 8-15
hazardous, 8-15
line, clean and verify, 8-19
Maintaining High Purity, E-1
toxic, 8-16

Gasket, Psat fitting, 8-7
Graph

copying as metafile, 5-25
editing onscreen, 5-22

Graph grid lines
command, 6-4
window, 6-4

Graph overlay
for multiple graphs, 2-66
generating, 2-60
multiple samples, 2-61

H
Halsey thickness curve, 3-42
Harkins and Jura thickness curve, 3-42
Heat of Adsorption report, 5-13
Heating mantle

installing with chain supports, 2-38
installing with shelf, 2-34

Heating mantle, cooling, 2-37, 2-40
Help

3Flex on the web, 1-20
Micromeritics web page, 1-20
online manual, 1-20
Tutorials, 1-20

Horvath-Kawazoe
Cylinder pore geometry (Saito/Foley) calculations, 

C-27
physical properties window, 3-54

report, 3-53
report calculations, C-26
report plot options, 3-56
report, tabular options, 3-56
Slit pore geometry (original HK) calculations, C-26
Sphere pore geometry (Cheng/Yang) calculations, 

C-28

I
In situ degassing, 2-18
Instrument log, 4-20
Instrument schematic

components, 4-10
enable manual control, 4-9
shortcut menu, 4-13
showing, 4-15

Interaction parameter, C-30
Interactive reports, Working with, 2-1
Isotherm report options, 3-31

K
Kernel function, F-14, F-15

L
Langmuir surface area

report, 3-33
report calculations, C-9

Leak test
diagnostics, 8-12
performing, 8-12

Lennard-Jones, F-2, F-7
Library, 1-17
List file statistics, 3-4
Loading a sample, 2-30
Log report settings, 4-21
Low surface area sample, analyzing, E-1

M
Main menu bar, 1-18
Maintenance

system, 8-1
troubleshooting, 8-1

Manual control
accessing shortcut menu, 4-13
enabling, 4-9

MCM-41 materials, F-8
Menu

bar, 1-18
structure, 1-18
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Method, New, 3-5
mic Python module, G-1
MicroActive

reports, 1-11, 1-12
Working with Interactive Reports, 2-1

Micropore option, 1-5
Models, F-1

Ar Carbon finite pores by NLDFT, As=12, F-11
Ar Carbon finite pores by NLDFT, As=6, F-10
Ar Carbon slit pores by NLDFT, F-10
AR Cylindrical Pores - Oxide Surface, F-8
AR DFT model, F-7
AR Modified Density Functional, F-9
Argon Cylinder, multi-wall nanotube by NLDFT, 

F-12
Argon Cylinder, single-wall nanotube by NLDFT 

model, F-11
based on classical theories, F-13
based on statistical thermodynamics, F-1
Carbon Cylinder, multi-wall nanotube by NLDFT, 

F-12
CO2 DFT Model, F-9
N2 Broekhoff-de Boer Model, F-16
N2 Carbon Cylinder, single-walled nanotube by 

NLDFT model, F-11
N2 Carbon finite pores by NLDFT, As=12, F-11
N2 Carbon finite pores by NLDFT, As=6, F-10
N2 Carbon slit pores by NLDFT, F-10
N2 Cylindrical Pores - Oxide Surface, F-8
N2 Cylindrical Pores - Pillared Clay Surface, F-8
N2 DFT model, F-7
N2 Halsey Thickness Curve, F-14
N2 Harkins and Jura Thickness Curve, F-15
N2 Harkins and Jura Thickness Curve model, F-15
N2 Modified Density Functional, F-7
N2 Tarazona NLDFT, Esf = 30.0K, F-9
Zeolites H-Form by NLDFT, F-12

Molecular dynamics, F-2
Molecular simulation methods, F-2
Monolayer capacity, 3-36, 3-39
Monte Carlo, F-2
Montmorillionite, F-8
MP-Method

plot report options, 3-67
report, 3-65
tabular report options, 3-66

N
N2 Broekhoff-de Boer model, F-16
N2 Broekhoff-de Boer Model model, F-16
N2 Carbon Finite Pores, As=12, 2D-NLDFT model, 

F-11
N2 Carbon Finite Pores, As=6, 2D-NLDFT model, F-10

N2 Carbon Slit Pores by NLDFT model, F-10
N2 Cylindrical Pores - Oxide Surface model, F-8
N2 Cylindrical Pores - Pillared Clay Surface model, F-8
N2 DFT model, F-7
N2 Halsey Thickness Curve model, F-14
N2 Harkins and Jura Thickness Curve model, F-15
N2 Modified Density Functional model, F-7
N2 Tarazona NLDFT, Esf = 30.0K model, F-9
No analysis file status, 1-15
Notes, defined, 1-3

O
Open report command, 5-4
Operator’s manual, conventions, 1-3
Option Presentation

Advanced Format, 6-1
Options

FlowPrep, 1-5
Micropore, 1-5
SmartPrep, 1-5
VacPrep, 1-6
Vapor, 1-5

Options menu
Graph Grid Lines, 6-4
Service Test mode, 6-4
Unit configuration, 6-3

Ordering information, 9-1

P
Parameter files, defining, 2-14
Parts, ordering, 9-1
Pass/Fail options window, 3-30
Po value, 4-4
Pore filling pressure, F-4
Pore Geometry

cylinder (Saito-Foley), C-27
slit (original Horvath-Kawazoe), C-26
sphere (Cheng/Yang), C-28

Pore size, F-13
Power failure, recovering from, 8-3
Power Supply Air Filter, 8-11
Prepared file status, 1-15
Preparing file status, 1-15
Pressure, absolute pressure tolerance, 3-25
Preventive maintenance schedule, 8-3
Psat tube ferrules, replacing, 8-9
Purify adsorptive, 2-20, 3-19
Python Scripted User-Defined Reports, G-1
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R
Rear panel, 1-9
Regression report

command, 5-7
recalculating SPC values, 5-8
selecting X- and Y-Axes variables, 5-7
window, 5-7

Regularization, 3-59
Relative pressure tolerance, 3-25
Replacing the Psat Fitting Gasket, 8-7
Report

Alpha-S method, 3-44
BET Surface Area, 3-33
BJH Adsorption/Desorption, 3-47
closing, 5-3
control chart, 5-10
DFT Surface Energy, 3-60
Dollimore-Heal, 3-52
Dubinin, 3-61
examples, 5-27
f-Ratio Method, 3-46
generating, 5-3, 6-1
graphs, editing onscreen, 5-22
header, 5-16
Heat of Adsorption, 5-13
Isotherm, 3-31
Langmuir surface area, 3-33
Sample log, 3-70
shortcut menus for, 5-20
Statistical Process Control (SPC), 5-5
Summary, 3-29
tabular, editing, 5-21
tool bar, 5-17
t-Plot, 3-41
zoom feature, 5-26

Report Options
command, 3-27
creating file, 2-21
defining file, 2-21
list file statistics, 3-4

Reports menu
close reports command, 5-3
control chart command, 5-10
open report command, 5-4
regression report command, 5-7
SPC report options command, 5-5
start report command, 5-3

Reports, Interactive, 2-1
Restricted format

defined, 2-6
sample information file, 2-10

Roughing Pump, Service, 4-17

S
Saito-Foley

calculations, C-27
Pore Geometry, C-27

Sample
compartment, 1-8
degassing, 2-30
degassing on analysis port, 2-33
log report, 3-70
low surface area, E-1
weighing, 2-28

Sample analysis command, 4-3
Sample Data Worksheet, form, A-1
Sample information file

creating in Advanced format, 3-10
creating in Basic format, 2-10
export, 3-3
list file statistics, 3-4

Sample Port Frit, replace, 8-5
Sample ports, location, 1-8
Sample tube

cleaning and labeling, 2-26
cooling, 2-37, 2-40
defining file, 2-14
installing, 2-30
on schematic, 4-10
replacing O-ring, 8-7

Schematic, 4-15
Service test mode, 6-4
Servo valve, calibrating, 4-32
Shortcut

for graphs, 5-22
for instrument schematic, 4-13
for tabular reports, 5-21
keys, 1-13
menu, 1-13

Show instrument
show log command, 4-20
show schematic command, 4-15
show status command, 4-19

Side panel, 1-10
SmartPrep

configuration, 4-25
degassing the sample, 2-30
Show status, 4-23
Start degas, 4-24

Soak time, 3-15
Software, using, 1-13
SPC report

control chart, 5-10
options window, 5-5
regression, 5-7

Start report, command, 5-3
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Status window, 4-19
STSA thickness curve, 3-42
Summary

report, 3-29
report calculations, C-46

Surface area correction factor, 3-43
Surface Energy, F-13
System valves, 4-12

T
Tarazona, F-7
Temkin

Isotherm Report Options, 3-39
report calculations, C-11

Temperature ramp rate, 3-15, 3-22
Text, copy graph data as, 5-25
Thermal transpiration

correction, 3-28
correction calculations, C-7

Thermodynamic law, F-2
Thickness curve

Broekhoff-de Boer, 3-42
Carbon Black STSA, 3-42
Halsey, 3-42
Harkins and Jura, 3-42
Kruk-Jaroniec-Sayari, 3-42
reference, 3-41

Title properties window, 5-25
Tool bar, reports window, 5-17
t-Plot report, 3-41
Transducer

manifold pressure transducer, 4-32
match transducer, 4-31
on schematic, 4-10

Troubleshooting and Maintenance, 8-1
Tutorials

Help Menu, 1-20

U
Unit configuration, 4-27
Unit menu

calibration command, 4-29
service test command, 4-35
show instrument log command, 4-20
show instrument schematic command, 4-15
show status command, 4-19
unit configuration, 4-27

Units, Options menu, 6-3
Using the Analyzer, 1-1

V
VacPrep, degasser, 1-6
Vacuum Pump, 1-5
Valves

failure, 8-1
system, 4-12

Van der Waal force, F-1
Vapor Analysis

Installing the Vapor Source container, 2-46, 2-50
Running a Vapor ANalysis, 2-52

Vapor option, 1-5
Vapor Source, 2-20, 3-19
Vapor Source Temperature, 2-21

W
Wall potential, F-10
Warm free space, 3-12
Warnings, defined, 1-3
Weighing sample, 2-28
Window menu

arrange icons, 1-19
tile and cascade, 1-19

X
X-axis order by, 5-11

Z
Zeolites H-Form by NLDFT model, F-12
Zeolites Me-Form by NLDFT model, F-13
Zoom feature, 5-26
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